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Installation and maintenance of licenses

Online activation of  a license
O n l i n e  a c t i v a t i o n  o f   a  l i c e n s e

In order to use EasySIGN software, you need to obtain at least one license. Licenses can be bought from a reseller
and at our web shop.  A license is provided as a ticket. A ticket is a 29 character long string consisting of 5 groups of
alphanumerical characters separated by hyphens, for example: "ABC01- ABC01- ABC01- ABC01- ABC01".

Your computer needs to have an internet connection in order to activate the license.

If you plan to activate a license offline (so your system is not connected to the internet), please consult "Offline
activation" first.

Once you have acquired a ticket, you can activate it by means of the license manager wizard. The license manager
wizard is shown the first time you start EasySIGN. You can also bring it up by selecting the menu "Help > Licensing
options". This will bring up a dialog showing all available licenses.

From here you can bring up the wizard by clicking the button "License Manager...":
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Press "Next" in order to start the activation process.

Here you have two options

1 I have a Product Voucher.
If you bought the license from a reseller your software box could contain a Product Voucher that will
look like the image below.
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You can use the number on this Product Voucher to obtain the ticket for the license you have bought.
You would use this option if you haven't got a ticket yet. If you want to use this option, select it and
press 'Next' to continue.

2 I have a ticket.
If you already have a ticket you would use this option. If you want to use this option, select it and press
'Next' to continue.

I have a Product Voucher

Press the button 'Activate Product Voucher' (1). This will open a browser and the web page where you can activate



9EasySIGN

your Product Voucher.
When you have activated your 'Product Voucher' and received your ticket (by email), press next to continue.

I have a ticket

Ticket based license activations are supported by (1) and (2). Offline activation is possible with (3) the latter is
described in section "Offline activation". The two choices in (1) and (2) tell EasySIGN how the newly installed
license will be bound. 

1 The license will be bound to your pc. This means that you can only use the software on that pc.

2 The license will be bound to a dongle. You can use the software on any computer that you connect with
this dongle. In order to be able to choose this option you need to have a dongle. A dongle can be
acquired from your reseller or at the web shop.

Pick the choice that is appropriate for you and press "Next".
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Here you can enter the ticket. By default the full textbox is selected allowing you to simply cut and paste the ticket.
Be careful to avoid leading and trailing white space characters.

Once you have verified that the ticket has been entered correctly, press "Next".
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The installation of a new license can take a while, so please be patient. Upon success you will see the above depicted
message. When you restart EasySIGN your newly added license will be activated. If your license could not be
installed consult section "Troubleshooting" for help.

Offline activation
O f f l i n e  a c t i v a t i o n

If the computer on which you want to use EasySIGN is not connected to the internet, you can choose for an offline
activation. Please be aware that an additional cost may be involved in an offline activation process. 
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On page 2 of the license manager choose "Offline activation (not recommended)" (3) and press "Next".

Choose the second option "I don’t have a license file yet" and press "Next".
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The choice between (1) and (2) tells EasySIGN how the newly installed license will be bound. 

1 The license will be bound to a dongle. You can use the software on any computer that you connect with
this dongle. In order to be able to choose this option you need to have a dongle. A dongle can be
acquired from your reseller or at the web shop.

2 The license will be bound to your pc. This means that you can only use the software on that pc.

In addition to the mentioned choice, you also need to specify a filename. This filename will be used by the license
manager in order to generate a file that will contain information with respect to the choice you made on this page. The
filename will typically be called "context.WibuCmRaC". Once you have made your choice, and provided a valid
filename, press "Next".
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You need to send the file generated to EasySIGN. This can be done by email, for example on another computer that
has an internet connection and e-mail, or by sending us an USB stick containing the generated file. Together with this
file, you need to specify which license you require. If you are not sure which license would be best for your purposes,
you can contact us trough the contact page on our website. Make sure you provide us with a return address.

When we receive the context file in good order we will generate a so-called license file and ship it back to you. The
license file will typically be called "update.WibuCmRaU". In order to install this file, you need to start the license
manager again.
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Select "Offline activation (not recommended)" (1) and press "Next". 

Select "I already have a license file" (1) and press "Next".  

Here you need to provide a filename. This is the name of the file that EasySIGN shipped to you. Select it and press
"Next".
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Upon success you will see the above displayed message. When you restart EasySIGN your newly added license will
be activated. If your license could not be installed consult section "Troubleshooting" for help.

Understanding and using the License dialog
U n d e r s t a n d i n g  a n d  u s i n g  t h e  L i c e n s e  d i a l o g

The license dialog provides an overview of all valid licenses (with the possible exception of the build license) on your
system. Select the menu "Help > Licensing options" to show this dialog.

Each entry in the listbox (1) window represents a license visible on your system. If a license is visible in this dialog, it
means it is considered to be valid. One exception to this rule is the build license:

A build license limits the build version of the software that can be used.  This is done by comparing the build date of
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the software with the expiration date of the build license. If the build date is too new, so it is newer than the expiration
date of the build license, then the build license is said to be invalid. The user will be informed of this fact at startup
after which all licenses will be disabled. Do not confuse a build date with the current date: A build license with an
expiration date in the past is still valid as long as the build date is in the past of the expiration date of the build
license. 
A build license is derived from a support license. All web shop products come with some support. The expiration date
of the support license is identical to the expiration date of the build license. In the example above the build license is
visible as the first entry in the listbox. It is valid since its expiration date of June 26 2010 is more recent than the build
date of May 1sth 2010.

The license dialog has 4 buttons

2 Close. With this you can simply dismiss the license dialog.

3 License manager wizard. With this you can bring up the license manager wizard as described in previous
sections.

4 Ticket manager. This dialog is used to extend subscriptions as will be described in the next section.

5 Web shop. This will open a web browser with a link to our web shop for your convenience.

In the lower left corner a checkbox (6) is visible. Licenses that are invalid will be collected and shown to you at
startup by an invalid license dialog (see "Understanding and using the expired license dialog"). Uncheck this
box if you do not wish to be informed of expired licenses.

Understanding and using  the Ticket Manager
U n d e r s t a n d i n g  a n d  u s i n g   t h e  T i c k e t  M a n a g e r

Licenses are said to have recently expired if their expiration date is within 30 days of the current date. These licenses,
although technically invalid, are still considered to be valid by the software: they are in a so-called grace period of 30
days. A grace period of 30 days will provide you with ample time to continue any subscription you might have without
losing the functionality of the software. 

The ticket manager presents you with a list of licenses that are within a grace period of their expiration date. If these
licenses are part of a running subscription, then they can be extended by means of this manager.
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In listbox (1) you will see an overview of all licenses that recently expired. In the above shown example we see that
two licenses have expired: "Support complimentary" and "Master subscription".  In listbox (2) you are presented with
a list of tickets that have been installed in the past. Selecting one or more licenses in listbox (1) results in the
selection of all relevant tickets in listbox (2). Textboxes (3) and (4) provide you with more information with respect to
a selected license and ticket respectively. Once you are confident that the right ticket(s) has/have been selected, you
can extend your subscription by pressing "Renew" (6). In textbox (5) you will be notified whether the extension was
successful or not. The next example shows a successful extension:

Notice that the licenses in listbox (1) are updated to reflect the new status after the successful extension. You do not

need to restart the software in this case.

The button "Remove" (7) can be used to remove tickets from listbox (2). You can use this to remove old tickets that
you will not extend. It is perfectly safe to remove a ticket. Removing a ticket does not result in the loss of licenses,
nor does it result in the cancellation of any subscriptions you might have. If you remove a ticket of a running
subscription by accident, you can use the license wizard to enter it again. The license wizard itself can be activated
from this dialog by pressing the button "License wizard" (8). You can also enter the web shop by pressing the button
"Online webshop" (9).

Understanding and using the expired license dialog
U n d e r s t a n d i n g  a n d  u s i n g  t h e  e x p i r e d  l i c e n s e  d i a l o g

Licenses that are expired, and which are no longer within a grace period of the current date, will no longer be
considered to be valid by the software. The software will collect these licenses and report them to you in an expired
license dialog.
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Each entry in listbox (1) of this dialog represents an invalid license. If you do not intend to extend the expired license
and you also do not want to see this dialog each time you start the software, you can suppress it by one of the
following two methods:

1 Notice that there is a checkbox (2) in the lower left corner of the dialog. By checking this checkbox you
prevent the software from reporting expired licenses to you. You can turn this checkbox off again by
selecting the appropriate checkbox on the "License dialog".

2 (recommended) You can select the license that is expired and explicitly hide it by pressing button
"Hide" (3).  This will make sure that the tool will no longer  warn you about this specific license. The hide
action is license and date specific: if you install a newer license that also expires, the tool will once more
warn you about this expired license until you hide this license as well.

Troubleshooting
T r o u b l e s h o o t i n g

In this section you will find the most common issues that can occur during activation of your license.

EasySIGN does not start. I just see a dialog with an error message
EasySIGN software is protected by an anti-piracy shield. This shield will only start EasySIGN if certain conditions are
met. The error message you see is most likely generated by this shield. Here are the most common failures you
might encounter:

EasySIGN communicates with a separate license server that runs locally on each machine on which EasySIGN
software is installed. This license server, named CodeMeter server, must be running as a service. If the CodeMeter
server somehow got terminated, it will not restart automatically as a service. Rebooting your system should restart
the CodeMeter server as a service.



20 EasySIGN

The version of the CodeMeter server running  on your system is outdated. This could happen if you e.g.  install
software that is using an older version of CodeMeter. Re-installing EasySIGN should fix this problem.

Axprotector itself requires a license. This license is shipped with the software. It is installed the first time you start the
software. The license itself is persistent to uninstalling and re-installing EasySIGN. So, losing this license is very
unlikely. However, if this license does somehow get deleted, it cannot be installed a second time. Therefore, in
addition to the original license, we ship one backup license with our software in case the original license gets deleted.
If this license also gets deleted you need to contact us in order to acquire a new one.

The shield itself was not able to provide more information about the problem. If you contact EasySIGN have the
following information available: The serial number of your software "Windows Start button > EasySIGN VX > Tools >
ContainerID" or in the software itself select the menu "Help > Container ID". We will also ask you to email us the
resulting file generated by a tool called VersionInfo ("Windows Start button > EasySIGN VX > Tools > VersionInfo"):
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If you see this message, or a message similar to this, your installation of EasySIGN software is corrupt due to missing
DLL files. Reinstall the software.

I cannot bring up the license manager
The license manager is a standalone executable that resides in the same directory in which EasySIGN is installed. It is
named "LicenseManager.exe". If this executable is missing, you need to re-install EasySIGN.

The license manager generates the following error:

Could  no t conta ct the  e x te rna l lice nse  se rv e r
Make sure your computer is connected to the internet. If your computer is connected to a proxy, make sure that the
default (login) credentials allow access to this proxy. Contact your IT department to make sure that this is set up
correctly.

Com m unica tion with  the  e x te rna l lice nse  se rv e r  fa ile d
This is caused by a communication failure between the license server and the license manager. Make sure your
internet connection is setup properly.

Your  ticke t is  no t v a lid
Make sure that your ticket is correct. It is easy to make a mistake if you are manually typing in the ticket. If possible,
try to cut and paste the ticket in order to avoid mistakes.

T he  products  in  th is  ticke t a re  no t com pa tib le  with  y our  ins ta lla tion. T he  m ost like ly  ca use  is  tha t y our
insta lla tion a lre a dy  conta ins  a ll the  products  cov e re d  by  th is  ticke t.
EasySIGN does not allow you to install the same product (license) twice or more on the same computer, or the same
dongle. This is done for your protection. Installing a license twice does not add any additional functionality, nor does it
allow you to start the software multiple times. Make sure that you are installing the ticket on the appropriate
computer, or on the appropriate dongle.

Your  ticke t ha s  a lre a dy  be e n a ctiv a te d
The ticket has already been activated before. You cannot activate it again, unless it is part of a subscription. If case of
the latter, you are trying to activate it too soon; you have to wait until the licenses contained by the ticket enter their
grace periods. The ticket manager (see "Understanding and using the Ticket Manager") will warn you when this
happens.

Unknown e rro r
This is most likely caused by an intermittent communication failure between the license server and the license
manager. Make sure your internet connection is setup properly.
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Could  no t find  a ny  dong le . Ple a se  v e r ify  tha t y our  dong le  is  conne cte d .
You must have selected "I have a ticket and a dongle" on page 2 of the license wizard. The license wizard could not
detect any dongle on this computer.
Important:
Please be aware that you cannot reuse the dongle of version 5 and earlier.

T he re  a re  m ultip le  dong le s  a tta che d  to  y our  sy ste m . T he  lice nse  m a na ge r  re quire s  tha t only  one  dong le
is  a tta che d  to  y our  sy ste m . R e m ov e  a ll dong le s , e x ce pt fo r  the  dong le  on which y ou wish to  ins ta ll the
lice nse .
You cannot have more than one dongle connected to the system during the installation of a new license. You can have
multiple dongles connected during normal operations, but only if at most one of these dongles contains EasySIGN
licenses.

Som e  file s  a re  m iss ing: <lis t o f m iss ing  file s>.
Please reinstall the application.
The license manager detected a corrupt installation of your software. Please re-install EasySIGN.

T he re  is  a  prob le m  with  y our  Code Me te r  se rv ice . Ple a se  re boot y our  com pute r .
The license manager detected a problem with your local CodeMeter license service. Please reboot your computer in
order to reset this service.

EasySIGN starts, but I get a warning/error message.
T he  re le a se  da te  o f the  progra m : <da te 1> is  ne we r  tha n the  e x p ira tion da te  o f y our  build   lice nse :
<da te 2> [E200]
The build date of the executable is too new. You do not have the rights to run this executable. You can either revert to
an older version of the software, or you can buy additional maintenance in the web shop. The setup of our software
normally prevents you from running into this problem, since it verifies that your build license (derived from
maintenance) allows you to run the software. However there are a couple of scenarios in which you can still manage
to trigger this problem. For example, you might have  installed a TryBuy license, after which you upgraded to a newer
version of the software. The TryBuy licenses are only temporarily available to you, and at the end of the TryBuy
period these licenses are deleted.

Only  one  dong le  ca n be  bound  to  the  Ea sy SIGN so ftwa re  on th is  com pute r . Ple a se  re m ov e  the  e x tra
dong le  (s).
You can have multiple dongles connected to your computer, but only one of these dongles may contains EasySIGN
licenses.

I just installed a new license by means of a ticket, and now all my licenses are gone.
Unless you installed a Move license, your licenses are most likely still available on your computer. Reboot your
computer. If the problem persists, contact EasySIGN and have your serial number readily available.

EasySIGN

Introduction

Welcome to EasySIGN.
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EasySIGN conventions
E a s y S I G N  c o n v e n t i o n s

Before you get started with EasySIGN it is important that you are familiar with the terminology used in this manual.

Menu

The horizontal bar at the top of the screen is the menu and this contains commands such as "File" and "Edit". If you
click on one of these commands, a so-called "drop down menu" will appear from which you can select further options
such as "New", "Save" etc. A click on one of these commands will activate your choice.

PopUp menu

This is in fact the same as a "Menu", only a "PopUp Menu" does not become visible until you use your right mouse
button to click on an object or worksheet.

Cursor

The cursor is the visible "Arrow" on your screen which moves when you move your mouse.

Dialog

A dialog is a window which enables you to modify your settings.

Worksheet
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The worksheet is the central part of the program on which you make your designs or drawings.

Active window
This is the complete area in the window that falls within the rulers and sliders. This includes the worksheet and the
area around it.

Buttons

When the following text appears "click on the OK button", you are being asked to use your left mouse button to click
on "OK".

Options

An option in a dialog is activated if the box in front of the option is ticked or if the circle in front of the option is black.

Keyboard

If you use the keyboard to carry out commands, "Ctrl+S" means that you must press and hold the Control key and
press the "S" key.

Mouse

EasySIGN makes use of both mouse buttons, using the left mouse button as the primary mouse button.

Product support
P r o d u c t  s u p p o r t

If you have any questions about EasySIGN, please refer to this manual. If you are still not able to solve the problem,
please contact the supplier.

When making a call to your supplier, make sure you are seated near your computer and that you have all relevant
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documentation at hand. Also make sure you will be able to answer the following questions.
What is the serial number of your EasySIGN version?
Which program version do you have?
Write down any error messages that appear on screen or use the keyboard combination "Alt+PrintScreen" to make a
bitmap printout of the dialog containing the error message.
What happened and what were you doing when the problem occurred.
Did you try to solve the problem? If so, how?
Which program version do you have?
What output equipment is connected to your system?
Do you have any special cards in your computer? If so, which?

The EasySIGN screen
 T h e  E a s y S I G N  s c r e e n

After you have started up the program the following screen will be displayed. The most important parts of the screen
will be further explained in detail.

1 Title bar

On the title bar you will find the name of the program followed by the name of the file you have just
opened. There are also a number of buttons on the title bar.

2 Menu bar

 In the menu bar you will find the names of the various menus. Each menu in turn contains several
submenus with the commands for the program.

3 Toolbar

 This bar contains the most frequently used menu commands; these can be controlled by clicking on the
appropriate button.
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 The bar (like all bars at this level) can be glued onto or dragged from of the menu.

The program contains many of these " floating toolbars". These toolbars are called "floating" because
when you use them, you can continue editing the worksheet, unlike the dialogs.

4 Toolbox

 The toolbox contains the most frequently used operations. You only need to click on the button of the
tool to activate the operation. The TAB key is a shortcut key that enables you to switch between the tool
you selected last and the selection tool (the arrow).

5 Rulers

 The rulers are located to the left and top of the worksheet of the program. These rulers give you an
idea of the location and size of the objects on your worksheet.

6 Sliders

To the bottom and right of the worksheet you will see two sliders. These enable you to slide your
worksheet horizontally and vertically over the screen.

If you want to move the screen you can also press the space bar, the mouse cursor changes as follows.

By moving the mouse (with the space bar and by clicking and holding the left mouse button) you can
also move the worksheet.

7 Status bar

The status bar is located at the bottom of the screen and gives information about a selected object.

8 Worksheet

The white area op the screen is the worksheet. The worksheet is represented by a square with a
pinfeed strip on two sides. The pinfeed is used to indicate the orientation of the output device.
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Working with EasySIGN

Installing EasySIGN

Even for the most inexperienced user installing EasySIGN is an easy and uncomplicated procedure. See the
installation manual.

Uninstalling EasySIGN

To remove EasySIGN from your system choose the command "EasySIGN uninstall" from the program group
EasySIGN (from the Windows "Start" menu, "Programs", “EasySIGN”).

Starting EasySIGN

After you have run the program "Setup", the program group "EasySIGN" is displayed in the Windows "Start" menu,
“Programs”. This program group also contains the icon for EasySIGN. By clicking on the icon the EasySIGN program
is started.

Interface

EasySIGN Application Look
E a s y S I G N  A p p l i c a t i o n  L o o k

The first time you run the software it will be using the default Application look. This look is highly optimized to be as
less distractive as possible. It uses a neutral color and easy to recognize icons. 

If however you feel more comfortable with a different look this is very easy to change.
Select the menu 'Vie w > App lica tion Look > x x x' where 'xxx' stands for a long list of different looks to choose
from. No restart is necessary so just select them one by one until you find the one you like best.
 
The last selected look is the one the software will be using with each new session until you change the look again.   
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MDI tabs
M D I  t a b s

The first time you run the software it will be using MDI tabs.

MDI tabs have several advantages over old style MDI windows.

1 Very easy navigation between documents.

2 Preview of every worksheet in the Windows 7 taskbar. 

3 Context menu with several useful options.

Manage the MDI tabs
To manage the MDI tabs right click on an empty space of the worksheet and select the command 'Interface'.
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This will open the same dialog as if you would have chosen the menu 'Vie w > Se ttings'.

1 Switch the tabs on or off.
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2 Choose if and where you want a close button on the tabs.

3 Choose the style of the tabs.

4 Tabs on top or on bottom.
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5 Every tab its own color.

6 Document icons displayed on tabs.

7 Document menu.

8 Drag tabs to a different location.

9 Each tab has its own context menu.
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Customize toolbars
C u s t o m i z e  t o o l b a r s

You can customize existing toolbars and even create your own.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.

1 Make sure that you have the 'Toolbars' tab selected.

2 Existing toolbars.

3 Reset the selected toolbar to its original state.

4 Reset all toolbars to their original state. this will also delete any custom toolbar.

5 Create a new toolbar.

6 Rename a toolbar. Only possible on your own toolbars.

7 Delete a toolbar. Only possible on your own toolbars.

Click on 'New...' (5).
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Give the new toolbar a name
and click on 'OK'.

This will create a small empty
new toolbar.

Click on the tab
'Commands' (1). From the
'Categories' list (2) on the left
select the menu you want to
use. From the 'Commands'
list (3).
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On the right drag the
commands you want to use to
the new toolbar.

When you are done close this
dialog.

Your new toolbar is ready to
use.

Create tools
C r e a t e  t o o l s

You can create links to other software (tools) which are automatically displayed in a menu.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.
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Make sure that you have the 'Tools' (1) tab selected and click on the button for a new entry (2). 

Enter 'Notepad' in the field that appears (3).
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Enter the path and name of the executable in the 'Command' field (4), or use the browse button (5) to browse to the
executable. When you are done click on 'Close' (6).

Select the menu 'File  > T oo ls  > x x x' where 'xxx' stands for the tool you have added.

Customize shortcut keys
C u s t o m i z e  s h o r t c u t  k e y s

You can create your own Shortcut Keys and they will even appear in the menus.

Right click on the menu and select from the context menu the command 'Customize'.
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This will open the following dialog.

1 Make sure that you have the 'Keyboard' tab selected.

2 Category, here is where you select the menu.

3 Accelerator, make sure this is set to default.

4 Commands, the commands in the menu you have selected under 'category' (2).

5 Current keys, the current assigned key (if any) to the command you have selected under
'Commands' (4).

6 Assign the shortcut Key you have typed in the field 'Press new Shortcut Key' (9).

7 Remove a Shortcut Key.

8 Reset all shortcut Keys to their default values.

9 Type/Press the Shortcut Key as you will use it.

Example
Let's add a Shortcut Key to the command 'Quick connect' from the 'Arrange' menu.
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As you can see in the menu, there is no Shortcut Key assigned to this
command.

Select from 'Category' (2) the menu 'Arrange'.

Select from 'Commands' (4) the command 'Quick Connect'.

Set your cursor in the field 'Press new Shortcut Key' (9). Press and hold on
your keyboard the Control key and then the '1'.

The button 'Assign' is now enabled, click on it to assign the new Shortcut
Key.

The new Shortcut Key is now assigned to 'Quick Connect'. Click 'C lose' to
close this dialog.

If you now go to the command 'Quick connect' from the 'Arrange' menu
you can see that the new Shortcut Key is also added to the menu.

Menu behavior
M e n u  b e h a v i o r

You can customize the menu behavior to your liking.

Right click on the menu and select from the context menu the command 'Customize'.



39EasySIGN

This will open the following dialog.

1 Make sure that you have the 'Menu' tab selected.

2 Make sure that 'Design doc' is selected.

3 Select the menu animation you want.

4 Check this if you want the menu to have shadows.

5 Use the 'Reset' button to reset all menu's to their original state.

Manage menu items
M a n a g e  m e n u  i t e m s

You can add or remove new commands to the existing menus, rearrange them and even create new menus.

Right click on the menu and select from the context menu the command 'Customize'.



40 EasySIGN

This will open the following dialog.

Make sure that you have the 'Commands' tab (1) selected.

Rearrange menu items
Now that this dialog is open you can start rearranging the menus. 

The image shows the current order of the top level menu items. Click on the 'File' menu and drag it behind the 'Help'
menu. 

The menu looks now like above. Drag every menu item to a different position.

Let's stop here and try something else.
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Click on the 'Text' menu to open it and
select the command 'Case'.

Drag the command 'Case' to the menu
'Arrange' and hold it above the menu
'Arrange' until this menu opens (don't let
go of your mouse button yet).

When the menu 'Arrange' opens drag the
command 'Case' just above the
command 'Group'. As you can see you
can even move commands from one
menu to another.

You can also drag commands from the dialog to the menus.
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Under 'Categories' select
'Arrange' and under
'Commands' select and drag
'Group' to the 'Text' menu.

Create your own menu

In the dialog select under
'Categories' the item 'New
menu' (1).
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Under 'Commands' select and
drag the command 'New
menu' (1) to the right of the
main menu, just after
'Text' (remember, we have
rearranged all the menu
items).

Right click on the new menu
item and select the command
'Button Appearance...' (1).

In the field 'Button text' enter
a name for the menu item.
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Start selecting menus in the
Categories (1) list and drag
commands from the
'Commands' (2) list to the
new menu.

In no time you have created
your own 'Favorites' menu.



45EasySIGN

If you want to reset the
menus to their original state
just select the tab 'Menu' (1)
and press the button 'Reset' (
2).

Associate mouse double-click
A s s o c i a t e  m o u s e  d o u b l e - c l i c k

You can associate a mouse double-click on an empty space on the worksheet to a certain menu command.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.
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1 Make sure that you have the 'Mouse' tab selected.

2 Make sure 'Worksheet' is selected.

3 Check the option 'Associate double-click event with'.

4 Choose the command of your liking (in our case this is 'FileOpen').

5 Click on 'Close' to close the dialog.

If you now double click on an empty space of the worksheet the File Open dialog will open.

Large icons
L a r g e  i c o n s

If desired you can change the size of the icons from all the toolbars.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.
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1 Make sure that you have the 'Options' tab selected.

2 Check the option 'Large icons'.

3 Click on 'Close' to close the dialog.

On top the toolbox with standard
icons and on the bottom the
toolbox with large icons.

Arrange Interface
A r r a n g e  I n t e r f a c e

You can arrange the interface completely to your liking. Menu, Toolbars, Dockers etc. can be made floating, dragged
to a different docking location, closed or put in 'Auto hide' mode.
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If you for example want the Object manager and Color docker both visible at the same time just drag one of them
into the other. An advanced docker helper Wil help you getting them on the right place.

If you want the dockers hidden but instantly
accessible when you hover the mouse over
them, just put them in auto hide mode. Click on
the 'Auto hide button' (1).
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The dockers will hide themselves on the side
they were docked.

If you want to make them visible again, just
hover your mouse over the icons. If your mouse
leaves the dockers they will hide themselves
again.

Just play around to get comfortable with all the possibilities with the interface, you will be pleasant surprised.

Ribbon
R i b b o n

The first time you run the software it will be using menus. If you are a user that likes Ribbons like e.g. in Microsoft

Word™ you can easily change the interface to a Ribbon interface.

To change to the Ribbon interface right click on an empty space of the worksheet and select the command 'Interface'.

This will open the same dialog as if you would have chosen the menu 'Vie w > Se ttings'.
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Make sure that the tab 'Interface' (1) is selected and check the option 'Use Ribbon interface (needs restart)' (2).

Click on 'OK' to accept the changes and restart the software.

The interface of EasySIGN is now a Ribbon interface that basically works the same as the Microsoft Word™ Ribbon.
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If for example you select the 'Effects' tab you have all the effects instantly at your disposal.

The same goes for the tab 'Text'.

Selecting the tab 'Create' gives you access to the drawing tools, import, export, Compatibility, insert objects etc.
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Just have a good look around and see what works for you, the Menu interface or the Ribbon interface.

Starting and finishing your work
S t a r t i n g  a n d  f i n i s h i n g  y o u r  w o r k

A new worksheet
When you start up the program it always opens with a new, clean worksheet. Because the program is an MDI
(Multiple Document Interface) you can have several worksheets open at the same time. 

Open existing worksheets.

To open an existing worksheet, select the option "Open" from the "File" menu. A dialog is opened from which you can
look for and select your worksheet.

Undo commands

The program remembers which tasks you completed during a session. If you make a mistake or if you wish to change
a recent command, you can undo it using the option "Recover" from the  "Edit" menu. The following commands can
not be recovered:

Some file operations such as "Open" and "Save".
Selecting an object.
Changes in viewing (zooming etc.).
Placing construction lines and changing certain settings.
Operations on tiling lines.
Moving special registration marks.

By going to "File, General Settings" under the tab "General" you can specify your preferred number of "Undo"
operations.

Immediately after the command "Undo" the command "Cancel Undo" becomes active. This way you can undo the
change(s) again.

Undo

Shortcut key "CTRL+Z"

Redo

Shortcut key "CTRL+A"

Setting preferences 

You can use the command “General settings” from the menu “File” and the command “Settings” in the menu “View” 
record a number of general settings. These commands enable you to modify the properties of a worksheet, reset the
properties of the grid, and determine the global unit of measure you want the program to use and a lot more.

Closing EasySIGN

Use the command "Close" from the menu "File" to end the current EasySIGN session.

Viewing the worksheet

EasySIGN has three different modes for viewing your work.

Wireframe graphics 
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This option displays all objects on the worksheet as wireframe graphics. Not a single object is filled and an object can
only be selected by clicking on the edge of the object. 

Filled

All objects that have a filling will be displayed as such.

High Quality

This option displays all objects in the best possible display.

Redraw window

If remainders of previous operations have been left on the screen, you can redraw the screen by selecting the option
"Refresh" from the  "Window" menu.

Shortcut key "F5"

Sliding the active window 

Sliders 
By using the horizontal and vertical sliders along the sides of the screen you can view the parts of your drawing that
fall outside the current active window.

Slider arrows
Click on the slider arrow in order to move the window by small steps in the desired direction.

Bars
Click on the bar in order to move the window in fast steps in the desired direction.

Slider block
The slider block can be dragged in two directions. 

Drag
A different way of scrolling the worksheet is by pressing and holding the space bar. The cursor changes as follows:

Hold the space bar and click on the worksheet. Move the worksheet to the desired location and then first let go of the
space bar and next let go of the mouse button.

Zooming tools
Z o o m i n g  t o o l s

If you want to use one of the available zoom options, click on the next button in the toolbar.

A submenu will appear with the following options.

Zoom in 
When you select this option the cursor changes as follows. 
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You can now zoom in by clicking once or by drawing a rectangle around the area you want to zoom in on. 

Zoom out
When you select this option the cursor changes as follows.

You can zoom out by clicking once on the worksheet. The position you click on will be moved to the center of the
window. 

All
This option zooms in on all objects on the worksheet, irrespective of whether the objects were selected or not.

Selection 
This option only zooms in on all selected objects.

Page
This option only zooms in on the worksheet.

Back 
This option returns to the last view.

Organizing and transforming objects

General
G e n e r a l

Moving, duplicating and deleting objects are the basic functions of any program. As with most commands in EasySIGN
they can be carried out in two ways. Either by dragging the mouse or by entering numeric values in a dialog box.
Some commands can be carried out using a keyboard shortcut, e.g. deleting objects with the DEL key or duplicating
with the keyboard shortcut "CTRL+D".

The option "Duplicate" in the "Edit" menu can be used to copy objects. This will enable you to make an exact copy of
an object. You can also use the mouse to drag the object but before letting go of the left mouse button click once on
the right mouse button. The program will then duplicate the object. You can use the previous method to leave a
duplicate of a guideline.

Using the magnetic features of guidelines, anchor points and a grid, you can swiftly and accurately position objects.
This accurate function eliminates the need to zoom in greatly on an object in order to get an exact positioning. 

In order to compile complicated illustrations there are many other ways to organize objects, such as: e.g. centering,
stacking and grouping objects.
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Moving objects
M o v i n g  o b j e c t s

Moving with the mouse
Moving objects using the mouse works in the same way whether you are working in wireframe graphics or color, with
only a small difference between both screen modes. If you are working in wireframe graphics you must always select
the object by one of its edges; when you are working in color you can click on any part of the object to select it. From
now on we will only be using the term selecting the object and we will leave it to you whether you would rather work
in wireframe graphics or in color. In both screen modes the following applies: when you go over an anchor point with
your mouse a red square will appear to show that you can select the object through this anchor point (only if you
have activated the option "Anchor points magnetic").

Take the selection tools to the object you want to move.

Click on the object to select it and hold the mouse button.

Move the mouse to where you want the object. Irrespective of the shape of the object when you drag it, it will change
into a yellow border which displays the borderlines of the underlying object. The mouse cursor changes into a cross
which shows the directions in which the object can be moved.
Once you let go of the mouse button the object will have moved.

If you press and hold the Control key while moving, the object will be moved over a horizontal or vertical line
(depending on the direction it is moved in).

Moving with numerical values

Keyboard shortcut "ALT+F7"

Select the object you want to move numerically.

When the object has been selected, click once on the right mouse button. A PopUp menu will appear.
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From the PopUp menu select the option "Transformations". A submenu will appear. Select the option "Position”.

The move dialog has several input possibilities.

Position (1)
In this box you will find the horizontal X and vertical Y position of the selected object.

Origin (2)
The buttons in this box show the object's origin. In the above dialog the button at the bottom left has been pressed
and in the fields X and Y are the values 100, 100. This means that the left bottom corner of the object is positioned at
100 units from the left border of the worksheet and at 100 units from the bottom of the worksheet.

Leave original (3)
When this option is activated the object is moved, leaving the original behind.

Move relative (4)
If you select this option the values in the X and Y fields will change. In the following example we will assume that the
object has a width of 50 units and a height of 50 units and is located at the bottom left-hand side of the page on the
zero point.

Select the options "Leave original" and "Move Relative ".

2 Click on the button "Top right" in the group "Origin".
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3 For X and Y fill in the value "50".

4 Click on the button "Apply".

5 The result will look as follows.

 The object has moved a total of 50 units up and to the right and
has left an original behind.

Close
This button closes the dialog.

Apply
When this button is active you can use it to execute the settings you have entered.

Moving with the arrow keys
In the "File” “Settings" menu you can use the corresponding dialog under the tab "General" to determine the distance
you want the objects to be moved when using one of the arrow keys. This option is called “Nudge distance”.

 

Tips
T i p s

Jolting movements when moving with the mouse
When this occurs the magnetic feature of the grid is probably activated. Disable this to stop the jolting.

Moving only vertically or horizontally
Hold the Control key while moving. Press and hold while you move the object with the mouse. As this is a limitation
key you must first let go of the mouse button and then the control key when moving over a horizontal or vertical line. 

Moving with selected anchor points
When your mouse cursor is above an object’s anchor point, you can select it. If the option "Anchor points magnetic" is
activated then this is an easy way to place objects directly against each other without intervention of magnetic
guidelines.

Rotating Objects
R o t a t i n g  O b j e c t s

Rotating with the mouse
Select an object by clicking on it once. After selecting 8 selection handles will appear around the object.
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Click on the object once again with the mouse.

The selection of handles has changed. When rotating only use the handles on the corners of the object.

Rotate by pressing and holding the left mouse button and moving the mouse in the direction you want to rotate.

When you are actually rotating, the object will remain visible and the new position will be displayed by a blue line
representing the outline of the object.

Once you let go of the mouse button the object will have rotated.

Rotation axis of objects
The rotation axis of an object is always represented by the following symbol.

This symbol can be moved with the mouse to any given location on the worksheet. The rotation axis determines the
point around which the object will be rotated. 

Moving rotation axis
Click twice on a non-selected object to display the rotation handles.

Bring the cursor towards the rotation axis. You can start moving once the cursor has changed into a cross.

You can now move the rotation axis to any given location on the worksheet.
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If you start the rotation you will see that the object rotates around the point where you placed the rotation axis.

By dragging the rotation axis with the "Control" key you are able to return it to the exact center of the object.

Rotating with numeric values.

Keyboard shortcut "ALT+F8"

Select the object you want to rotate numerically. 

When the object has been selected, click once on the right mouse button. A PopUp menu will appear.
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Select the option “Transform” from the PopUp menu. A submenu will appear. Select the option "Rotation”.

Rotation (1)
This contains an input field for the number of degrees of the rotation movement.
Furthermore there are two option circles in this field. With these option circles you can determine the direction of
rotation of the object. 

Origin (2)
The buttons in this box indicate the rotation axis of the object.

Leave original (3)
When this option is activated the object is rotated, leaving the original behind.

Special rotations
By placing the rotation axis in combinations with the rotation dialog gives you more control over the rotation. If you
reposition the rotation axis and then call up the rotation dialog you will be able to place objects in a repetitive
pattern. 

Example
Select an object twice to display the rotation handles.

Then move the rotation axis.
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Use the PopUp menu to call up the rotation dialog.

In "Origin" (2) where you would normally find the buttons to reposition the rotation axis to a vertex or side of the
object, you will now see the following icon.

Where it says rotation, fill in "30 degrees" and activate the option "Leave original" (3). Once you have done this, click
on the button "Apply" 12 times.

In a simple way you have now made a picture with an object in the places where you would normally find the digits
on a clock. 
Instead of clicking on the "Apply" button of the dialog several times, you can also make one single rotating action with
the dialog or with the mouse and then select "Repeat" from the "Edit" menu or use the shortcut key "Control R".

Skewing Objects
S k e w i n g  O b j e c t s

Skewing with the mouse
Select an object by clicking on it once. After selecting 8 selection handles will appear around the object.

Click on the object once again with the mouse.

 

The selection of handles has changed. When skewing only use the handles on the sides of the object.
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You can skew an object by moving the mouse in one of the directions indicated by the handle you are holding at that
moment.

Skewing with numerical values

Keyboard shortcut "ALT+F11"

 Select the object you want to skew.

 When the object has been selected, click on the right mouse button once. A PopUp menu will appear.

 Select the option “Transform” from the PopUp menu. A submenu will appear. Select the option "Skew”.
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Angle (1)
 This contains an input field for the number of degrees you wish to perform the skewing. There are also two radio
buttons in this field. These radio buttons let you specify the direction of rotation of the object. 

Origin (2)
 The buttons in this box indicate the origin or axis used as anchor point for skewing. The difference between the
various anchor points is displayed in the following illustrations. 

Initial Situation

Origin Result

  

  

  

Leave original (3)
When this option is activated the object is skewed, leaving the original behind.

Mirroring objects
M i r r o r i n g  o b j e c t s

Using the mouse to mirror
Select an object by clicking on it once. After selecting 8 selection handles will appear around the object.



64 EasySIGN

You can use any selection handle to mirror the object.

Press and hold the left mouse button and move the cursor to the right. In order to mirror the object and not distort it,
you must press the "Control" key. The "Control" key is a limitation that ensures the movement is limited to steps of
100% of the size of the object.

If you click on the right mouse button once while mirroring, you will automatically leave behind an original of the
object.

Mirroring with a dialog

Keyboard shortcut "ALT+F10"

Select the object you want to mirror.

When the object has been selected, click on the right mouse button once. A PopUp menu will appear.
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Select the option “Transform” from the PopUp menu. A submenu will appear. Select the option "Mirror”.

Mirror (1)
Here you will find two checkboxes. If you activate the top checkbox the object will be mirrored along its horizontal
axis. If you select the bottom option, the object is mirrored along the vertical axis. It is also possible to use both
options at the same time.

Origin (2)
The buttons in this box indicate the object's origin or axis that is used as an anchor point for mirroring. In the
following illustrations the difference is shown between the various anchor points. In the following examples we have
activated both options "Horizontal" and "Vertical". Also we have activated the option "Leave original" (3). The object
with the selection handles is the mirrored object.

Initial situation

Origin Result
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Sizing and distorting objects
S i z i n g  a n d  d i s t o r t i n g  o b j e c t s

Sizing and distorting with the mouse
Select an object by clicking on it once.

The selection of handles that have been circled are the ones to be sized.

You can enlarge the object by moving away from the object with the cursor.
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You can reduce the object by moving towards the object with the cursor.

If you hold the "Shift" key while you are enlarging or reducing, the object will be scaled from the center.

 

If you press and hold the "Control" key while enlarging, the object will be scaled by its size doubling with every step. 

 

The selection of handles that has been circled in the following illustration is going to be distorted.

As with scaling, if you want to distort the object from the center use the "Shift" key and if you want to distort the
object in steps of one hundred per cent use the "Control" key.

Scaling and distorting with numerical values

Keyboard shortcut "ALT+F9"

Select the object you want to scale or distort numerically.



69EasySIGN

When the object has been selected, click on the right mouse button once. A PopUp menu will appear.

Select the option “Transform” from the PopUp menu. A submenu will appear. Select the option "Size”. 

Size (1)
In this box you will find the horizontal (X) and vertical (Y) values of the format of the selected object.

Origin (2)
The buttons in this box indicate the object's origin.

Leave original (3)
When this option is activated the object is scaled or distorted, leaving the original behind.

Proportional (4)
When this option is activated the object can only be scaled. All values entered for "X" e.g. will influence the value in
"Y" and vice versa.

By value (5)
When this option is activated, the true sizes of the objects are displayed in the fields "X" and "Y".

Examples of scaling
The object surrounded by the selection handles represents the end result.

Initial situation
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Origin Result
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Transformation assistant
T r a n s f o r m a t i o n  a s s i s t a n t

The transformation assistant is your assistant in applying the transformations the program has to offer. You can
perform transformations like positioning, rotation etc. via this floating dialog. For example, you would enter a number
for the horizontal positioning and apply this by pressing “Enter”. You can show or hide this dialog via the menu “View”,
“Transformation assistant”:

You can change the appearance and shape of this dialog by dragging the edges.

The parts of the transformation assistant

Position

Horizontal

Vertical

Size

Horizontal

Vertical

Skew

Horizontal
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Vertical

Rotate

Both directions

By entering a negative or positive value, you can rotate in both directions.

Mirror

Horizontal

Vertical

Anchor point

Changing the anchor point has influence on:
Position
Size
Skew
Rotate
Mirror
If you set the anchor point to bottom left, the transformation will use this point as the anchor point:

In the example above the anchor point is set to bottom left. The rotation is done around the boundaries of the object.
You have to remember that, after a rotation, the boundaries of an object change and so the rotation may do things
you wouldn’t expect, when a second rotation is applied:

In the example above, the red box is the original position of the object. The blue box represents the boundaries of the
object and the yellow dot the rotation point. You can see that, after every rotation, the boundary of the object
changes and with that the position of the rotation point does too. See the chapter “Rotating object” on how a rotation
point works. 

Proportional

With this option the following fields become proportionally connected:
Horizontal and vertical position 
Horizontal and vertical size

Percentage

With this option the fields for “Size” use percentages of the original instead of the actual values.

Relative
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With this option, positioning is done relative to the current position.

Leave original

With each transformation (except “Order”), a duplicate is left behind.

Order

Move forward

Bring to front

Move backward
 

Put to back

Duplicating objects
D u p l i c a t i n g  o b j e c t s

You can copy objects using the command "Duplicate" or you can use the commands "Cut", "Copy" and "Paste".
EasySIGN's internal clipboard is used for this.

Placing a copy of the object on the internal clipboard:

 Shortcut key "CTRL+C"

1 Select the object you want to copy.

2 Select the command "Copy" from the "Edit" menu (or use the
button from the "Toolbar").

Cutting an object and placing it on the internal clipboard:

 Shortcut key "CTRL+X"

1 Select the object you want to cut.

2 Select the command "Cut" from the "Edit" menu (or use the button
from the "Toolbar"). The object will disappear and is placed on the
internal clipboard.

Moving an object from the internal clipboard to the worksheet:

 Shortcut key "CTRL+V"

Select the command "Paste" from the "Edit" menu (or use the
button from the "Toolbar").

Duplicating

Shortcut key "CTRL+D"

The command "Duplicate" from the "Edit" menu is used to make a copy of the selected objects.

Duplicating on top

Shortcut key "Numeric+"
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This command from the "Edit" menu places a copy of the object directly on top of the original.

Deleting objects
D e l e t i n g  o b j e c t s

Shortcut key "DEL"

If you want to delete an object from your worksheet, select the command "Delete" from the "Edit" menu or use the
shortcut key "DEL".

Aligning objects
A l i g n i n g  o b j e c t s

Using the various commands from the menu bar "Align objects" enables you to align all objects, make them the same
size or center them on the page.

Important
For all options in this menu bar (with the exception of centering on the page) the last selected object determines
where the other object will be aligned. In other words the last selected object does not change place.

Place two objects on the worksheet

Select the first object from the series you would like to align.

Select the last object from the series you would like to align.

Click on the button "Align left" from the menu bar "Align objects". 

Click on the button "Apply" from the menu bar "Align objects".

You will see that the object selected first has been aligned to the left of the object selected last.



75EasySIGN

 

Alignment commands
A l i g n m e n t  c o m m a n d s

In the next section you will find a description of the separate alignment commands including a number of possible
combinations of these commands.

Location on the menu bar

Separate commands

A Align left

B Center vertically 

C Align right

D Align top

E Center horizontally 

F Align bottom

G Align all selected objects to the middle of the page. 

H Make all selected objects the same width.

I Make all selected objects the same height.

J Apply selected command(s).

Combinations of commands

Initial situation

Combination Result
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You can use all previous combinations together with the commands:

Make all selected objects the same width.

Make all selected objects the same height.

You can use both commands either separately with the alignment commands or simultaneously. For example the
following combination,

Distribute (space evenly)
D i s t r i b u t e  ( s p a c e  e v e n l y )

The distribute options make it possible to place objects so that the distances between the objects are equal. You can
let the software calculate the distance between the objects or you can specify the distance yourself.

Automatically calculating the distance
You will find these options in the “Aligning objects” toolbar. These options, together with the possibility to specify the
distance, can also be reached via the menu “Arrange, Space evenly”.

A Distribute horizontally 
Select the objects you want to distribute followed by an option on the alignment toolbar. After pressing the
“Enter”-button on the alignment toolbar, the objects will be distributed horizontally. The two outermost objects
stay fixed and will be used as anchor. This means placement of the other objects is relative to them. 

 

Optio
n

Result 
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1

2

3

4

B Distribute vertically
This option works the same as “Distribute horizontally”, except that now everything is distributed vertically.

You can use the horizontal and vertical distribution simultaneously. However, it is recommended to deal with
horizontal and vertical distribution separately. You can also combine the distribute options with the alignment
options. If you combine the distribute options with the alignment options, the last selected object stays fixed
and acts as anchor.

C Text alignment options
On the alignment toolbar, hit the "C" button  to open the “Text alignment extends settings” dialog. See the
chapter “Text alignment options” for a detailed description. 

Specify distance

This option is available via the “Arrange, Space evenly, Distribute” menu .

1 Horizontal alignment
Options from  le ft to  r ight:
Do nothing.
Distance between left side and left side.
Distance between center and center.
Distance between right side and right side.
Distance between right side and left side of next object.

2 Specify distance
If you wish to do so, you can specify a user -defined horizontal distance between the objects.

3 Distribute vertically
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Options from  le ft to  r ight:
Do nothing.
Distance between bottom side and bottom side.
Distance between center and center.
Distance between top side and top side.
Distance between top side and bottom side of next object.

4 Specify distance
If you wish to do so, you can specify a self-determined vertical distance between the objects.

Text align options
T e x t  a l i g n  o p t i o n s

Due to the complexity of text objects and the different opinions regarding the correct method to align text objects,
there are several alignment options for text. Select “View, Settings” and next the tab sheet “Text” and the button
“Text extends…”.

1 Aligning text with whitespace 

2 Aligning text without whitespace

3 Aligning text on baseline

You can select any combination of options. The settings you make in this dialog, apply to the w hole softw are package.    

A Light grey area
This is the “whitespace” of a text.
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B Dark grey area
This is the vector shape or curve of a text (option: without whitespace).

C Nodes (tiny squares)
Origin points of the distinct characters.

D Orange line
Base line, walks through the origin points of the distinct characters.

Below you see several examples with different settings.

If  you intend to align text typographically (and visually) correct, activate the option combination below .

If you were satisfied with the single text alignment option in versions older than version 5, activate the option
combination below.

Rulers
R u l e r s

The horizontal and vertical rulers in EasySIGN are located in the top left-hand corner of the worksheet. The rulers are
displayed in the chosen unit of measure.
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Grid
G r i d

The grid is a screen of dots that is placed on the page. When the option "Grid magnetic" is activated, the grid ensures
that all moves with the mouse are restricted to a multiple of the grid distance.

 

Guidelines
G u i d e l i n e s  

There are two ways to add guidelines to a worksheet that does not have guidelines.

Move the mouse cursor onto the ruler and click on the right mouse button.
A PopUp menu will appear.

In the PopUp menu of the guidelines you will find the following commands:
Hide
Grid settings
Guideline properties 

If you click with the mouse on "Guideline properties ", a dialog will appear.
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The dialog is subdivided into 3 "Tabs" (1). The first tab is for operations on the horizontal guidelines, the second is for
the vertical ones and the third tab is for the slanted guidelines.
On the left side of the dialog you will find the location of the guidelines displayed numerically (2). If you have several
guidelines located here, you can change the properties of each separate guideline by clicking on the numerical value
of the guideline. The value of the selected guideline will appear in the text window next to it (3). 

Deleting guidelines
Select the guideline in (2) and click on the button "Delete" (6).

Moving guidelines
Select the guideline in (2), enter a new value (3) and click on the button "Move"(5).

Adding guidelines
Fill in (3) a value and click on the "Add" (4) button.

Move the mouse cursor onto the ruler and drag the guideline onto the worksheet.

Editing guidelines
If you want to edit the guidelines in a worksheet, move your mouse onto the guideline you want to edit, click on it
with your right mouse button and a PopUp menu will appear.

In this PopUp menu of the guidelines you will find the following commands:
Delete
Snap to guidelines
Bring to front
Hide all
Properties

Delete
This option deletes the selected guideline. It is also possible to delete the guideline by dragging it back to the ruler.
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Snap to guidelines
By enabling or disabling this option objects can be placed magnetically against the guidelines.

Bring to front
This option ensures that the guidelines are on top of or behind the objects on the worksheet.

Hide all
This option hides all guidelines on the worksheet without deleting them. The guidelines will become visible again by
placing the mouse on the ruler and calling up the dialog "Guideline properties" with the right mouse button. In this
dialog you must activate the option "Show guidelines".

Properties
This activates the dialog "Guidelines". 

Slanted Guidelines
If you want a slanted guideline, you can achieve this in two ways:

1 Open the dialog "Guidelines" and under the tab "Slanted guidelines” fill in the horizontal, vertical and
angular values numerically.

2 Drag a guideline from a ruler and put it in the required place. Then select the guideline with your mouse
and at the same time use the shift key. By moving the mouse you can determine the angle of the
guideline manually.

Magnetic properties
The most important property of guidelines is that they can be magnetic. As this can have an undesirable effect when
moving objects, you can enable or disable the magnetic properties. This can be done by calling up a PopUp menu
using the right mouse button and enabling or disabling the option "Snap to guidelines".

Snapping magnetically
When you move a whole object this object will snap onto the selection of handles. 

When you have an irregularly shaped object which you want to place against a guideline, you can also have an
anchor point of the object snap onto the guidelines.

The procedure is as follows:
Move the mouse cursor over an object. When an anchor point has been found, a red square will appear.



83EasySIGN

When the square appears click on it with your mouse; you can now let this point snap onto a guideline or onto an
intersection of several guidelines.

You can also let the guidelines themselves snap onto this intersection of objects. 

Example
You have an object on the worksheet and you would like to align other objects to the left of it.

Drag a guideline from a ruler.

Move this guideline over the left part of the object until a red square appears, then let go of the guideline. The
guideline will have moved to the exact left side of the object.

Tips
T i p s

Placing double guidelines
You can drag two intersecting guidelines at the same time from the intersection of the rulers. This is very handy for
quickly placing guidelines on a corner of an object.
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Grouping and ungrouping objects
G r o u p i n g  a n d  u n g r o u p i n g  o b j e c t s

Grouping

Shortcut key "CTRL+G"

You can use the command "Group" from the "Arrange" menu to lock the location of objects in relation to each other. 

Ungroup

Shortcut key "CTRL+U"

By using the command "Ungroup" from the "Arrange" menu you can separate the objects in a group again.

Multiple ungroup
M u l t i p l e  u n g r o u p

If  there are more than one group or groups which have nested groups in a selection, you can use the command
“Arrange, Ungroup”, or the shortcut “CTRL+U”, until all of the groups are removed from the selection. This way you
don’t have to ungroup a selection and select a new group before you can use the command “Ungroup” again.

Combining and breaking apart objects
C o m b i n i n g  a n d  b r e a k i n g  a p a r t  o b j e c t s

Combining

Shortcut key "CTRL+L"

By using the command "Combine" from the menu "Arrange" you can combine two (or more) objects of the same
type. Combining is more drastic than grouping because it changes separate objects into one object. 

Letters are often combined objects; in this way the letter “b” is a shape that consists of one outside contour and one
inside contour. Because the contours are combined, only the letter is filled and the gap in the “b” is transparent. 

When you combine vector objects of different colors and or line styles, the final combined object will receive the color
of the last selected object.

Let us assume you would like to make a letter "b" from the following objects. In this case you need to achieve that
the bar that is displayed remains visible through the gap in the letter "b".

When you put the object to the left on top of the outside outline of the letter "b" you will achieve the following result.
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The letter "b" still consists of two objects that each have a different color and the bar is not visible through the object.

Even if you give the object on top the same color as the background, it might look more like a letter "b", but the letter
"b" still consists of two objects that each have a different color. 

After combining, the object will look as follows.

Break Apart

Shortcut key "CTRL+K"

Break apart means canceling a combination of objects.

Smart break
S m a r t  b r e a k

If multiple objects are combined to form one object, you can now break this object into its individual objects again
using the command “Break apart”.

As the illustration shows, if you break objects such as text, previously you would have had to combine each separate
object again to retain the visual shape of a letter. The program can now do this automatically using the command
“Arrange, Smart break”.

Original

After the command “Arrange, Break”
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After the command “Arrange, Smart Break”

Stacking sequence of objects
S t a c k i n g  s e q u e n c e  o f  o b j e c t s

By using the commands from the menu "Arrange, Order" you can change the stacking sequence of objects. The
stacking sequence of objects determines whether an object lies behind or in front of another object. 

Move forward

This command moves the selected object one place forward in the stacking sequence.
Bring to front

This command moves the object to the foreground of the stacking sequence.

Move backward 

This command moves the object one place back in the stacking sequence.
Put to back

This command moves the object to the back of the stacking sequence.
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Stacking order extended in version 4
S t a c k i n g  o r d e r  e x t e n d e d  i n  v e r s i o n  4

Through “Arrange, Order, Invert selection” you can invert the stacking order of all selected objects.

You can place an object directly in any position of a stacking order. Select the object you want to move in the
stacking order and the select “Arrange, Order, Place in front or Place behind”. The cursor will change, then you select
the object where you want the selected object to be placed behind or in front of.

Multiplying objects
M u l t i p l y i n g  o b j e c t s

This command enables you to create several copies at once. You can adjust the number of copies to be made in
horizontal and vertical direction. You can also indicate the spacing (space between the maximum outline of the copies
to be generated). 
To do this select the command "Multiply" from the menu "Arrange".

In the fields near (1) you can fill in how many copies you would like to have vertically and horizontally. In the fields
near (2) you can set the amount of space between the copies.
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Multiply circle
M u l t i p l y  c i r c l e

This command allows you to make multiple copies that are placed in a circular shape. Select one or more objects and
then select the menu “Arrange, Multiply”. In the dialog, you select the “Circle” tab. 

In this dialog, the current center of the selected object is shown under “Center” (1). These fields represent the
location of the selected object in the worksheet. Under “Radius” (2), you can enter the radius of the circular shape.
When the dialog is opened, a number based on the size of the selected object is placed in this field. The radius is
calculated from the center of the selected object to the center of the objects in the resulting circular shape after the
multiplication.

You will find the following settings under “Angles”.

Start:
Enter the start point of the circular shape here. For these settings you can refer to the illustration in the bottom right
corner of the dialog.  

End:
Enter the end point of the circular shape here. If you enter  0 degrees in the “Start” field, 180 degrees in the “End”
field and 6 in the “Steps” field, you can create a circular shape consisting of 7 objects with a 30 degree rotation
between each object. 
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By entering 0 degrees in the “Start” field, 330 degrees in the “End” field and 11 in the “Steps” field, you can create a
circular shape consisting of 12 objects with a 30 degree rotation between each object.

In both of the above images, “A” is the original object and “B” is the copy of that object. The rest of the objects are
the result of the number you’ve entered in the “Steps” field. The original object is never included in the resulting
circular shape.

Steps:
Enter the number of steps to be used in the resulting circular shape here.

Each step:
The fields “End” and “Steps” are disabled when this field is activated. The number you previously entered for “End”
will be recalculated every time the “Each Step” field is adjusted.

Direction:
You can set the direction of the rotation here.

The option “Rotate object” (4) allows you specify whether the object axle should remain the same during rotation or
whether the object axle is rotated.

With “A”, the “Rotate object” option was activated and with “B”, it was not.

Lock rotation point
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To lock the rotation point so that the original object is not the center but a part of the circular shape, you must select
the object again so that you can access rotation mode. Then you can drag the rotation center to the desired location.
You will now be able to access the dialog. In the dialog you will find the options “Center” and “Radius” disabled
because you have already set these in the worksheet. If you work this way, the original object will always be a part of
the circular shape instead of the center.  

Multiply spiral
M u l t i p l y  s p i r a l

This command allows you to make multiple copies that are placed in a spiral shape. Select one or more objects and
then select the menu “Arrange, Multiply”. In the dialog, you select the “Spiral” tab. 

In this dialog, the current center of the selected object is shown under “Center” (1). These fields represent the
location of the selected object in the worksheet. Under “Radius” (2), you can enter the begin and end radius of the
spiral shape. When the dialog is opened, a number based on the size of the selected object is placed in these fields.
The radius is calculated from the center of the selected object to the center of the objects in the resulting spiral shape
after the multiplication.
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You will find the following settings under “Angles”.

Start:
Enter the start point of the spiral shape here.

End:
Enter the end point of the spiral shape here. If you enter 0 degrees in the “Start” field, 360 degrees in the “End” field
and 12 in the “Steps” field, you can create a spiral shape with one winding of 13 objects and with a 30 degree rotation
between each object. 

By entering 0 degrees in the “Start” field, 720 degrees in the “End” field and 24 in the “Steps” field, you can create a
spiral shape of 25 objects with a 30 degree rotation between each object.

In both of the above images, “A” is the original object and “B” is the copy of that object.. The rest of the objects are
the result of the number you’ve entered in the “Steps” field. The original object is never included in the resulting spiral
shape.

Steps:
Enter the number of steps used in the resulting spiral shape here.

Each step:
The fields “End” and “Steps” are disabled when this field is activated. The number you previously entered for “Steps”
and “End”  will be recalculated every time the “Each Step” field is adjusted.

Direction:
You can set the direction of the rotation here.

The option “Rotate object” (4) allows you specify whether the object axle should remain the same during rotation or
whether the object axle is rotated.
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With “A”, the “Rotate object” option was activated and with “B”, it was not.

Lock rotation point

To lock the rotation point so that the original object is not the center but a part of the spiral shape, you must select
the object again so that you can access rotation mode. Then you can drag the rotation center to the desired location.
You will now be able to access the dialog. In the dialog you will find the options “Center” and “Radius” disabled
because you have already set these in the worksheet. If you work this way, the original object will always be a part of
the spiral shape instead of the center.  

Enhanced multiplying
E n h a n c e d  m u l t i p l y i n g

As of version 5, multiplying has been enhanced so that the copies are still editable, also known as “Step and repeat”.
In EasySIGN this means that the copies remain editable, and not only during the application of this option. When a
worksheet is saved and later reopened, the drag tool still enables you to change the number of copies. By checking
the options of the object, other parameters like the gap between copies can be changed.

Workflow
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Select the object or objects you want to multiply. Select the menu “Arrange” “Multiply”

Adjust the parameters as desired, and set the option “Modifiable” to on. Then click "OK".

You are now in the drag tool mode, the drag tool can be used to move the handle to create more or fewer copies.
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If you want to edit the gap or other parameters through the dialog, choose the “properties” option from the right-
mouse button menu.

Scale and measure tool
S c a l e  a n d  m e a s u r e  t o o l

With this tool you can measure and correct the distances and angles on objects.

If one or more objects need to be modified then first select these object(s). Next choose the command "Scale and
measure" from the menu "Arrange" “Transformations”.

Rotating by using the scale and measure tool
When an object has been scanned and vectored, it usually appears on screen slightly slanted. By using the scale and
measure tool, the object can easily be put horizontal in one move. First select the object and then choose the scale
and measure tool. Find two points in the object which must be put horizontally. Press and hold the mouse button to
draw a dotted line between these two points. 

After letting go of the mouse the following dialog will appear:
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By filling in "0" in "Angle" (2) the object is immediately placed horizontally.

By using this dialog you can also modify the scaling factor of objects (1). This is very handy when you need to modify
the length of a hypotenuse. If you have selected several objects it is often impossible to measure these correctly
because the most outside objects are not always exactly on one line. This is why EasySIGN has "invisible handles".
This means that there is something just inside the drawn handle points onto which a mouse automatically snaps.
These points indicate the exact maximum width and height of objects.

Quick sizing
Q u i c k  s i z i n g

You can save and apply frequently used sizes in EasySIGN for reuse. Select the command “Arrange, Transformations,
Quick size”.
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1 The list with available sizes.
2 Add a new size.

3 Change a selected size.
4 Delete a selected size.

To apply a size just select it from the list and press ‘OK”.

Place objects on a path
P l a c e  o b j e c t s  o n  a  p a t h

It is possible to place any object (including groups, effects and bitmaps) on an open or a closed vector path. 
To do so, first select the objects which you want to place on a path.

Next, select the menu “Arrange, Objects on path” and then click the path.
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Once the objects are on a path, you can choose the option “Rotate objects with path” from the context menu.

With the combination CTRL+CLICK, you can select objects which are placed on a path and modify them. The path
itself can be adapted by selecting it in the object manager and then modifying it.

Example
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Common functionality

Area and Length
A r e a  a n d  L e n g t h

Usage:
Select one or more objects on the worksheet.

Select menu : View > Area and Length.

The following results are available in this dialog:

Area
Represents the area of the selected object. When more than one object is selected the silhouette of the objects
represents the area that will be calculated. 
Consider the following example.

One object, width 100mm, height 100mm.
Result:

Two objects like the one above. 

Result:
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The same objects as above but now overlapping. 
Result:

Area contour
Represents the area of the selected object ignoring any "holes". When more than one object is selected the outline of
the objects represents the area that will be calculated.
Consider the following example.

One object, width 100mm, height 100mm with a hole in it (width 50mm, height 50mm).

Result:

Two objects like the one above.
Result:

The same objects as above but now overlapping. 
Result:

Area extends
Represents the area of the extends of the selected object(s). The extends of an object or objects is the smallest
rectangle that can enclose the object(s).
Consider the following example.

Two objects, the red rectangle around these objects represent the selection extend.  
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Length
This is the length of all lines that are visible when viewing your worksheet in color mode. Layers, fills and no fills and
stacking order are considered when calculating the length. Using this method will make sure that non visible lines will
not be calculated. 
Consider the following example.

Two overlapping objects, both have a fill.

Result:

Same as above but the bottom object has no fill, the result will be the same as the result
above. 

Same as above but now the overlapping (top) object has no fill.
Result:

Length wireframe
As the name already implies this is the length of the selected object(s) as you would view them in wireframe mode.
So all the visible lines in wireframe will be calculated.
Consider the following example.

Four overlapping objects which all have a fill. Below that the same objects but shown in

wireframe.
Result:
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Options

Treat as one vinyl
color

This option is for clarity and will not trigger a recalculation. It just hides the "Area"
and "Area contour" values leaving only the "Area Extends".
  

Include line width. This option will recalculate the area but now including the line width.

Wireframe for length This option is for clarity and will not trigger a recalculation. It just hides the
"Length" leaving only the "Length Wireframe".

Change to last selected tool
C h a n g e  t o  l a s t  s e l e c t e d  t o o l

Before version 4 of EasySIGN the “Tab” key was used to change to the last selected tool. This is changed in the “Esc”
key because of the use of the “Tab” key in text blocks. Also you will find as first item in the context menu of objects
the option “Previous tool” which does the same as the “Esc” key. 
It isn’t necessary anymore to first select the selection tool before you can apply a special effect to a just created
object. You can for example create a rectangle and then without having to switch tools apply an effect.

Context menu (right mouse button menu)
C o n t e x t  m e n u  ( r i g h t  m o u s e  b u t t o n  m e n u )

The use of the context menu has changed since version 4 of EasySIGN. It isn’t necessary anymore to first select the
selection tool before you can access the context menu.

Paste centered
P a s t e  c e n t e r e d

If you paste an object that you have copied in EasySIGN it will always will be pasted on the same coordinates as
where it was copied from. This is an important feature, however in some cases this isn’t practical, for example when
you are zoomed in on a different area from where the object was copied.

The option “Edit, Paste centered” (also in the context menu) will paste the object centered to the current visible view.

Copy Special
C o p y  S p e c i a l

With this function you can copy the whole worksheet or a selection of it to the clipboard. You can then paste this copy
into an e-mail template, a work description, invoice etc.
Select the menu “Edit, Copy special, As bitmap to the clipboard”. This command opens a dialog where you can specify
the color space, size and resolution  of the bitmap.

Vector paths in bitmaps
V e c t o r  p a t h s  i n  b i t m a p s

PSD files (the native format of Photoshop™) and other files can contain vector paths. When EasySIGN imports this
kind of bitmaps, included vector paths are grouped with the bitmap. On the "LIBRARIES"  DVD there is a folder
named "\BITMAP\Masked\Fonts\Chrome005\", in which each bitmap has an included vector path. You can use this
included path as a cutting shape.
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Alpha channels in bitmaps
A l p h a  c h a n n e l s  i n  b i t m a p s

Among other file types, PSD, PNG and TIFF files may contain alpha channel information besides normal bitmap
information.
This so-called alpha channel is a grayscale mask which enables EasySIGN to process this kind of bitmap in a
transparant or masked way. At this moment EasySIGN is only capable of importing TIFF as CMYK together with an
alpha channel. PSD and PNG files have to be RGB files. However, after importing these, you can convert them to
CMYK. See the item on transparency for more information and for how to apply it.

Previews in Windows Explorer
P r e v i e w s  i n  W i n d o w s  E x p l o r e r

Of each file format, supported by EasySIGN, a preview is shown in Windows Explorer. This means that not only
worksheets are shown, but Clipart and Template files as well.

Hilight (Bright Spot) in radial fountainfills
H i l i g h t  ( B r i g h t  S p o t )  i n  r a d i a l  f o u n t a i n f i l l s

Radial fountainfills in EasySIGN support a so called “Hilight”. 

A Select an object and apply a radial fountainfill to it.

B Select the tool to adjust fountainfills and move the cursor above the last node. 

C Press  the right mouse button and from the context menu select the option “Toggle Hilight”.

D A node, indicating the position of the bright spot, appears.

E Move this bright spot as wanted.

F Compare the fountainfill with the one mentioned in "A" (the first step above).

Weld Bitmaps
W e l d  B i t m a p s  

As of version 5, also bitmaps can be welded, the workflow is identical to that of vector objects. To clarify this we will
show you a small example.

Original objects, a bitmap and a text.
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Select the bitmap first, then the text. Next, choose the menu option “Edit, Welding, Mask last selected”.

With the CTRL+CLICK option or by using the object manager the text and bitmap can still be edited.

You can also apply multiple welds.

If your license permits it, extra effects can still be applied to the welds as well as the bitmap.

Open paths
O p e n  p a t h s

When you import vector files (like for example worksheets with the extension .AI) into EasySIGN it sometimes
happens that not all shapes are closed where they should have been. This happens especially when using software
that doesn’t have up to date export filters. It can be very tedious work to correct this manually if you have to check
the job shape by shape.
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In EasySIGN a new procedure for this has been implemented that is very accurate and gives you maximum results.

Workflow
Select all objects that you want to check. Next, select the menu option “Edit”, “Select open paths”. If nothing gets
selected then all objects in the worksheet are already closed. If a selection is left, you can choose the option
“Arrange” “Close open paths”, this will close all open paths in the active selection. This gives you full control over the
end result, as opposed to doing this automatically during import.

Lock objects

Select the object or objects you want to lock.

Select “Arrange, lock selection” (or the same option from the context menu of the object). The selection handles of
the object change to small locks and the object is locked. Every time you select this object this handles wil show so
you know this object is locked.

When an object is locked it can’t accidentally be moved or edited. Especially if you want to trace a bitmap it is easier
to temporary lock the bitmap than to work with locked layers.

You can unlock an object by selecting “Arrange, Unlock selection” or the option with the same name from the context
menu. You can also unlock all objects in a worksheet by selecting “Arrange, Unlock all objects”.

Some properties of locked objects
1 If your worksheet contains locked objects the command “Edit, Select All” will only select objects that aren’t

locked.
2 Locked objects will print or plot. If you don’t want objects to print or plot you have to work with layers.
3 Locked objects can’t be selected with an area select. You can select multiple locked objects by using the “Shift”

key.
4 Locked and unlocked objects can’t be selected together.
5 No transformations or special effects can be applied on locked objects.
6 Since a locked object can be selected a command like “Insert crop marks around selection” can be executed.
7 All transformations and editing features are also blocked in the Object Manager, after all you didn’t lock the

object for nothing.
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Select by size

You can quickly remove objects from your worksheet that meet some size criteria. Normally this is a time consuming
job but necessary because after for example a vectorisation there can be many objects that are to small to plot.
Instead of doing this manually you can select “Edit, Select by, Size ...”.

The dialog has two modes, a simple (see image above) and an advanced (see image below).

1 Here you can set the maximum size of the objects to select.
2 If you check this option an already active selection will become selected together with the new one.
3 Closes the dialog.
4 Select this button if you want the result to be selected.
5 Select this button if you want the result to be deleted.
6 If you deleted a selection through this dialog that action can be undone here.
7 This opens the advanced mode.

1 Here you can set the minimum and maximum size of a width and a height.
7 This will return to the normal mode.

Select objects from top

This feature selects identical objects that are placed exactly on top of each other. These objects can not be detected
by just viewing the worksheet. Situations like this occur when you have pasted the same object(s) multiple times on
the same location or imported a file in which the fill and the line style of an object where exported as two separate
shapes.

Select the command “Edit, Select objects from top”.
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Bitmaps
B i t m a p s

One bit bitmaps

One bit bitmaps (black and white) now can be colored using the color palette. These colors can also be printed. 

A Original bitmap
B In the color palette, click on the yellow color with the left mouse button (fill color) and on the red color with the

right mouse button (line color).
C In reverse order to description provided for A.

You can also use the color tool for fill and outline colors to assign a color to a one bit bitmap that is not present in the
color palette.

Sometimes it is more economical to use a scanned one bit bitmap directly as part of a print instead of vectorizing it
first. Also when vectorizing, it may be easier to place a duplicate under the vectorized bitmap with a contrasting color
assigned to it as a reference for optimizing the vectorization.

Bitmap display

You now have four different display options for bitmaps in wire frame view.

A Border
B Simple grayscale
C Grayscale
D Original

You can find these settings under the menu ‘View, Quality”.

Brightness and Contrast

This method works as follows. Select a bitmap and click on the right mouse button. Select the option "Adjust
Brightness and Contrast" from the popup.
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1 Brightness

 Use this to touch up the brightness of the bitmap. 

2 Contrast

 When a bitmap is too dull the difference between the dark and
light colors can be touched up by increasing the value.

3 Gamma

 This slider modifies the brightness of the colors in the middle of
the palette.

4 Saturation

 Saturation is the strength or purity of the color.

5 RGB settings

 When a bitmap is too red, too green or too blue, you can use the
slider to modify the values.

6 Close

 This button closes the dialog.

7 Apply

 This button applies the modifications in the dialog to the bitmap.

8 Reset

 This resets all the values in the dialog back to the initial values. 

9 Variations

 This button opens the variation dialog (see following description).

10 Graph

 This graph displays an illustration of the modified color curve.
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Variations

"Variations" enable you to visually modify the color balance, the contrast, the saturation etc. of a bitmap.

1 Original/Current pick

 These two thumbnail illustrations at the top of the dialog window
display the original and a preview of the modifications.

2 Horizontal

 Here you can choose which filter possibility you would like to
display and modify horizontally in the dialog.

3 Vertical

 Here you can choose which filter possibility you would like to
display and modify vertically in the dialog.

4 Step size

 Here you can set up the size of the steps for your modifications.
The larger the value the more visible each change is.

5 Horizontal display

 Here the horizontal sliders are displayed.

6 Vertical display
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 Here the vertical sliders are displayed.

7 Show clipping

 Enable this option if you want to see a preview of the areas in the
illustration that could loose color after modification.

8 OK

 This button transfers all modifications to the original bitmap and
closes the dialog.

9 Cancel

 This button closes the dialog without carrying out any
modifications. 

10 Reset

 This button resets all the settings that have been made.

The procedure is as follows
Let us assume that in "Horizontal" you have chosen "Brightness" and in "Vertical" you have chosen "Contrast". In
order to apply a modification all you need to do is keep clicking on one of the thumbnails below.

Special effects

It is possible to apply special effects to all imported or scanned bitmaps. Activate the right mouse button menu of a
bitmap and select the option "Special effects"; a submenu will appear and you can choose any of the available special
effects. 
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In the special effects dialog you will find the following possibilities.

1 The left window always shows the original. When the mouse moves over this
window the mouse cursor changes into a "Hand"; you can then move the
illustration in this window in order to view other parts of the bitmap.

2 The preview (example) window. 

3 This button forces the example.

4 "Auto preview", when this option is enabled all modifications in the dialog will be
displayed immediately.

5 Either by sliding or typing in a value in the box next to it, you can enlarge or
minimize the effect on the original.

6 "Progress", here the progress of the application of the effect is displayed.

7 "Ok", this button applies all the settings that have been made to the bitmap and
closes the dialog.

8 "Close", this button closes the dialog.

9 "Apply", this button applies all the settings that have been made to the bitmap and
closes the dialog.

Convert objects to bitmap

A direct and easy to use command to convert any selected object(s) on the worksheet to a bitmap. Select the object
(s) and the menu “Edit, Convert to, Bitmap”.
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1 Here you can set the color space like RGB, One-bit, Black and White etc.
2 Here you can set the size.
3 Here you can set the resolution.

After applying, all the selected object on the worksheet will be converted to one single bitmap.

Bitmap mode

With this command you can convert a bitmap to a different mode. Select the bitmap(s) and the command “Bitmap,
Mode” and the color space you want the bitmap to be converted to. You can for example convert an RGB to CMYK, a
CMYK to RGB etc.

Working with layers

What is a layer?
When you open a new document you see a white background with a delimited area called the worksheet. On this
worksheet you can import e.g. various bitmaps. You can use these to make a design or picture. If you start to work
on ten or more bitmaps, the use of layers can save time and stress.

Imagine you are working with roughly 60 bitmaps; no matter how fast the program is, the screen composition of a
bitmap takes time. If you use layers you can hide parts of your composition to achieve a faster screen composition.

Setting up layers
From the "View" menu select the command "Layers".
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When using for it for the first time you will always find the standard layers in the layer dialog. These layers cannot be
deleted. The names of these layers are as follows:

1 Main layer

2 Guideline layer

3 Cropmark layer

When opening the dialog the main layer is always selected and activated. You can select the guideline layer and
cropmark layer, change their level and carry out all other layer operations, but you cannot make these the active
layer.

Button Function

Opens a dialog so you can add a new layer.

In this dialog you can fill in the following settings.

Name (1)
Fill in the name you want to give the layer. Make sure it is a recognizable name for you.

Layer options (2)

Visible (3)
Determines whether the layer will be shown or not.

Locked (4)
Not a single object on the layer can be moved or edited after it has been locked.

Enable printing (5)
This layer determines whether the layer may be printed.

Enable plotting (6)
This option determines whether the layer may be plotted.

Opens a dialog so you can set up the properties of the selected layer.

Deletes selected layer.
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 Moves selected layer up a level.

Moves selected layer down a level. 

Moves selected objects from one layer to the layer that has been selected
in the dialog.

Copies selected objects from one layer to the layer that has been selected
in the dialog. 

What status can a layer have?
The following illustrations explain what the status of a layer can be.

Selected

When a layer has been selected you can use the buttons in the dialog to carry out operations on the properties of the
layer.

You select a layer by clicking on it.

Active

Active means that when you import an illustration e.g., it will be placed on the active layer.  You can see a layer is
active by the symbol in front of the name of the layer.

A layer is activated by double clicking on it.

Active and selected
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Add a plotter

To add a plotter select the menu 'File > Device Setup > 'Add Plotter Wizard...'.

Select from the dropdown for drivers (1) the desired device. Click 'Next'.

Select from the dropdown for Ports (1) the Port your device has been connected to. Click 'Next'.
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How this page will look depends on the selected Port from the previous page. On this page make your settings
according the manual supplied with your device.

To finish the installation of your device, click 'Finish'.
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Plotter settings

Select the menu 'File > Device Setup > Open...'. The following Window will become visible.

On the left open the folder 'Plotter Settings' and click on 'Plot Setting 0'. On the right the available plotter settings will
become visible.

A Sorting and optimization

 

1 No sorting
 The subject will be plotted in the same sequence as it is drawn. 
2 Maximum speed
 The different objects are sorted in such a way that they can be plotted as quickly as possible.
3 Minimum vinyl movement
 The data is sorted in such a way that there is as little vinyl movement as possible during plotting. This improves

plotting accuracy, but delays speed.
4 Pin feed
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 If you have a plotter with pin feed EasySIGN takes into account the inaccuracy of the pin feed.
5 Inside first
 A combined object, e.g. the letter "O", first has the inside cut. This has two advantages; it increases the plotting

quality for small letters and it is essential for milling, preventing the shapes from coming loose.
6 Swivel knife
 The shapes are sorted in such a way that a minimum of damage and inaccuracy is caused by the swivel knife

being aligned in the foil.
7 Edge extension
 A closed shape is cut at an adjustable distance over the beginning. This simplifies stripping the vinyl.
8 OK
 Apply the settings made and close the dialog.
9 Cancel
 Close the dialog without applying the settings.

B Plot options

 

1 Quality
 The cutting accuracy on arches. A higher accuracy obviously impedes the speed ("quality 80" is usually the

best choice).
2 Cut weed borders
 If you use weed borders in your worksheet you can state here whether you want to plot them standard or not.
3 Relative plotting
 Automatically places all the objects you want to plot on the zero point of the plotter.
4 Start point behind the plot
 This option ensures that after each assignment the plotter moves back with the pen behind the plotted area.

Here you can specify the value for the distance. This option is not available on all plotters.
5 Extra copies
 Here you can enable whether you want extra copies with each plot and how many.
6 Multi cut
 Here you can enable whether you want the program to use each intersecting line several times and if so how

many. You can use this option for heavy materials which normally cannot be cut in one go.
7 Cut vinyl after plotting
 This option ensures that the plotter cuts the material from the roll after each assignment. This option is only

available if supported by your plotter.
8 OK
 Apply the settings and close the dialog.
9 Cancel
 Close the dialog without applying the settings.

C Plotter settings
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1 Speed
 Here you can adjust the speed of the plotter. This would mainly affect long, straight lines.
2 Acceleration
 Speeding up your plotter. This determines the speed in the corners.
3 Knife offset
 This is a setting for a swivel knife plotter; here you set up the center-to-center distance of the swivel knife.
4 Knife pressure
 The pressure your plotter exercises on the material.
5 Pen number
 If your plotter supports various pens and knives, you may select one here. This enables you to make a choice

between various fixed items, you can only make the selection here.
6 OK
 Applies the settings and closes the dialog.
7 Cancel
 Closes the dialog without applying the settings.

D Device Specific

 How this dialog will look is dependent on the selected plotter driver.

Most plotters do not support all settings mentioned here. If a certain setting is grayed out, your plotter will not be able
to support this. It is possible that you will be able to set up the appropriate value on the plotter. Please refer to the
manual of your plotter for this.

If you remove the tick "Use default settings", the standard setting of the plotter is used. 

CMS (Color Management System)

CMS General
C M S  G e n e r a l

EasySIGN is supplied with an advanced CMS (Color Management System). After the installation of EasySIGN CMS is
activated by default.

What is CMS?
When working with color, a consistent color representation on different devices like monitors and printers is essential.
These devices have to be able to exchange colorimetric information to achieve a predictable end result.

Color is subjective to the human eye. All devices in a production process have a different range of colors. It is
possible that a monitor can display colors that your printer cannot reproduce. CMS will make sure that your monitor
only shows colors that your printer can reproduce.

The range of colors that a device can reproduce is called the gamut. A monitor has a different gamut than that of a
full color printer. This means that a worksheet can contain colors that can be shown correctly on a monitor but can not
be reproduced on an output device. Another problem is that the color gamut of different printers can also be different.
Even on printers of identical make and model, differences can occur. Accurate representation of colors can only be
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achieved when the different gamut’s of all the devices that you use are taken into account.

Using CMS minimizes the difference between the devices in a production process.

What is a profile?
A profile is a file that describes the colorimetric properties of a device like a full color printer. Color profiles are
usually of the ICC (International color consortium) or the ICM (Image color matching) file format. EasySIGN supports
both formats plus it’s own internal format that connects seamlessly to ICC and ICM profiles. With this internal format
you can adjust ICC and ICM profiles to your liking, a process that would otherwise take expensive and complicated
software.

How do I install a profile
When you have a profile provided by a third party you can install it in EasySIGN by copying it to the “\EasySIGN\

Shared\Profiles\” folder.  Or, you can install the profile for all applications by right-clicking the file and choosing
‘Install’.

What is "Rendering intent"?
The rendering intent enables you to choose which method EasySIGN should use when converting colors to fit the
gamut of different devices. The biggest problem you will encounter is that some colors can be displayed on a monitor
but the printer cannot reproduce them. You can choose between four different methods:

1 Perceptual

All colors in a device’s gamut will be scaled to another gamut, keeping the relation between the
colors intact. This method is recommended for reproducing scanned or imported bitmaps.

2 Relative colorimetric

This method will leave colors that fit into both gamut’s intact. Colors outside of the gamut of
the output device will be adjusted  to fit, preserving brightness and color at the expense of
saturation. This method is preferred if accurate color representation is necessary, for example
when printing spot colors.

3 Saturation

Scales the source gamut to the destination gamut but preserves relative saturation instead of
hue, so when scaling to a smaller gamut, hues may shift. This rendering intent is primarily
designed for business graphics, where bright saturated colors are more important than the
exact relationship between colors

4 Absolute colorimetric

Absolute colorimetric rendering reproduces in-gamut colors exactly, and clips out-of-gamut
colors to the nearest reproducible hue, sacrificing saturation and possibly lightness. This
method also takes into account the color of the paper when printing.

Settings
In the menu, select “File, Settings”, and click the tab called “Color management”.
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1 Enable color management
Here you can set if every newly created worksheet should use color management.

2 Monitor
Here you can set if EasySIGN should use the system monitor profile (set in Windows) or a
different, user defined profile.

3 Bitmap import policy
Here you can set how a bitmap should be color managed when importing it.

Prompt user
When importing,  EasySIGN will prompt you for the desired action.

Do not color manage
When importing the bitmap it will not be color managed, even if the bitmap has an embedded
profile.

Use document defaults
The settings of the document will also apply to this bitmap.

Use embedded profile
If the bitmap has an embedded profile it will be used, otherwise the document settings apply.

Settings
Select the menu “View, Settings” en click the tab “Color management”:
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1 Enable color management
This switches color management on or off.

2 Bitmap profile

RGB
Here you can choose the profile used for RGB (24 bit) bitmaps.

CMYK
Here you can choose the profile used for CMYK bitmaps.

Intent
This selects the rendering intent for bitmaps.

3 Vector profile

RGB
Here you can choose the profile used for vectors with an RGB fill/pen style.

CMYK
Here you can choose the profile used for vectors with an CMYK fill/pen style

Intent
This selects the rendering intent for vector data.

4 Set as default
If this option is checked, the current settings will also be used when creating a new document.
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5 Reset.
Restores default values for this dialog.

Important tip
If you want to be able to match colors to the final result as accurately as possible we advise you to use only CMYK
colors in the final output. The color gamut of RGB colors is too extensive for most printers, which will make matching
colors unnecessarily difficult.  When your customers supply designs, ask them for CMYK colors too.

Bitmaps and profiles

When you import a bitmap into EasySIGN the embedded profiles will be used. You can adjust the setting for every
bitmap. Select the bitmap and choose the menu “Bitmap” “Color management”. 

1 Do not use ICC profile
The bitmap will not use CMS.

2 Use document defaults
The bitmap will use the CMS settings of the worksheet.

3 Use other profile
The bitmap will use the selected profile instead of the one selected in the worksheet.

4 Use embedded profile
If the bitmap has an embedded profile, this option can be selected. The bitmap will the use the
profile that was imported together with the bitmap.

5 Rendering intent
The bitmap will use a different rendering intent than set in the worksheet.

6 Export profile
When the bitmap has an embedded profile, it can be exported. You can then use the profile on
the rest of the worksheet too.

CMS display and export
C M S  d i s p l a y  a n d  e x p o r t

The color management  (CMS) in EasySIGN has been enhanced to make its use even more intuitive.

Display settings
In the settings dialog for color management ( can be reached via “File” “Settings”, next the tab “Color management”)
a new option has been added:
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Manage RGB as CMYK

If you activate this option, RGB colors will be shown on screen as they will be printed on for example a desktop
printer. This option was only available with a print license in previous versions (Color proofing).

This option switched OFF:

This option switched ON:

With the use of this option, the screen display will of course be slower because the software has to perform several
extra calculations.

CMS (color management) export
To give you more control over color management, the settings dialog ( can be reached via “File” “Settings”), has the
extra tab “Color management: Output”. In this tab you will find the following settings:

When exporting

Export colors
as:

When this option is active, all colors will be exported as either CMYK or RGB. If this is
not active, the colors will be exported unaltered. This setting will only affect exporting
to vector formats like .AI, .EPS en .PDF.



124 EasySIGN

If you have activated the option “Manage RGB as CMYK” in the color management
settings, we advise you to activate this option also for consistency, choosing CMYK.

The conversion from RGB to CMYK, or vice versa,  will be color managed using the
chosen profiles. If color management is switched off, another conversion will be used.

When printing to PostScript printers

Export colors
as:

When this option is active, all colors will be sent to the printer as either CMYK or RGB.
If this is not active all colors will be send as they are designed in the worksheet.

If you have activated the option “Manage RGB as CMYK” in the color management
settings, we advise you to activate this option also for consistency, choosing CMYK.

The conversion from RGB to CMYK, or viceversa,  will be color managed using the
chosen profiles. If color management is switched off, another conversion will be used.

When printing to 'EasySIGN Print Server'

Export colors
as:

When this option is active, all colors will be sent to EasySIGN Print Server as either
CMYK or RGB. If this is not active all colors will be sent as they are designed in the
worksheet.

Because EasySIGN Print Server has an even more advanced color management
system as EasySIGN we advise you not to use this option, leaving color management
to EasySIGN Print Server

The conversion from RGB to CMYK, or viceversa,  will be color managed using the
chosen profiles. If color management is switched off, another conversion will be used.
 

Production manager

All output in EasySIGN is done with the Production Manager. When you send a job from EasySIGN the Production
Manager will be opened automatically (if not already open) and the job will be visible with it’s current status displayed.
If you want so save a job for later reuse, you have to activate the option “Keep in Production Manager” in the output
dialog from EasySIGN. The job will then remain in the Production Manager even after completion, giving you more
than enough time to save the job.

With the Production Manager you can keep several output devices running simultaneously.
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1 Menu.
2 Button bar.

Opens a previously saved job. You have to make sure to open a job with the same output
device selected as when you saved the job. If you open a job in a different output device the
result will be unpredictable. Best is to save a job with the name of the output device in the file
name. 

Saves a selected job to file. This way you don’t have to wait until a repetitive job is calculated
again by EasySIGN. You just open the file and activate it. Keep in mind that these job files can
get very large. Remove them when they are no longer needed.

Activates a selected job that is paused.

Pauses a selected job that is active.

Stops a selected job that is active.

Removes a selected job.

Keeps a job in the Production Manager even when it is finished.

These buttons give you control over the job priority. You can move jobs up and down the list, a
job at the top of the list will be sent first.

3 Available output devices and jobs.
For each installed device in EasySIGN an icon is added. Below these icons you can then find the currently
active jobs.

4 State of a selected job.
All properties including speed, size and start time of a selected job can be found here.

Trough the first menu in the menu bar you can reach the following extra options.
1 Pause all.
2 Remove all jobs.

You can’t close the Production Manager when there are still jobs in it, active or not. With this command you can
clear the Production Manager, all active or unfinished jobs will be lost.

3 Settings
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1 This option makes sure that a job is only sent to the output device when EasySIGN is ready calculating the
complete output.

2 This option will ensure the Windows™ spooler is used instead of the internal spooler.
3 Here you can set multiple folders for temporary files. If none is entered the default Windows™ temporary

folder is used.

Print Windows

When you choose the command "Print Windows " from the menu "File", the standard Windows printer dialog appears.
The only difference is that we have added a number of functionalities. At the bottom of the dialog you will find several
extra options which we will explain in more detail here.

All
This option prints everything on your worksheet.

Se le ction
This option only prints the objects on your worksheet  that you have selected.

Size
Here you can fill in how large you want your worksheet to be printed.

Fit to  pa ge
When you activate this option all objects in your active window (all objects in and around your worksheet) are
reduced in size to fit on the paper format of your Windows printer.

T ile
If you enable this option, your whole worksheet is automatically divided into different tiles. These tiles are printed with
an overlap of 5 mm on each side.

Print wireframe
This option does not print your worksheet in color or gray tones as standard, but prints all objects as wireframe
graphics.
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Optical Positioning System (OPOS)

In EasySIGN you can make a “Print & Cut” combination of your printer and plotter. EasySIGN supports predefined
and custom Optical Positioning Systems. 

Predefined systems are provided by a plotter manufacturer. Whenever you select a predefined system EasySIGN will
automatically use the specifications provided by the manufacturer. When you use a custom system there are no
special limitations.

Activate the system
Select the command “View, Settings” and then the tab “Crop marks”.

1 Show or hide the crop marks.
2 Lock crop marks to page.

With this option activated the crop marks will be recalculated with every change in page size or orientation.
3 Here you select the system you want to use.
4 Here you set the crop mark dimensions. 

When you have selected a predefined system the size of the crop marks is bound to limitations specified by the
manufacturer.

Use the system
The worksheet will need to contain plotable and printable objects.
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Activate the OPOS system (“View, Settings”, “Cropmarks”).

Next you select only the objects you want to print and select the command “File, Full Color Printing”. In the print
dialog activate the option “Selection only” and the option “Print & Cut crop marks”. Then select “Print”.
After printing the worksheet take the material from your printer and place in your plotter. The optical positioning
system is different for every plotter. Read the manual from your plotter for exact guidelines.

Select in the worksheet the object you want to plot and then the command “File, Plot”. In the dialog you activated the
option ‘Selection only” and the option ‘Aligned plotting”. Then select “Plot”.

Now place the head of your plotter over the first crop mark and follow the steps (if any) in the control panel of the
plotter. 

Move the crop marks
You can move the crop marks with the paneling tool.

Warning
Do not move any of the objects on your worksheet between the print and the plot job, this will cause unpredictable
results.

Masking

Masking is a way of cutting out bitmaps and other vectors using vectors and without damaging the original. E.g. when
you place a bitmap over another bitmap you will always have the rectangle limiting borders you have to take into
account. If, e.g. you want to edit the two photos below in such a way that the face of the man lies credibly over the
background, then you will only be able to do so by masking. However, masks cannot be plotted, only printed.
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If you try to do this without masking, you will always be able to see the straight separations of the bitmaps as you see
below.

In order to get the illustration of the man realistically over the background, you must draw a line that follows the
outline of the face.

Once you have drawn the outline you need to make sure that only the bitmap is selected. From the menu "Arrange"
select the option "Masking" and then the command "Place in mask"; the cursor changes shape and you can now select
the object that will serve as a mask. Everything that falls outside the mask will no longer be displayed (or printed).

When you place the above masked object over the other photo you will see the following result

Drawing tools

Bezier drawing tool
B e z i e r  d r a w i n g  t o o l

Almost any shape can be made with this "digital pencil". The use of this pencil is slightly more complicated than a
normal pencil but on the other hand there are many more advantages. When you draw with an ordinary pencil the
firmness of your grip determines how flowing a curve looks. A digital pencil always has a firm grip, you only need to
determine the shape. 

Use
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Select the "Bezier drawing tool" from the toolbar. The cursor will change as follows.

Use this cursor to click somewhere on the worksheet (1), let go of the mouse button and move to a different location
on the worksheet (2). Click again with the cursor on that particular location and click once on the right mouse button
to break off the line (3). You now have a straight line left on the worksheet. If you want this line to be exactly
horizontal or vertical (with in-between steps of 15 degrees) hold the CTRL key while moving the mouse. 

Drawing a curved line is slightly more complicated but after practicing a couple of times this method will seem logical
and easy to carry out.
Click once on the worksheet (1) and move the mouse a short distance to a different location without letting go of the
mouse button (2). Next let go of the mouse button and move towards a point on the worksheet where you then click
once on the left mouse button to complete the operation (3) and once on the right mouse button to break off the line.
You now have a flowing curved line.

Of course we cannot describe all possibilities here, but these two basic methods should enable you to draw almost any
existing shape. You will find that this way of drawing enables you to work much better, faster and easier than any
other method. You only need to remember a few things:

1 Clicking and immediately afterwards letting go of the mouse button after a move, gives a straight line.
2 Clicking and first moving a little holding the mouse button, gives a curved line after the second move.
3 To break off a line (to stop) click once on the right mouse button. 

Scribble tool
S c r i b b l e  t o o l  

This tool functions in the same way as an ordinary pencil. All movements made with the mouse are transferred to the
worksheet.

Use

Select "Scribble tool" from the toolbar. The cursor will change as follows.

Next click somewhere on the worksheet with this cursor and begin to draw. The result of this method of drawing will
usually need to be touched up with the drag tools to remove the inaccuracies of the mouse movements.
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Rectangle drawing tool
R e c t a n g l e  d r a w i n g  t o o l  

The rectangle drawing tool is a fast way to draw a rectangle or square. In EasySIGN a rectangle is an object with its
own specific properties. This means that a rectangle is more than a vector, such as a shape made with e.g. "Bezier
drawing tool". In the case of a rectangle e.g. you can use the drag tools or a dialog to round off the corners and
determine the look of the corners.

Use

Select the "Rectangle drawing tool" from the toolbar. The cursor will change as follows.

Click with the cursor somewhere on the worksheet (1) and move the mouse without letting it go. After letting go of
the mouse cursor a rectangle will appear on the worksheet (2). If you do the same as in (1) and (2) but then using
the CTRL key, the same move will leave behind a rectangle (3). If you hold the Shift key while dragging, the
rectangle will be drawn from the center.

After drawing a rectangle you can modify the corner points by using the drag tools or a dialog. In order to do this
select the rectangle and click once on the right mouse button. From the PopUp menu that then appears you must
select the command "Properties", and the following dialog will appear.

In this dialog you will find the following settings:
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1/2 Here you can determine the length and height of the rectangle.
3 In this box you can determine the radius of the corners.
4 Here you can determine what the corner is to look like.
5 When you click on the button "Close" the dialog is closed without copying the settings you made.
6 The button "Apply" transfers the settings you made to the rectangle without closing the dialog. You can see the

applied settings directly on screen.

You can also round off the corners or change the shape by using the drag tool.

Select the drag tool.

The face of the rectangle will change (1), and you will see eight anchor points appear. Select one of the anchor points
on the corners of the object and move along the line of the rectangle (2) holding the mouse button.  The corners will
now be rounded. When you use the selection tool to distort a rectangle the corners are also distorted. If you do the
same with the drag tool (3) only the horizontal or vertical scale of the rectangle will change, the corners will remain
the same.

Circle drawing tool
C i r c l e  d r a w i n g  t o o l

The circle drawing tool is a fast way to draw an ellipse or a circle. In EasySIGN an ellipse is an object with its own
specific properties just like a rectangle.

Use

Select the "Circle drawing tool" from the toolbar. The cursor will change as follows.

The drawing method is identical to that of drawing a rectangle with the only difference that you are now drawing
circles and ellipses instead of squares and rectangles.

Draw a circle by holding the control key while dragging.

Make sure the circle is selected and next select the drag tools. Move the mouse along the circle but make sure you
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stay within the radius of the circle with your drag tool.

You have now drawn a "pie slice". Do the same but this time make sure you stay outside the circle with your drag
tool.

You have now drawn an "arc".

Draw a new circle and select it with the drag tool. Select the bottom anchor point and move it upwards and do the
same with the right anchor point but drag it to the left.

This way you can turn a circle into an ellipse. If you want to change the ellipse back to a circle, press the shift key
and select the right or the bottom anchor point. By moving the mouse you can turn the object back into a circle and at
the same time you can scale the object integrally. If you do the same but this time with the control key, the shape of
the object will stay the same only it will be integrally scaled.

These properties can be set up in the same way as with the rectangle using a dialog. In order to do this click with the
right mouse button on the circle and select the menu item "Properties" to call up this dialog.

Star drawing tool
S t a r  d r a w i n g  t o o l

You can also change the shape of a star using the drag tools or by clicking on the object with the right mouse button
and then choosing the option properties. This operation opens a dialog in which you can numerically determine the
properties of the object.

Use
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Select the "Star drawing tool" from the toolbar. The cursor will change as follows.

Place the cursor somewhere on the worksheet and draw the star by holding the left mouse button and making a
dragging movement.

Next select the drag tool and move the right anchor point along the outline of the star.

In this way you can increase the number of star points. When you move in the other direction the number of star
points is reduced. Next select the anchor point on the left of the previous one and move it towards the outside of the
star.

This way you are able to modify the inside radius of the star. Now select the left anchor point and move the mouse
towards the center of the star.
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This way you will be able to modify the outside radius of the circle. With both methods you can reduce or enlarge the
radius of the circle.

Polygon drawing tool
P o l y g o n  d r a w i n g  t o o l

Just like with all other objects in EasySIGN a polygon can be edited using the mouse or a dialog.

Use

When you select the "Polygon drawing tool" from the toolbar the cursor will change as follows.

Both drawing with this tool and its properties are identical to those of the star tool.

Arrow drawing tools
A r r o w  d r a w i n g  t o o l s

Just like with all other objects in EasySIGN an arrow can be edited repeatedly by using the mouse or a dialog.

Use

If you select the "Arrow drawing tool" from the toolbar the cursor will change as follows.

Both drawing with this tool and its properties are identical to those of the other objects in EasySIGN. The only big
difference between the object "arrow" and the other objects is the number of control anchor points.
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A You can move this point from left to right in order to modify the point of the arrow.
B You can move this point in all directions to modify the overhang of the arrow point. If you use the shift key

while dragging, point "C" will be carried along over the same distance and in the same direction.
C You can move this point in all directions to determine the width of the front of the arrow and the indentation of

the arrow point. if you press and hold the Control key when you move it, the object will be moved (depending
on the direction it is moved in) over a horizontal or vertical line.

D This point influences the length of the arrow's tail. If you use the shift key while dragging, point "C" will be
carried along over the same distance and in the same direction.

E This point determines the indentation of the tail of the arrow.
F This point ensures that you can still move the object when using the drag tool.

Spiral tool
S p i r a l  t o o l

With the Spiral tool you can draw normal and special type spirals.

Use

Select the Spiral tool from the toolbox and click and drag to draw a spiral. When holding the Control key while
drawing the X and Y radius will stay the same.

After drawing the spiral you can use the drag tool to adjust among other properties the number of windings.
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When using the property dialog of the spiral you can get much more out of this shape. Select a spiral and then form
the context menu the option “Properties”.

1 The X and Y position on the worksheet. 

2 Begin and end angle.

3 The horizontal, vertical and inner radius of the spiral. 

4 Number of windings. 

5 Direction. 

6 Type

Constant

Exponential

7 Shape

Here you can combine different top and bottom shapes into a new and unique spiral shape.
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Vector brush
V e c t o r  b r u s h

The Vector brush is a quick and handy tool for vector retouch.

Use

Select the Vector brush tool form the toolbar, the cursor will change and the following toolbar will appear.

Here you can set the width and shape of the brush. By clicking and dragging you can paint a vector shape just as you
would paint with a real brush. The resulting objects can be used to melt with objects you want to retouch.

By clicking, then releasing the mouse cursor and drag, you can paint straight lines. When using the Control key you
can restrain these lines to angles of 15 degrees. 
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Vector eraser
V e c t o r  e r a s e r

The Vector eraser is a tool for editing open and closed vector shapes.

Use

First select one ore more objects you want to use the eraser on, then select the Vector eraser tool from the toolbox.
The cursor will change and the following toolbar will appear. 

Here you can set the width and shape of the eraser. By clicking and dragging you start erasing parts of the selected
objects.

You can use the eraser on any object, even text, groups and complex effects. Notice that when you use the eraser
the objects are all converted to curves. You can even use the eraser on bitmaps, the actual bitmaps data will not be
changed but the bitmap will be placed in a mask like container.

By clicking, then releasing the mouse cursor and drag, you can paint straight lines. When using the Control key you
can restrain these lines to angles of 15 degrees.

Editing drag tool and nodes

Editing drag tool and nodes
E d i t i n g  d r a g  t o o l  a n d  n o d e s

All objects in EasySIGN are built up of basic elements which we call paths. In this way a line/curve is a part of a line
between two nodes.

You can use the drag tools to change the features of the path and the nodes. In this way you can change the shape of
an object; a straight line can be changed into a curved line and then it can be given any shape desired.
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If you want to change the shape of an object using the " Edit, drag tools”, the object must first be transformed to a
curve. You will find this option in the menu Convert to, Curves". This is not necessary for objects that have been
drawn because they are directly drawn in curves. Rectangles, circles and such must first be transformed to curves. If
objects are grouped, they must first be taken out of the group.

You will find the symbol for the drag tools in the toolbar and it will look like this.

Add nodes
A d d  n o d e s

Select the option from the window, the cursor will change into a drag cursor with a "+" alongside it. Any part of a line
you click on with the cursor will add an extra node. Once you have selected two nodes, an node is added in the
middle of the curve. When you have completed adding these you can exit this mode by clicking on the worksheet.

Delete node
D e l e t e  n o d e

Select the node or the nodes you want to delete and then select this option.

Open shape
O p e n  s h a p e

Select the option from the window, the cursor will change into a drag cursor with "scissors" alongside it. Each line you
click on with the cursor will be cut open. When you have finished cutting, you can exit from this mode by clicking on
the worksheet.
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To line
T o  l i n e

Select the curved line you want to transform into a straight line and then select this option from the window.

To curve
T o  c u r v e

Select the straight line you want to transform into a curved line and then select this option from the window.

Close node
C l o s e  n o d e

Select the nodes you want to close and then select this option from the window. If you have selected more than two
nodes, the nodes closest together will be closed. If you have selected two nodes, the nodes selected last is used as
the location determinator. This means that when you use the shift key to select two nodes, the node selected last
remains in its current location and the node selected first is moved towards this location. These settings are optional.

Breaking nodes
B r e a k i n g  n o d e s

Select the nodes you want to break and then select this option from the window.
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Sharp node
S h a r p  n o d e

Select one or more nodes you want to make sharp and then select this option from the window. A sharp node means
that only the control handle you edit with the mouse is changed, the adjoining handle is not influenced.

Smooth node
S m o o t h  n o d e

Select one or more nodes you want to smooth and then select this option from the window. A smooth node means
that each modification to this node with the control handle has an effect on both the edited and the adjoining control
handle. The adjoining control handle will only change when the angle of the edited control handle changes. When you
modify the length of the edited handle, the adjoining handle will remain unchanged.
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Symmetrical node
S y m m e t r i c a l  n o d e

Select one or more nodes you want to make symmetrical and then select this option from the window. A symmetrical
node means that each modification of this node with the control handle has an effect on both the edited and the
adjoining control handle. The adjoining control handle will also change when the angle of the edited control handle
changes and also when you change the length of the edited control handle. The handles will both be the same length.

Horizontal alignment
H o r i z o n t a l  a l i g n m e n t

This option aligns all selected nodes on a horizontal line.

Vertical alignment
V e r t i c a l  a l i g n m e n t

This option aligns all selected nodes on a vertical line.
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On one line
O n  o n e  l i n e

All selected nodes are placed on one line between the first and the last selected node.

Right angle
R i g h t  a n g l e

Select the nodes you want to put at a right angle and click on this tool. 

Substitute for line
S u b s t i t u t e  f o r  l i n e

Make a straight line of all selected line parts between the first and last node.
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To circular arc
T o  c i r c u l a r  a r c

Select the option from the window, the cursor will change into a drag cursor with an "arc" alongside it. With this tool
you can draw an arch from any type of line, and from this arc another arc etc.

Rounding corners
R o u n d i n g  c o r n e r s

When you use this tool you can round all corners that are located between two straight lines.

Settings
S e t t i n g s

When you select this button a dialog appears in which you can make the following settings for the drag tools.
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1 Last selected.
 This option ensures that the last selected node is always used as orientation for connecting the ends. 

 

2 Middle
 This option ensures that nodes that are connected with each other always come together in their respective

middle.

 

3 With line
 This option ensures that the nodes that are to be connected to each other will stay in their place and will be

connected through a line.

 

Quick connect

A unique and very fast drawing method. Where you used to tediously edit lines, add nodes, connect nodes and were
obligated to work with guidelines you now only have to use one menu item. 
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To change the lines in the figure above into a closed object you had to add nodes on the intersection points of the
lines, remove lines and then close the overlapping nodes. Now you only have to select the lines and use the command
“Arrange, Quick connect” to get the closed object as shown below.

‘Quick connect” can also handle a combination of closed and open objects.

After applying ‘Quick connect” on the objects shown above you get the following results.

By strategically placing lines you can get results even faster than with welding or stamping objects. 
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Experiment a little to get acquainted to how “Quick connect” handles in different situations, then you will notice that
most of your drawings can be made ten times faster than before.

Paneling

What are panels and when are they used? 

Even if you have a large format printer, this does not necessarily mean you can print all sizes. All equipment has a
maximum size. A printer with a material throughput of 90 cm can often only use 88 cm of this width effectively.

How?
A large format printer that works with rolls has a maximum length of print that depends on the length of the roll. The
width is determined by the effective print width. So the length is hardly ever a problem; the width is however. For
both orientations there is the possibility to divide the worksheet into panels. Panels are a demarcation on the
worksheet that you can specify yourself and that must be based on the effective print width and the maximum length
of the medium. The demarcations ensure that during printing of the worksheet, the worksheet is divided into panels
that have been defined by you. In order to illustrate this we will use a fictional assignment of which the throughput is
larger than our printer would normally be able to cope with.

In this example we will assume that the print job has an output format of 3000 mm high and 4500 mm long; the
effective width of the printer is 700 mm.
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Panel lines using the mouse
The lines you need in order to specify panels can be applied in two ways, either with the mouse or by using a
numerical input in a dialog. To use the mouse for tiling do the following. From the tool bar select the symbol "Panel
tool".

When the tool has been activated the cursor will change as follows.

When you use a portrait orientation as in this example, each click on the worksheet will place a horizontal line (a
panel line oriented along the paper). If you want to place a vertical panel line, hold the shift key and click on the
worksheet. Apart from the difference between horizontal and vertical panel lines, there is also the difference between
negative and positive. If you click on one of the other tools or on the Tab key, you will close the panel line mode.

Panel lines using a dialog
From the "File" menu select the option "Panelling setup". The following dialog will appear.

Using this dialog you can automatically divide the worksheet into panels by setting the maximum size of a panel. As
the orientation of the worksheet is not important for panels (portrait or landscape) only the zero line of the printer,
"horizontal" is always parallel to the pin feed (running direction) of the page.
In the field "Size horizontal" (1) fill in the maximum size of the horizontal panel (in this case equal to the length of
your page). As we are using a roll of material, no panel lines are needed here. Fill in the length of the page or a
larger number. In "Size vertical" (2) fill in 600 units. With "Overlaps" (3) we mean the total overlap of a vertical panel
line and "Overlap horizontal" (4) means the total overlap of a horizontal panel line. In "Overlap vertical" fill in 100
units. We are not using an actual overlap here but an extra large one, as this more clearly demonstrates the division
of panels over a worksheet.
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Now you could say that you have an effective print width of 700 mm. So why are you only using 600 mm. The
explanation is very simple, for each specified width you must add on the total overlap.

Negative and positive panel lines
Positive panel lines are the most frequently used panel lines, if you are going to print a job that is larger than your
effective print width you need an overlap in order to be able to paste the separate panels together. A positive panel
line determines the size of the overlap. When you spread a print over several panels that are to be placed in a
concertina shape, you will need a positive overlap in one corner and a negative overlap in the corner on the other
side.

A The vertex near "A" folds towards the inside. This means that at this point part of the drawing is no longer
visible. At this point a negative overlap is necessary. A negative overlap leaves out a width in the print contrary
to a positive overlap which adds a width to the print. 

Horizontal Vertical

A negative overlap is displayed by three dark gray continuing lines.

B The vertex at "B" folds towards the inside, this means that if you do not want the print to be broken by a seam,
you need to apply a positive overlap here.

Horizontal Vertical

A positive overlap is displayed by two dark gray dotted lines on the outside and a continuing light Grey line in the
center.
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A The original.
B The result after a negative overlap.

C/D The result after a positive overlap.

Orientation of panel lines
In the illustration below you will find an explanation of how the program sees the location and format of the overlap.

The next illustration is the bottom of a portrait oriented page with a width of 3000 mm and a height of 4500 mm (the
page from our example).

Hold the cursor above the left panel line and click on the right mouse button to make a PopUp menu appear. From this
menu you select the option "Panel line properties". The following dialog will appear. 

Because the right side is the zero line of the printer, the heart of the selected panel line is at 2400 mm. This is the
distance of the zero line of the printer towards the heart of the panel line. The panel line is seen as a horizontal panel
line because the horizon runs parallel to the zero line of the printer.

Paneling for plotting
P a n e l i n g  f o r  p l o t t i n g

You can use paneling when the work you want to plot is larger than the output of your plotter. Suppose you have a
design that is 180 cm x 180 cm and your plotter only supports vinyl that is 100 cm wide. This means you have to plot
your design so that after plotting you can join two separate pieces of 90 cm.
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First, adjust the page size to the size of your design, select your design and look at the status bar to get the actual
size or use the tool for scale and measurement. You assign these measurements to the page size (menu: “View”,
“Settings”, “Page”), to make sure that the design is centered to the page. Now you can add the paneling lines to your
worksheet: 

Paneling is based on the size of your worksheet, so if you don’t adjust the size of your page to the design, the blank
spaces on your worksheet will also be included in the paneling process. This would cause unnecessary waste of your
expensive vinyl:

In the situation above your work would come out of the plotter as displayed below. The black arrows mark the
unnecessarily used vinyl:

The best way of getting acquainted with paneling is to plot some small-size worksheets, so you can see and try out
how paneling works.  

Adding paneling lines for plotting 
Select from the toolbar the “Paneling tool”:

When selected the cursor changes as below:
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Click on the worksheet where you want the paneling line. 

A paneling line always has the same direction as the pin feed of the worksheet. If you want to add a paneling line at
right angles to the pin feed, you have to click the paneling tool while holding down the shift key. Once you have
placed a paneling line, you can edit its properties by pressing the right mouse button, when you are over that
paneling line. From the context menu select “Properties”. In the dialog you can then adjust the exact location and
overlap of that paneling line:

Plotting
When you start the plot you have the possibility of plotting all the panels at once or one at a time. When you want to
print a single panel, you activate this option and insert the number of the panel. You can see these numbers on the
worksheet when you are in paneling mode (when the paneling tool is selected).

Scanning

What resolution do I need to scan in on?
W h a t  r e s o l u t i o n  d o  I  n e e d  t o  s c a n  i n  o n ?

The following rule would be sensible to use: a bitmap should be 72 DPI (Dots Per Inch) in 1 to 1 use. This means that
when you print the bitmap a size 50 x 70 cm, the bitmap is allowed to have a resolution of 72 DPI for this size. If the
bitmap has a lot of detail, you could even double the resolution.
The printer only has a certain amount of DPI as output, everything above the printer's capacity is ignored. What is not
ignored is the calculation time for printing. A bitmap with 72 DPI can give the same result as a bitmap of 2400 DPI,
the difference being that the bitmap of 2400 DPI takes up ten times as much space on the hard drive. The calculation
time for processing the print is also multiplied by factor ten, even though the result is hardly better. If you think the
resolution could be better, increase it with just a few steps or double it, but do not immediately multiply it by ten. 
In the world of offset, films are used that are made on a printer with an output of 2400 DPI (inkjet printers are
available from 180 to 600 DPI). The resolution that bitmaps of 1 to 1 use here is 300 DPI with a screen of 150 LPI
(Lines Per Inch). This resolution is used for most full color prints. So why would you use 2400 DPI for a photo?

To make it easy EasySIGN has a "Wizard" for scanning which advises you about the correct resolution to scan in on. 

From the menu "File" elect the command "Scan", and from the submenu select "Wizard". The next dialog will be
opened.
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In the middle of this dialog there is a button "Select Source"  (1). When you click on this button a dialog appears,
displaying the scanners that have been installed on your system. From the dialog select the scanner you want to use.
Once you have done this, click on the button "Next" (2).

In this window fill in the width and height of the original on your scanner (1). Once you have done this, click on the
button "Next" (2).
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In this window fill in the size of the print you want of the original (1). Once you have done this, click on the button
"Next" (2).

In this window the advised resolution will be displayed (1). When you click on "Finish" (2) the standard dialog of your
scanner will be opened. In this scan dialog fill in the value you have been advised. We cannot display the scan dialog
here because this differs for each scanner. For further details on the use of the scan dialog we refer to the manual of
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your scanner.

Color management

Use of colors
U s e  o f  c o l o r s

At the bottom of the EasySIGN screen you will generally find the current color palette and if this is not the case you
can first choose "View" from the menu and then the command "Color palette".

The color palette is a floating bar, which means that you can drag the bar and change its size. 

If you want to allocate a color to an object, select the object and in the color bar click on the color you want to
allocate. When your mouse is over a colored area, the name of the color under your mouse is displayed in the color
bar. One click with the left mouse button will allocate the selected color to the fill of the object and one click with the
right mouse button will allocate the color to the line of an object. If you want to delete the fill or the line of an object,
for the fill just click with the left mouse button on the square with the cross through it and for the line click with the
right mouse button on the square with the cross through it.

If you would like to change the color of an object or create a new color, first select an object and then the color tool
from the toolbar.

When you have selected this option the following dialog will appear.



157EasySIGN

1 Color model
 Here you can choose the color system that you would like at this moment. EasySIGN offers a wide range of

color systems such as: 
 RGB : Red, Green and Blue
 CMYK : Cyan, Magenta, Yellow and Black
 Gray values : Composed of shades of gray
 HSB : Hue, Saturation and Brightness
 Spot colors : Full colors specified by the printer suppliers.
 CMYKOrGr : Cyan, Magenta, Yellow, Black, Orange and Green
 CMYKLiCLiM : Cyan, Magenta, Yellow, Black, Light Cyan and Light Magenta
2 The visual display of the chosen color system. The color can be influenced by using the sliders in the bar (A) or

by filling in a value in the text box (B). The result is displayed in the palette (7).

 

3 Static color bars
 When you activate this option the color bars look the same as in the above illustration and you can mix

according to your knowledge of color. If you are not familiar with the mix values e.g. what color you get when
mixing green and red, you can disable this function. The color bars will now change into a type that shows you
which way to slide in order to get a certain color. With every movement of one of the sliders all the bars are
modified.

 

4 The button 'Close" closes the dialog 
5 The button "Apply" transfers the color from the dialog to the selected object.
6 The button "Add" opens a dialog so you can add the color to your palette.
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In order to add the color to the table you must give the color a name in field (1) and click on "OK".

Default color
Each time you draw an object in EasySIGN this has a default fill, line style and line color. You can choose the default
yourself. To do this click on a color in the color bar or create a color in the color dialog, without selecting an object.
The same work method applies to creating a default line color.

Color palette and library management
C o l o r  p a l e t t e  a n d  l i b r a r y  m a n a g e m e n t

If you want to rename colors from your color bar, delete them, change a color or add a color from a library, you must
select the following tool from the toolbar.

When you have selected this option the following dialog will appear.
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1 When you select a color from the list (2) the name of this color is displayed in the textbox (1). You can use this
field to change the name. 

2 In this list you can sort a color, select it to rename it or select it to delete.
3 Here you will find the commands for editing the colors that are in the list (2):

This option orders the list alphabetically.

This option puts the selected color at the top of the list.

This option moves the selected color up one place on the list.

This option moves the selected color down one place on the list.

This option puts the selected color at the bottom of the list.

This option deletes the selected color

4 The "OK" button applies all modifications and closes the dialog. 
5 The "Cancel" button closes the dialog without carrying out the modifications.
6 The “library” button opens the next dialog.
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1 From this list you can select the name of the required library.
2 This list displays the color names or product numbers of the selected library. Here you can choose several

items simultaneously.
3 The "OK" button transfers all selected items to the list in the previous dialog where you can select or modify

them.
4 The "Cancel" button closes the dialog without modifying anything.
7 The button "Edit" opens the standard color dialog where you can modify the features of the color.

Select by color
S e l e c t  b y  c o l o r

The command "select by color" from the "Edit" menu opens a dialog that can select all objects of a certain color at the
same time.
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1 List with all the fill colors from the worksheet.
2 List with all the line colors from the worksheet.
3 Add the selected line and fill colors to the selection list(4). 
4 The selection list.
5 Deletes selected item form the selection list..
7 The "Select" button ensures that objects on the worksheet that correspond with the color in the list you have

specified, are selected.
8 The "Deselect" button ensures that the objects on the worksheet that correspond with the color in the list you

have specified are unselected.

Select by object
S e l e c t  b y  o b j e c t

The command "Select by object" from the "Edit" menu opens a dialog that works in the same way as the previous
dialog with the difference that this dialog can select all objects of a certain type at once.

Quick select objects with similar fill style
Q u i c k  s e l e c t  o b j e c t s  w i t h  s i m i l a r  f i l l  s t y l e

Select an object and then from the context menu the option “Select by, Similar fill style”. All objects with the same fill
style will be selected. The selection looks for objects with the same color name instead of color values.
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Quick select objects with similar line color
Q u i c k  s e l e c t  o b j e c t s  w i t h  s i m i l a r  l i n e  c o l o r

Select an object and then form the context menu the option “Select by, Similar line color”. All objects with the same
line color will be selected. The selection looks for colors with the same color name instead of color values.

Quick select similar objects
Q u i c k  s e l e c t  s i m i l a r  o b j e c t s

Select an object and then from the context menu the option “Select by, Similar objects”. All identical objects will be
selected. 

Registration color
R e g i s t r a t i o n  c o l o r

What is registration color

Registration color is a separate color space. This color is not an actual color but a property. If an object has this
property, it will be printed and plotted together with every color in a color separation. The property “registration color”
causes crop marks to act the way they do. You can assign this property via the color tools for line or fill styles, or via
the color palette. The registration color is indicated on the color palette by the black field with the white “R”.

You can assign any color to the property registration color to emphasize the difference between registration colors
and normal colors in your worksheet. A default color for the registration color can be assigned via the menu “File,
Settings” and the tab “General”. Every new object with a registration color will be shown in this color. These settings
have no effect on objects with this property already assigned to them. You can change the appearance of objects with
this property via the color tools for line or fill styles.

In the above illustration, “A” is the object with the property registration color and the color red assigned to this
property.

1 Color separation in red
2 Color separation in green
3 Color separation in blue

The registration color is automatically included with each color separation.
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Measuring colors
M e a s u r i n g  c o l o r s

In EasySIGN you can input colors into the software by means of a densitometer. A perfect way to make your own
color library! 

Settings
Open the menu “File, Settings” and select the tabsheet “Densitometer” in the opened dialog.

1 Select here the option “Yes, I want to use my densitometer”

2 Select the brand of densitometer in the combobox.

3 Select the port the densitometer has been connected to. If you have chosen a densitometer
with USB connection in the combobox, this option is not available. Don’t use automatic
densitometers that measure several colors in one pass, but use one that measures only
one color at a time.

4 Press this button to find out whether the densitometer is recognized. This can take a while,
wait for the message which indicates that the densitometer is recognized.

5 Select the color space in which the measured colors must be stored (CMYK of RGB). If you
intend to print the colors, you should use the CMYK color space.

6 Here you can select the desired profile for the CMYK and RGB color space. If you have a
printer and a (ICC of ICM) profile for this printer: select this profile. This way, the
measured colors will correspond as closely as possible to  the printed result. If you don’t
you have a printer or if you have more than one, choose the "Default CMYK" and the
"Default RGB" profile.

Save the made settings by pressing “Apply” and close the dialog.

Procedure
Select the "Fill bucket" from the toolbar and then the icon for "Color management".
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This opens the following dialog.

If you want to store the new colors in a separate table, you first have to press the button “New” (2) in the group
“Table” and make a new table. If you have already done so, or want to add the measured colors to an existing table,
press the button “Measure” (1) in the group “Color”.

Fill in the name of the color and click with the densitometer on the color you want to measure. The color appears in
the color preview (2) and the values of the colors in the edit boxes.

If this icon shows up, the measured color falls outside of the gamut (range of printable colors) of your printer, based
on the chosen profile in the ”Settings”.  You can visually adjust the color so that it matches the measured color as
close as possible.

Press the button “Add” to add the measured color to the active color table. Close the dialog when you have completed
the measuring of colors. Don’t forget to press the “OK” button to store the changes. 

Gradient fill
G r a d i e n t  f i l l

With a gradient fill you can let two or more colors gradually change into the next color. With this function you can add
more color and depth to your work. There are different types of gradient fills available.
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Linear
The fill is in one straight line over the object:

Radial
The fill consists of concentric circles:

Square
The fill consists of concentric squares:

Conical
The fill consists of rays from the center of the object:

Each of these gradient fills is subdivided into two types.

Two colors
This fill has only two colors that change into each other:

Custom
This fill can have more than two colors. You can use for example a fill from red to orange, to yellow, to green etc:

You can personalize gradient fills further by changing the “Edge fill”, the “Angle”, and you can add and change colors
etc. You can do this in the dialog or directly on screen.  

How do I apply a gradient fill?
There are two ways to do this.

Gradient fill dialog
Select an object and click on the gradient fill button in the submenu of “Fills” in the toolbox:

Make your settings in this dialog and click “OK”.
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Direct on screen
Click the symbol for direct gradient fill in the submenu of “Fills” in the toolbox:

The cursor will change as follows:

When you select an object with this tool and simultaneously drag the mouse, you apply a gradient fill to the object:

Gradient fill dialog

Two colors
1 Type
 Here you can choose from the following types of gradient fills:
  Linear
  Radial
  Square
  Conical.

2 Center
 When a type of fill supports this, you can adjust the center of the fill with this control. In the image below, in

the left column, the center is set to 0% horizontal and 0% vertical; in the right column the horizontal and



167EasySIGN

vertical values are set to 25%:

 

3 Options

 Angle
 Here you can adjust the angle of the gradient fill.

 Steps
 Here you can set the number of steps that are used to build the gradient fill. If you unlock the button behind

this field, you can set the number of steps for the current active gradient fill. If you lock the button, the number
of steps displayed are the ones you can set globally under the menu “File”, “Settings”, “General”, “Gradient fill
steps”.

 Edge fill
 This setting controls the distance over which the begin and end color stays an even fill and at which point the

actual gradient fill starts.

 Special effects
 If this option is active, you can make a special effect of a regular gradient fill. A normal square gradient fill

looks as follows:  

 

 The same gradient fill, but with the “Special effects” option active and an angle of 6 degrees, looks as follows: 

 

4 Gradient fill
 Here you can choose between “Two colors” or “Custom”.  

5 From/To
 Here you can choose the start and end color of the fill. When you choose one of the buttons the following menu

will appear:
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 By selecting one of the color squares you assign the selected color as the new begin or end color: 
 

 

 When you select the black square with the capital “C”, you open a color dialog in which you can create a
custom color.

6 Center
 Here you can set the center of the fill:
 

 

7 Rainbow
 By selecting one of these buttons you can set the direction of the begin and end color. In the example below,

the left image represents the “shortest” way in a color space from one color to another and the right image is
the “longest” way: 

 

 

8 Preferences
 This list provides a set of predefined gradient fills. You can add your own by typing a name and pressing the

button with the “+”. You delete a setting by selecting it and pressing the button with the “-”. 
Custom
When you select “Custom” the dialog changes:
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1 Position
 Here you can find the position of the selected color within the gradient fill.  

2 Current
 Here you can see the currently selected color.  

A The start color.
B One of the possible color positions in the gradient fill.
C The end color.

By double clicking on the white space between point “A” and “B”, or by adding a value in (1), you can add a new color
position. When you want to add a position numerically (1), you have to make sure that no existing position is selected
or you would just move this position instead of adding one. You can deselect a position by clicking once somewhere
on the white space between points “A” and “B”.

 

The newly added position has the exact color of the position in the gradient below. When you drag the slider to a
different location, this color doesn’t change, only the position. You can change a position by selecting this position and
dragging, or by selecting the position and changing the value in the position field (1):

 

A position is selected when the triangle is black. When a position is selected you can delete it by pressing the “Delete
key” on your keyboard.

To change the start and end color, first select point “A” or “B” and then adjust the value in the color menu (2). To
change the color of one of the positions, first select this position and then adjust the value in the color menu (2).

Adjust a gradient fill directly on screen
Select an object with a gradient fill and then the symbol for direct gradient fill in the submenu of “Fills” in the toolbox:

The control handles for the gradient fill become visible:
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If you drag one of the outer handles, you can change the angle and positions of the gradient fill. These handles are
magnetic and can snap on a guideline or node:

The slider in the middle is for changing the center of the gradient fill:

When a position is selected you can change its properties. 

Not selected : 

Selected : 

1 Location
 You can also change the location of the outer position numerically by selecting using the context menu with the

command “Move”: 
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2 Color
 You can change the color of a position by selecting that position and then selecting a color from the color bar,

or by selecting “Properties” from the context menu. If you select “Properties”, the color dialog in which you can
create a custom color will appear.

3 Delete
 Any position, except the start and end position, can be deleted by using the context menu or the “Delete” key

from the keyboard. 

4 Add positions
You can add a position by placing the mouse over the dotted line between the start and end position, and selecting
“Insert” from the context menu, or by double-clicking the dotted line. If you are over the dotted line the mouse cursor
will change its appearance:

By double-clicking you add a position:

By selecting a color from the color bar you can change the color of the current position:
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Changing the type of the gradient fill
Open the gradient fill dialog by clicking on the gradient fill button in the submenu of “Fills” in the toolbox:

In this dialog you now can change the “Type” of the fill:

Radial

Just as with any other gradient fill type, you can add positions and edit their location and color:
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Square

Conical

Working with gradient fills
With the control handles of a gradient fill you can do almost all the things directly on screen that you can do with the
dialog:
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Switching between the different gradient fill types is only possible via the dialog:

Almost anything you can do in the dialog, you can do directly on screen:

Making gradient fills ready for cutting

You can make a gradient fill ready for cutting by selecting the object and choosing the command “Convert to”, “Ready
for cutting” via the context menu:

When working in color mode you cannot see any difference. Only when you switch to wire frame, can you see what
has happened. Each step in the gradient fill is converted to a vector object, so it is ready for cutting. This operation is
useful only when the gradient fill has a small number of steps. Too many steps would cost too much on different vinyl
colors and aren’t practical:
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Pattern fills

Pattern fills are bitmap files that can be tiled seamlessly to form an uninterrupted, integral whole. EasySIGN ships with
several hundreds of example files. More than 3400 of these fills in 27 different categories, such as "Wood", "Metal",
"Marble", "Stone" etc., can be obtained from our website: http://www.easysign.com.

You will find the pattern fills in the subdirectory "Shared\TEXTURES\" of EasySIGN. 

How to apply a pattern fill

Pattern fills, like all other fills, can be applied by means of the "Fill bucket" from the toolbar. First select a vector
object to which you want to assign a pattern fill, then select the icon below from the toolbar.

This opens the dialog where you can select the pattern fill.



176 EasySIGN

1 Pattern preview

By pressing the button "Pattern", you open a dialog where you can select the desired pattern fill.
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This is the standard "Open dialog" as you have seen before, but with several additions.

1)
Here you can determine the way files are presented to you. Select "Thumbnails" to see previews of the images.

2)
By pressing the "+" button, you can add the current subdirectory to the "Favorite list".
When you select a subdirectory from this list, the dialog automatically goes to the selected location. 

2 Offset origin

A pattern fills "starts"  at the bottom left corner of the selected objects. Here you can adjust that origin.

3 Size

Here you can adjust the size of the pattern fill.

4 Transformations

Here you can adjust the skew and rotation of the pattern fill.

Transform tile with object
This option determines whether the pattern fill copies the transformations of the object.

Orig ina l
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Obje ct tra nsfo rm e d a nd  th is  option d isa b le d

Obje ct tra nsfo rm e d a nd  th is  option e na b le d

Pattern fill manipulation with the mouse

Select an object with a pattern fill.

Next, select the tool to adjust pattern fills (the same as the one to adjust fountain fills).

You now can adjust the rotation, placement (origin), scaling and skewing with the mouse.

The adjustments made with the mouse are being copied to the dialog of the pattern fill. If you want to fine tune the
transformations, select the object with the pattern fill and then the icon below from the toolbar.

Some examples of pattern fills
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Crop marks

In EasySIGN there is the possibility to automatically place crop marks around a page or a selection. You can also
enter crop marks directly at any required location. Crop marks are always placed on a special layer that is adjustable
according to visibility, locking and whether the crop marks are going to be printed or plotted or not at all. Because
crop marks are rather a different type of object in EasySIGN, they behave differently. If e.g. you place crop marks
around an object that you want to plot with separated colors, you do not need to place a new crop mark for each
color. A crop mark is always plotted or printed with every color, irrespective of the number of colors in a worksheet.

If you want to place a crop mark in a specific location, you must select the following tools from the toolbar.
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The cursor changes as follows:

In each location on the worksheet you click on with the cursor, a crop mark will appear.

When you click with the right button mouse on a crop mark a menu with the following choices will appear.

Delete : Deletes the crop mark that is under the mouse.

Delete all : Deletes all crop marks in the current worksheet.

Hide all : Hides all crop marks in the current worksheet. You can make the crop marks visible
again by using the layers dialog.

Properties : Opens a dialog in which you can make the following settings.

1 Modify the shape of the crop mark.
2 Modify the size of the crop mark
3 If this option has been ticked the settings in the dialog will be applied to all crop marks in the worksheet.

The next dialog can be opened using the menu "Insert, production, Insert crop mark".
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The shape and the size that you set in this dialog will also become the default when placing new crop marks on the
worksheet.

1 Here you can select the shape.
2 Here you can enter the size of the crop mark.
3 When you check the option "Around page or selection" the options in the group box below it become active. In

the actual group box you can indicate whether you want the crop marks around the page or around a selection.
4 In "Margins" you can set what the distance must be from the crop marks to the selection or page.
5 When you activate this option, the values you enter in the first field will automatically be applied to the margins

in the other three fields.

Crop marks around the page
When you use this option, the crop marks will not only be placed around a page but the size of the page will also be
modified so the crop marks can be printed as well. This means there will be four guidelines added to the worksheet
which indicate the original size of the worksheet. This way you will never forget to include the crop marks when
printing the page, as the crop marks will be included in the size of the page. 

Editing crop marks
Working with crop marks is basically the same as in previous versions, however some major new features have been
added. In version 3 and later, the crop marks can be selected with other objects and relocated. They can also be
converted to curves and their color can be adjusted.

Custom crop marks
Crop marks have the property “Registration color”.  This means that objects with this property are printed or plotted
with every color separation. The property “Registration color” can be assigned to every vector object which is then
also printed or plotted with every color separation. If you cancel the property “Registration color” for a crop mark, the
crop mark will no longer be plotted or printed with every color separation.

Pagination

When part of the worksheet is too high to output, in other words if the output format of the plotter is not large enough,
the "Pagination" function can be used.

Let us assume that the illustration above is too large for your plotter. In this case you select the objects you want to
divide and temporarily make a duplicate of where the division is going to be carried out. Dividing actually splits the
objects in two and the objects loose their properties. When you plan to split a text for example you will not be able to
edit it afterwards as text. In order to prevent this, it is better to carry out the operation on a copy of the original
design.

From the "Edit" menu select the command "Pagination"; the cursor will change as follows.

Move the cursor to the point where you want to divide the work, click once and drag the cursor over the part you
want to divide. You can divide under any angle, but if you use the control key the angles are limited to 15 degrees.
When you let go of the mouse after dragging, the following window will appear.
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1 Overlap:
 In this field you can enter the size of the overlap.
2 Close shapes:
 When you activate this option the shapes are closed after splitting. If you split to a plotter before output this

option must be activated, as you would otherwise cut open shapes.
3 Group objects:
 When you split one object e.g. this option ensures that the result is immediately grouped. It is better not to use

this option for several objects because when grouping, the stacking sequence can change which may lead to
undesired results.

4 The "OK" button applies the settings and the "Cancel” button closes the dialog without carrying out the division.

When you click on "OK" it may seem at first as if nothing has changed. If you look in wireframe graphics or if you
slide the object apart, you will be able to see the result.

Cut through

Perhaps not a specific sign function but certainly a derivative of pagination. This function allows you to quickly clip an
object or cut it in half. From the menu "Edit" select the command "Cut through". The cursor changes as follows:

This cursor can draw a line just as when paginating. However this function goes exactly to where you want to clip, if
you want to cut the whole object, you must put the line over the whole object.

After letting go of the mouse the following dialog will appear:
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In this dialog you can set "Overlap" (1), and when you click on "OK" after setting, it may seem at first as if nothing
has changed. You can however give one half a different color to make the difference visible.

Welding

This is certainly one of the most frequently used functions to make production drawings of a successful design. By
using this functionality you can make the most complicated production drawings on screen before cutting them.

Melting
Melting turns two objects into one. Select the objects you want to blend and then from the menu "Edit, Welding"
choose the command "Melt objects".

Stamping
The command "Stamp objects" deletes the shape of an object from the underlying object. 



184 EasySIGN

Stamping open shapes
The command "Stamp open" works the same way with the only difference that the result of the operation is an "open"
shape.

Stamp last selected
Normally stamping operates in stacking sequence, the object lying op top punches out the objects lying underneath.
In this option it makes no difference where the object is located in the stacking sequence. The object that has been
selected last punches out the other selected objects and is subsequently deleted.

Mask last selected
This option uses the last selected object as a sort of mask and punches out all objects around it.

Union
The command "Union" only leaves the overlapping shapes. When several objects have been selected that do not all
overlap, this command will not generate a result.

In the following illustration all shapes do not overlap. The shape on top only overlaps the one in the middle. This
function will not generate a result in this situation.
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In the illustration below all shapes overlap and the function will give a result.

Add nodes
The command "Add nodes" adds an extra node in each location where the lines of the selected object intersect.

Photo plotting

This function enables a color or gray scale bitmap to be plotted. This happens by making strips that become thicker as
the photo becomes darker. The line distance and the number of lines are adjustable. It is advisable not to take less
than 2 mm for cutting because otherwise the lines will be too close together and weeding from the foil will become a
difficult job. 
If you want to photo plot select the bitmap you want to use. If you then click on the selected bitmap with the right
mouse button, a PopUp menu will appear with two relevant options for photo plotting.

A Show as photo plot
 When you choose this option the selected bitmap is displayed as a photo plot with the currently applicable

settings.
B Photo plot options
 This option opens a dialog in which you can modify the settings for the photo plot.
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1 Stroke width
 Here you can set the width of the strips the photo is to be divided into.
2 Number of strokes
 Here you can set the number of stokes the photo is to be divided into.
3 Cutting direction
 Here you can specify whether you want the strokes to run horizontally or vertically.
4 Invert brightness
 This option inverts the brightness of the photo. This can be used if you want to apply white vinyl on a black

background.
5 Stroke width limits
 This option enables you to specify the minimum and maximum thickness of the strips. 
6 With the "OK" button you can apply the settings and close the dialog, with the "Cancel" button you can close the

dialog without applying the settings.

The settings you have made in this dialog will be applied to the next bitmap that you want to plot as a photo plot.

Text

Text
T e x t

Text is probably the most elementary component of any design. For this reason EasySIGN has very advanced text
tools. These tools support text on path, on circle, tabs, all formatting properties etc. The text tool is very easy to use
and everything can be edited and inserted directly on screen.

Inserting text
I n s e r t i n g  t e x t

From the tool bar select the symbol for the text editor.

The following dialog will appear and the cursor will change into a text caret.
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Use the text caret to click on the worksheet and begin to type. If you want to insert text from outside EasySIGN all
you need to do is select the text in the original text editor (or one of the text editors from Windows™) and then select
the command "Copy". In EasySIGN make sure the text caret is on the worksheet and then use the keyboard shortcut
"CTRL+V" to paste the copied text. In this way you are compatible with almost all word processing software used
under Windows™.
If you want to select part of the text, place the text caret at the end or beginning of the required selection and drag
the cursor until the required text has been selected. Any commands you select from the dialog will be applied to the
selected text.

Parts of the dialog
1 Font selection
 Here you can select the required font. An example of each font is displayed when selected.
2 You can use these buttons to change the selected text to respectively bold or Italics (if the selected font

supports this format). You must never forget that there are complete font families that only support capitals
and that all systems have fonts that only support normal weight.

 

3 You can use the first button to put a character in superscript (reduces the font directly above the last character)
or subscript (reduces the last font below and to the right of the last character). 

 

4 With the first button you can change the selected characters into capitals and with the second button you can
apply small capitals. Small capital means that each capital letter remains a capital and that lower case letters
become a capital letter at a size of 70% of the original capital.

 

5 With these buttons you can align the text to the left, right or center.

 

6 These buttons help you to put text on a circle and will be discussed further on in this chapter.

7 In this field you can enter the size of the selected text. The line spacing (8) will be adjusted automatically with
any modifications to this field.
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8 In this field you can modify the line spacing.

 

9 Word spacing. This is calculated in percentages, 100 per cent word spacing is standard. In the example below,
the word spacing has been doubled. This modification has only been applied to the selected parts and not to the
whole paragraph.

 

10 In this field you can determine the extra spacing for the selected characters and the spacing between words.
Zero per cent is standard. All incremental value will result in a wider spacing between fonts (more space
between the text).

 

11 In this field you can determine the width of the characters in the text. Here you can make your text wider or
narrower by simply adjusting the values. The standard value is 100 per cent.

 

12 Set as default
 All current settings in the text editor are saved as the default settings.

13 Apply default
 The default settings are applied to all the controls in the text editor.

14 Rotate text
 Each selected character is rotated:

15 Skew text
 Each selected character is skewed:

Rotating and skewing are done with the origin point of the character as the origin for the rotation or skewing.
 

Edit text.
If you want to edit text again you can select the text tool from the taskbar and place the text caret in the text you
want to edit. You can also select the text you want to edit and choose the command "Edit text" from the right mouse
button menu. Both methods do the same thing but have a different approach.
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Giving a text a color or outline
In order to give a complete block of text a color or outline the text block must first be selected with the selection tool.
Next click on a color from the color bar or open the color dialog to compose a color.

If you want to give one or several characters in a text a color or outline, then select the required letters with the text
tool. Next click on a color from the color bar or open the color dialog to compose a color.

Paragraphs and tabs
P a r a g r a p h s  a n d  t a b s

EasySIGN not only supports the use of tabs in plain text but also in text on path. This is very convenient if e.g. you
want a fast way to put together interesting price lists. Of course you cannot use text on path for paragraphs, as these
consist of several lines. If you want to put a paragraph on a path, it will be transformed into one line.

Formatting a paragraph
As EasySIGN does not support the automatic return of lines in the current version, you will have to make the
hyphenation in paragraphs yourself. This is the only limitation in paragraphs, all other features of paragraph
formatting are supported by EasySIGN, such as indenting and properties. The following is an example of a paragraph
format.

Type a text starting with a tab and then a dash, then one more tab and then a couple of lines of text.

In the ruler you will see a so-called "Tab bar" and the paragraph is not yet a true paragraph. In order to edit it, you
will need to know what the parts of the tab bar stand for.
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A Indentation of first line.

 

 When you move the slider to the right, the first line (in this case including the tabs) will be aligned towards it.

B Indentation of paragraph.

 

 When you modify this by sliding the slider to the right, all lines except the first will be aligned to it. The first line
is dependent on the slider near "A". You can also enter these settings throughout the properties dialog of the
tab bar.

C Markers that specify the standard tab distance. This property can only be modified by using the properties
dialog of the tab bar.

If you want to place a tab in the tab bar, all you need to do is click in the bar with the mouse and a tab is added at
that location.
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The character that is located behind the first tab will be aligned to it. If you want to change the properties (type of
alignment) of the tab you must click with the right mouse button on the tab. From the PopUp menu that then appears
you can choose between "Left", "Right", "Decimal" or "Center". You can also enter these properties by using a dialog
and choosing "Properties" from the PopUp menu. If e.g. you choose "Right", it will appear as follows. 

In order to make the paragraph look like a paragraph you must specify a position for the second tab; this must be a
left tab alignment because the width of the text is too large for a right tab alignment.

To complete the picture all you still need to do is put the bottom slider (for the paragraph) in the same location as the
second tab.
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Tabs can be removed by choosing the command "Delete" from the PopUp menu or by dragging the tab outside the
tab bar.

Please note that settings for tabs and alignments can be adjusted per line.

Examples of tab alignments
There are four different tab alignments, each with their own specific use. In the examples below all four have been
used in the same example to show the differences more clearly.

Left tab alignment
These are only used at the beginning of an indented paragraph in order to align the first sentence with the rest of the
paragraph. They are not suitable for a price list as you can see from the example below.

Right tab alignment
These are not used very often. These tabs can be used in a price list, where everything behind the decimal dot has
the same character or the same number of characters. Right tab alignment is only used for special formats or to align
the dash (usually for incremental numbers) in an indented paragraph to the right instead of to the left.

Decimal tabs
Probably one of the most used tabs. An especially indispensable tool for price lists. You can specify the decimal
character in "Regional Settings" of Windows™. In Europe this will mostly be a comma, and in the US this is always a
point.
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Center tabs
Once again a tab that is only used in special circumstances. This is probably one of the least used tabs.

Limitations of tabs
A tab only works when a paragraph has a left alignment. A tab in a right aligned or centered text is ignored. 

The properties dialog of the tab bar
In this dialog you can set up the properties of tabs and paragraphs. You can open this dialog by clicking on the tab
ruler with the right mouse button. 

1 Tab position
 When you have chosen a position from the list (2) of existing tabs, you can change this number and by using

the button "Move" (8) you can move the tab to a new position.  
2 In this list the existing tabs are displayed in the tab bar.
3 Alignment
 You can select the tab alignment from the list below.
4 Here you can specify the distance for the standard tabs.
5 Here you can specify the amount of indentation of the first line.
6 Here you can specify the amount of indentation of the paragraph.
7 Add
 When you have entered a number in "Tab position" (1) you can use this button to add the tab to the list.
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8 Move
 This enables you to move an existing tab.
9 Clear
 This enables you to delete a selected tab from the list.

10 Clear all
 This command deletes all tabs from the list.

11 OK
 Applies all modifications to the tab bar and closes the dialog.

12 Cancel
 Ignores all modifications and closes the dialog.

Placing text on a circular path
P l a c i n g  t e x t  o n  a  c i r c u l a r  p a t h

Placing text on a circular path can be done on screen and checked directly. In order to place text on a circular path
you must first draw a circle; this must be a circle object. If you first transform the circle into a curve, you do not place
the text on a circle, but on a path. So it is not the shape that matters here (it could also be an ellipse) but the
property of the object (it must be a circle object). Select the text you want to place on a circular path and click on
your right mouse button once. From the PopUp menu select the command "Place text on path".

 
When you have selected the command "Place text on path" click on the circle with the mouse. The text will then place
itself on the circle. 

The circle has now become "invisible" and as long as the object is a "text on a circle" will stay there together with the
text. If you now want to change the radius of the object you can choose the drag tools from the toolbar and use these
to select the object, to make the circle visible again use the drag tools to select the text.
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You can use the drag tools to edit the text on the path and to drag the text over the path.

By dragging the existing nodes you can change the radius and the shape of the circle without influencing the size of
the text.

By using the control key together with the right mouse button to drag, you can enlarge or reduce the radius of the
circle.

By just dragging the anchor point at the bottom of the circle you can turn it into a horizontal ellipse. By using the
control key together with the left or right node to drag, you can enlarge or reduce the radius of the ellipse without
changing the shape of the ellipse. By pressing the shift key once while dragging, you can return the ellipse shape to a
circle.

By dragging only the right node of the circle, you can change it into a vertical ellipse. By using the control key and the
left or right anchor point to drag, you can enlarge or reduce the radius of the ellipse without changing the shape of the
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ellipse.

By dragging the uppermost anchor point you can change the circle into a pie. Here you can also change the shape by
using the control key together with the left or right anchor point to drag, enlarging or reducing the radius of the shape
without changing the shape itself. 

If you want to close the pie shape again you must use the control key to place the point that has been opened exactly
on top of the other "open" point. 

If you use the drag tools to get hold of the control point of the first letter you can drag this point over the path.

If you take hold of a different letter to drag, the positioning will be calculated again depending on the setting in the
text dialog. If, as in the above example, you have the positioning on center/top,

the text will be adjusted to this. 
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In the above example this has been done to the extreme. The use of this behavior is that once you have chosen for a
certain positioning, possible modifications such as kerning do not cause the positioning to be lost. If the positioning is
not of interest to you, or if you want to do everything manually, you can activate the option "left alignment", "right
alignment" or "center". When you have selected one of these alignments, the text will stay in the same location after
any modifications. 

You cannot drag a text past its initial position when it is placed on a path or circle. If the text is placed on a circle, e.g.
as in the above illustration, you can only move the text to the top center by dragging it once around the circle.

Text on a path
T e x t  o n  a  p a t h  

In many ways text on a path works the same as text on a circle. The text alignment buttons "Left", "Center", "Right"
or "Below" are not available here.  First draw a path and next select the text you want to place on a path with your
right mouse button. From the PopUp menu select the command "Place text on path". 
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Next select the path

The text will now be on the path. With text on path you can also drag the whole text block or parts of it over the path.

If you use the shift key when dragging, you can lift the characters from the path just like with the text on a circle. This
option is also available for a normal line of text.

Editing the path
Even when the text is on the path this path can still be edited, as with all other paths in EasySIGN. All modifications to
the path will result in the text adjusting to the "new" path.
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General edit functions for text on path and circle
G e n e r a l  e d i t  f u n c t i o n s  f o r  t e x t  o n  p a t h  a n d  c i r c l e

Reversing the path direction
Use the right mouse button to click on the selected text on a circle or path.

From the PopUp menu select the command "Reverse path direction".
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The same is also possible with text on path.

In the above example the paths of the text have just been drawn in to make it clear, normally they would only be
visible when you use the drag tools.

Rotate characters with path.
Use the right mouse button to click on the selected text on circle or text on path.

Select from the PopUp menu the command "Rotate characters with path".
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The letters will keep the vertical orientation. This option works the same way with text on path.

Once again for the sake of clarity the internal path has been drawn next to the text.

Placing text on a path
Normally text is placed on a path aligned to its baseline. You can modify this type of alignment. In order to do this
select the object with your right mouse button and then select the option "Align bottom", "Align center" or "Align top".

The same options are also available for text on path.

The option "Align top" may not seem to be correct at first sight, but it is. This is because "Align top" always takes into
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account how to fit in special characters such as e.g. a capital letter "E" with a circumflex on top. 

Remove kerning
When you have a text on path, text on circle or a text of which the characters have been taken off the baseline using
the shift key, you can use this command to bring the text back to its original shape. All kerning, either horizontal or
vertical, will be removed

Remove text from path
This option changes a text on path back into ordinary text. The path will also reappear as a separate object.

Draggable line distance and kerning
D r a g g a b l e  l i n e  d i s t a n c e  a n d  k e r n i n g

Drag kerning
Situation at start:

To adjust the kerning first select the text with the drag tool. Two control points appear:

The control point on the right is used for adjusting the kerning of the text:
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Drag this control point to change the kerning of the characters and white spaces; when you hold down the shift key
while dragging, you adjust only the space between words:

Increase the kerning by dragging the control point to the right and decrease the kerning by dragging the control point
to the left. You can even adjust the kerning if the text is rotated or in any other way distorted:
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Drag line distance
To increase the line distance drag the control point on the left downwards; to decrease the line distance drag it
upwards:

Draggable line distance and kerning on path and arc
D r a g g a b l e  l i n e  d i s t a n c e  a n d  k e r n i n g  o n  p a t h  a n d  a r c

The same possibilities as with a normal text are there when a text is placed on a path or arc; however the line
distance here is used to adjust the distance to the path or arc.

Drag kerning
Without the shift key:
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With the shift key:

Drag line distance

After you have adjusted the line distance of the text, you can set this back to normal by choosing from the right
mouse button menu either “Align bottom”, “Align center” or “Align top”.

Select and edit characters
S e l e c t  a n d  e d i t  c h a r a c t e r s

You can simultaneously change the color of different characters anywhere in a text by using the drag tool. Suppose
you would like to change the color of all the numbers in the text below to red. You can do this using the following
technique:
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With the drag tool you can select each character by clicking on its origin point or by dragging a selection rectangle
over the characters. You can now assign a color to the selected character:

In previous versions, when you moved one character, all the following characters were moved as well. It wasn’t
possible to move one character at a time or more characters in different locations in a text. This is now possible. The
previous method is still supported by selecting the origin of the character you want to drag and starting to drag
immediately, without releasing the mouse button. The rest of the text line is then dragged simultaneously. If you
select a character, then let go of the mouse button before selecting it again, you will move only the selected
character. If you select multiple characters, all the selected characters move.

Click a nd  dra g  one  cha ra cte r
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Multip le  se le cte d  cha ra cte rs

Click, click a nd  dra g  one  cha ra cte r

Exceptions
When you drag characters in a text containing tabs you obtain different results:

In the situations above, the characters after the selected character would also be moved when dragging the control
point:

However, the text above contains tabs and the next character is only moved when the next tab position is reached.
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The next character is moved to the next tab location.

Text settings
T e x t  s e t t i n g s

Default settings for the sizes of superscript, subscript etc. can be found at “View”, “Settings”, tab: “Text”:

1 Text units always in points
Whatever the global setting for units is, the text will always be measured in points.

2 Connect line distance to font size
When you adjust the font size of the characters in the text editor the line distance is adjusted automatically.

3 Default tab distance
Automatically places tabs with a given interval. If you enter a tab in a text without setting its location, this
setting is used.

4 Size of small capitals
The difference between original font height and the size of small capitals as a percentage.

5 Position of subscript
The position measured from the baseline of the text as a percentage.

6 Size of subscript
The size as a percentage of the original font height.

7 Position of superscript
The position measured from the baseline of the text as a percentage.

8 Size of superscript
The size of a superscript character as a percentage of the original font height.

9 Restore defaults
Restores the defaults as set during the first installation of the software.
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The settings 4 to 8 apply to all newly entered text. Text already entered in existing worksheets remains as is.

Text orientation
T e x t  o r i e n t a t i o n

With the menu “Text”, “Text orientation”, “Vertical”, any selected text is displayed from top to bottom instead of from
left to right:

With vertical text any “next line” will be placed to the left of the current line:

Spacing and line distance can be set with the text editor or the drag tool:

Text import
T e x t  i m p o r t

Via the menu “File”, “Import” you can now import files with the “.txt” extension. This import for artistic text is limited
to 1000 characters per import. Even if you import a text file containing more than 1000 characters, only 1000
characters are imported.
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Adjustable kerning
A d j u s t a b l e  k e r n i n g

Kerning is the distance between two characters. You can adjust this distance by dragging the origin point with the drag
tool.

This kerning is active only for the adjusted character in the active text block. You also have the possibility to save this
kerning in a font. After saving, this kerning will be applied to every newly entered text made with this font type. You
actually saved a kerning pair: the distance between two characters.

How?

Type a text with the kerning pairs you want to adjust and select the text with the selection tool.

Then select the command “Text, Kerning, Edit Kerning” in the menu. The Object Manager becomes visible (if not
already open) and the cursor changes into the drag cursor.

Drag the origin point of a character to a different location.

In the Object Manager you will see the name of the font, the kerning pair and its adjusted value.
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When you press “Apply” the adjustment is saved to the kerning table.

With each new text the adjusted kerning pair will be used instead of the one embedded in the original font. The
original font remains intact.

 
Apply
This saves any adjustments made.

 
Remove
Removes a kerning pair from the kerning table.

 
Remove all
C lears the entire kerning table.

 
Apply kerning to selected text blocks.

 
Apply kerning to all text in the current worksheet.
Also text within groups and effects are included.

When you open worksheets that already contain text blocks the adjusted kerning pairs are not automatically applied.
When you want to apply adjusted kerning pairs to existing text blocks you will have to do this manually by selecting
the command “Text, Kerning, Reset all kerning”. All the new text you enter will have the new kerning pairs
automatically applied to it.

Split text
S p l i t  t e x t

You can split a text into the following parts.

Lines
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Words

Characters

To do one of the above, select “Text, Split text, …”.

Join text
J o i n  t e x t

You can join selected characters, words or lines into one text block. All selected text objects will be placed after each
other. The last selected text object is the placeholder and becomes the first text part in the new text block. The order
of the rest of the selected text objects will be conform the order in the worksheet. 

In the example below the black letter “A” is the last selected object.

To join text select “Text, Join text”.

Spelling checker
S p e l l i n g  c h e c k e r

Options spelling checker

If this is the first time you use the spelling checker you have to make some settings. Select “Text, Spelling, Options
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Spelling checker”.

1 Options spelling checker
Her you can set exceptions, for example, ignore capitalized words.

2 Main dictionary language 
Her you can select the language you want the spelling checker to use.

3 Suggestions
Here you can set the balance between speed and accurate.

Lexicons

Lexicons can be made for a specific language or for use with all languages. Here you can make your own lexicon of
frequently misspelled words or add words that aren’t in the supplied lexicons. Select “Text, Spelling, Adept lexicons”’
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In the field “Words” (1) you can add a word on which you let the spelling checker take a specific action. In the field
Other word” (2) you can enter the desired result. With “Action” (3) you can select the action that has to be done when
the spelling checker encounters this word. For example you can choose that the word has to be replaced, you can
also set that the word has to be ignored. With “Files” (4) you can select the lexicon you want to add the word to.

Spell checking

If you have selected some text the check will only be applied to the selected text, otherwise the spelling checker will
search the whole document.

Select “Text, Spelling, Check spelling” or press the shortcut key “F7”.

In the dialog and in the worksheet the spell errors will be selected.
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1 Here you can see the spell errors the spelling checker encounters.
2 Here the suggestion is shown. You can changes the suggestion by typing another suggestion or select one from

the list below.
3 A list with other suggestions.
4 Ignore, this ignores the suggestion and moves on to the next spell error. If you want all similar words to be

ignored press the button next to this one.
5 Change, this button changes the spell error in to the suggestion. If you want all similar words to be changed

press the button next to this one.
6 If you want to add an encountered spell error to the lexicon (it isn’t a spell error but it isn’t in the current

lexicon) you can press this button.
7 If you have added your own suggestion in the field “Change to” (2) you can ask the program by pressing this

button to suggest other words that resemble your suggestion.
8 The current lexicon.
9 Here you can open the Option dialog, The Lexicon dialog or close this dialog and end the spell checking.

Text statistics
T e x t  s t a t i s t i c s

Through the menu “Text, Text statistics” you will get a dialog that shows you the number of words, lines characters
etc. in a worksheet.
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In this dialog you get the number of:

text objects;
words;
tokens (including spaces);
tokens (excluding spaces);
lines.

Insert symbols
I n s e r t  s y m b o l s

To insert symbols and special characters you need to place the caret in a text block and select from the context menu
the option “Insert, Symbol”.

In the dialog you can select a font and the character or symbol you need. Select the button “OK” to insert the symbol
or select the button “Insert” if you want to add more then one symbol.

Text Merge
T e x t  M e r g e

The function Text Merge is an advanced way to automate tedious jobs like creating hundreds of name tags. When you
have a job to create several nametags, container labels, stickers, engraving plates etc. you will normally get a list or
database file to use as a source from your customer. Normally this source would be a .CSV file (semicolon, tab or
comma delimited text), typically a .CSV file would look like this:

surname;name;occupation
Smith;Ethan;Art Director
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Johnson;Emily;Account Executive
Williams;Noah;Marketing manager
Brown;Emma;Sales manager
Jones;Joshua;Graphic designer
García;Madison;Graphic designer
Davis;Liam;Graphic designer
Martínez;Sarah;Graphic designer

The first row would contain the "field" names where as the rest of the file contains the values for that field names. You
could say that a .CSV is a simplified database table. If you would display the sample .CSV file above as a database
table it would look like this:

surname name occupation

Smith Ethan Art Director

Johnson Emily Account Executive

Williams Noah Marketing manager

Brown Emma Sales manager

Jones Joshua Graphic designer

García Madison Graphic designer

Davis Liam Graphic designer

Martínez Sarah Graphic designer

The Text Merge function doesn't stop at text alone, it is possible to use any design containing text, artwork and even
images to create hundreds of different results within minutes. Say for example we have to make some name badges
containing the names of the people from the .CSV example above together with their photo's. This would normally be
a tedious job, especially when there are hundreds of name badges to make instead of the only eight in the sample .
CSV file. 

For implementing the photo's of the people on the name badges we would not only need (of course) their photo's but
we also have to edit the .CSV file to make the software aware of the photo's and where to find these photo's. Their
will also be times you don't receive a .CSV file from you customer and have to create a .CSV file from scratch. For
these reasons we have created a separate software in the "Helpers" range to make these kind of jobs easier.

To find out the best possible way for this workflow and to learn the Text Merge functions we refer to the help file of
the "esHelperCSV" software. The help file of this "Helper" software contains all the information you need to edit and
create .CSV files and how to use them in the EasySIGN Text Merge function.

To get started do the following. In EasySIGN select the menu "File > Run Helpers > esHelperCSV", this will start the
"esHelperCSV" software. 

In the "esHelperCSV" software select the menu "Help > Help" to start the help file and follow the instruction in this
help file to learn about .CSV files and the usage of the EasySIGN Text Merge function.

Shadow

Shadows are, like most effects in EasySIGN, object oriented. As long as you don’t convert a shadow to curves (e.g.
for detailed adjustments), you can adjust the properties or even remove the entire effect to return to your original
objects. The properties of a shadow effect can be adjusted by means of the “drag tool” or the property dialog. 

Applying a shadow

Select a random vector object, text, bitmap, effect, group or combination of these objects.
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Perspective shadow

Next select from “Effects, Shadow” the desired kind of shadow. In the examples below we use the perspective
shadow. The procedure is the same for other kinds of shadow.

The drag tool becomes active and a preview of the shadow is shown on screen. You can adjust any of the visible
nodes with the drag tool to modify the shape.

By pressing "ESC" or pressing the “select tool” button from the toolbar, the shadow will be recalculated.



219EasySIGN

To change the shape of the perspective shadow, you don’t have to remove the shadow and apply a new one from the
menu. You can  simply request the properties of a shadow via its context menu, and then change the type of shadow.

5 Shadow type
The dialog opens with the current shadow type selected.

A Norm a l ty pe
The shadow continues behind the object.



220 EasySIGN

B Ov e r la p
The shadow partly continues behind the object.
The option "Overlap" (1) becomes active. You should specify a distance first, to make the
overlap visible.

C White  spa ce
Extra white space is added between the original and the shadow. Here, too, you should fill in a
value for “Overlap” (1) , to see the result.

D Ex tra  borde r  o r ig ina l
An extra border is added around the original and the size of the shadow is based on the
original.
Here, too, you should fill in a value for “Overlap” (1) , to see the result.

E Ex tra  borde r  sha dow
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An extra border is added around the shadow result and the size of the shadow is based on the
original.
Here, too, you should fill in a value for “Overlap” (1) , to see the result.

4 Here you can adjust the pen style of the original and the shadow. If you adjust the pen style here,
instead of doing so on the work sheet, the pen style is applied to all originals.

3 If the selected shadow type has a vanishing point, you can adjust this here numerically.

2 Here you can adjust the color of the pen style and the fill style of the objects and the shadow. If
you adjust the color of the pen style and fill style here, instead of doing so on the work sheet, the
styles are applied to all originals.

1 Here you can adjust Depth, Angle and Overlap of the selected shadow.

Block shadow

A

B
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C

D

E

Drop shadow

A
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B

C

D

E

Cast shadow
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A

B

C

D

E
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Special effects

EasySIGN has effects both on bitmaps and on vectors. The most complex vector objects or group of vector objects
can be modeled in almost any shape. These effects can also be placed over each other. You can place one effect over
the other infinitely and in this way create a different effect again. Each effect can be removed from an object so that it
regains its original shape. If you want to apply a permanent effect in order to carry out other processes or
refinements you can select "Edit", "Convert to" from the menu and then the command "Curves". This command
transforms the effect object to curves that can be edited.

Applying an effect
Select or type a text. 

From the menu "Effects" select the command "Special effects". EasySIGN will apply the effect that was used last on
the object and immediately jump into drag tool mode. The object will look as follows:

The parameter sliders will be above the object. With these sliders you can change the shape of the object
interactively. 

Each slider changes a different part of the effect. The number of sliders depends on the number of parameters that
are supported by the current effect. If you want to apply the effect you must select the drag tools or press the tab
key.
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If you want to modify the effect you must select the object and then click on the right mouse button. From the PopUp
menu that appears select the command "Properties".

The following dialog will appear.
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The dialog will display the currently applied effect and the suitable parameters for this (3). In the list on the left (1)
are all the available effects. The dialog also contains an example window (2); this shows you an example of the
settings you are modifying in the dialog. All modifications to a parameter are displayed in a simplified way in this
window. If you would like to see an effect in its final shape you must press the button "Apply" (4). The effect will be
carried out on screen. 
Select a different effect and first click on "Apply" (4) and then on close (5).

In order to show that any other transformation can be a useful part of an effect, the object needs to be scaled
vertically.

Next select the drag tools to display the parameters of this effect.
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This effect only needs one parameter, drag the slider with the drag tools until you have the required result.

You can put another effect over this one by once again selecting "Effects" from the menu and choosing "Special
effects".

Each applied effect can be removed individually by choosing the command "Remove effect" from the right mouse
button menu of the object. You can delete all effects until you are back again at the original object. If you want the
effect to be definite, you must choose "Edit”, "Convert to" from the menu and then the command "Curves".

Dimension lines

Dimension lines in EasySIGN are completely object-oriented. All modifications in dimensions or shapes are
immediately implemented in the labels of the dimension lines. A dimension line can always be selected or grouped
together with an object. All properties of dimension lines can be modified by using a special dialog. 

Applying a dimension line.
First select an object and then choose the option "Dimension lines" from the Toolbar.



229EasySIGN

The cursor will change as follows.

With this cursor select one of the points you want to measure and click on it with the mouse. 

Next move the mouse (still holding the mouse button) towards the next point and click again.

Let go of the mouse button and move the "arrow" to the distance at which you want to place the dimension line.

Once you let go of the mouse button a dimension line will be placed here and the size will be displayed in a so-called
label.
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If you select the dimension line together with the object and then scale it, the display of the label will automatically be
modified according to the new measurements.

Changing dimension lines
It is possible to make modifications directly on the screen by using a special dialog or by using the right mouse button
menu. In order to modify the dimension lines directly on screen you must select the drag tools. You can use the drag
tools to select one of the control points of the dimension line and to modify it.

When you drag a control point near the arrow end you can slant the dimension line by pressing Shift as you drag.
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A slanting dimension line also displays the angle of the line.

By clicking on a selected dimension line with the right mouse button you call up a PopUp menu. In this PopUp menu
you will find a number of direct commands such as the change of unit used in the dimension line and the command
"Properties". The command "Properties" calls up the following dialog.

1 Text height
 Here you can enter the size of the text.
2 Font
3 Text is fixed
 When you activate this option, you can state in "Label text" (4) which text you want displayed instead of the

automatically calculated text.
4 Label text
 Here you can enter your own text for a label.
5 Units follow worksheet
 When you activate this option, the unit will be linked to that of the worksheet.
6 Specific units
 When you activate this option, the label will always display the chosen unit irrespective of the unit used in the

worksheet.
7 Accuracy
 Here you can select how many decimal figures will be used to display the measurements.
8 Here you can enter the shape of the arrow.
9 Place label horizontally
 When you activate this option, the label will always be displayed horizontally irrespective of the angle of the

dimension line.
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10 Show units in label text
 When you activate this option, the label will also display the units used.

11 Apply
 This button applies the settings you have made and displays these immediately on the worksheet.

12 Close
 This button closes the dialog.

Weed borders

Weed borders are used to simplify the removal of excess vinyl when cutting. On screen the weed borders may run
through the text and/or illustration, but when plotting only the excess vinyl will be cut. For text this means that a line
will be cut in between the letters and not through them. The inside outline of the letters are of course not cut.

Adding a weed border
There are two ways in which you can do this. You can do this manually by selecting the option "Weed borders" from
the toolbar.

The cursor will change as follows.

You can now put the weed border around the chosen object in the same way as you would draw a rectangle.

You have now drawn the border but the intersecting lines must still be added. In order to do this you must select the
drag tools. The weed border will look as follows.

You can use the drag tools to drag the weed lines from the thickening on the horizontal and vertical lines.

If you click on the selection tools again you can use the menu of the right hand mouse button to call up the following
dialog by selecting the option "Properties".
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1 Contour margin
 The area between the outside part of the object to be plotted and the weed border.
2 Weed lines margin
 An adjustable safety margin for cutting the objects.

 Horizontal and vertical weed lines
3 None
 No weed lines are drawn.
4 Every
 Weed lines are drawn at an adjustable interval.
5 Individual lines
 Each weed line can be adjusted individually.
6 Here the weed lines that have been selected from the list below, are displayed. Existing weed lines can be

modified and new ones can be typed.
7 Here all weed lines present are displayed.
8 Move
 Moving an existing weed line.
9 Add
 Adding a new weed line.

10 Remove
 Deleting an existing weed line.

You can also use an insertion dialog to add weed borders and weed lines to the selected objects.  In order to do this
select an object and next select from the menu "Insert", "Production" the option "Weed border around selection". The
following dialog will appear.



234 EasySIGN

1 Contour margin
 The area between the outside part of the object to be plotted and the weed frame.
2 Weed lines margin
 An adjustable safety margin for cutting the objects.

 Horizontal
3 None
 No weed lines are drawn.
4 Every
 Weed lines are drawn around an adjustable distance.
5 Between the lines
 When a text has been selected a weed line can be placed between each line automatically.
6 Through the lines
 The weed lines are placed through text lines.
7 Between and through he lines
 Part 5 and 6 are applied simultaneously.

 Vertical
8 None
 No weed lines are drawn.
9 Every
 Weed lines are drawn around an adjustable distance.

10 OK
 Apply all settings made and close dialog.

11 Cancel
 Closes the dialog without applying the settings made.

12 Default
 Restores all settings in the dialog to the standard settings.

Modifications to the weed border
By using the drag tools you can carry out a number of direct modifications to the weed border.

If you drag one of the outside nodes, you can modify the margin of the outline.
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By dragging one of the inside nodes you can determine the position and scaling in relation to the object.

You can use the drag tools to change weed lines that have already been placed. You can also delete the weed lines by
dragging them back to the thickenings on the horizontal and vertical lines of a weed border.

Blocknesting

Blocknesting is fast and easy to apply effect that rearranges objects as efficiently as possible to save material.
Blocknesting is object oriented, even after applying the effect you can always add extra objects or return to the
original state of the objects. 

Select “Effects, Blocknesting” to apply the effect to a range of selected objects.
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A control object will appear around the selected objects. By dragging the control points the objects will rearrange
themselves as efficiently as possible within the width and height proportions of the control object.

You can drag the control points until you agree with the rearranging of the objects.
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If you think the result could be better you have the possibility to select “Properties” from the context menu of the
effect. In the dialog that appear you have the following options available for optimizing the result.

1 Select the direction you want to edit.
2 Select between ordered or optimal. Optimal will give the best result but is slower. 
3 Here you can set the horizontal or vertical size.
4 Here you can set the space between object. In the images above, a space of 2 mm is used, in the image below

0 mm is used.

5 Here you can select if you want to split text into lines, words, characters or use no text split. The text remains
text, if you remove the Blocknesting effect the text will be as it was before applying the effect.

6 If you check this option the effect will rotate objects to get an even better result. This option has the best result
when using a large number of objects and no space between the objects.
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True shape nesting

'True shape nesting' is an automated method of minimizing material usage. ‘True shape nesting’ places objects
together with minimal space between them. Using this functionality is cost efficient and environmental friendly. For
example, the objects on the worksheet below are placed by using the 'Multiply' functionality.

 

Compare this placement to the placement automatically generated with 'True shape nesting' as shown below.
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For some objects the media cost reduction can be even far greater, for example:

Manual or other automated placement
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As you can see 'True shape nesting' saves almost 50% of the media cost.

Workflow

Using 'True shape nesting' is simple and straight forward. Before you can start using 'True shape nesting' you need to
know how to apply the object specifications.

Preparing the objects to be nested

'True shape nesting' requires the objects you want to nest to meet a certain specification. An object ready for 'True
shape nesting' needs to be enclosed in a 'Sticker contour' with the option 'Connect' checked.

Why do you need the option connect checked?
For example see the object below with a 'Sticker contour' applied. For clarity the 'Sticker contour' is represented by a
red line.

At first glance there seems to be noting wrong with this situation but if you want to start the 'True shape nesting', with
50 duplicates of the object, you will get the following error message. 
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Som e objects could not be  p laced. No unique  cutline  de fined fo r 50 objects. 

A unique cutline is a continuous line surrounding each of the objects you want to nest. The object used is one object
that consists of 3 words with spaces between them. The so called 'cutline' consists of tree separated cutline's, one for
each word. You could of course enlarge the distance of the 'Sticker contour' to the object until the lines meet, but that

would not be the best option in this case, see the image below. 

The white space surrounding the object is much larger then was intended (or even required by the customer). It is
much easier and more consistent to let the software try to optimize this object by checking the option 'Connect' in the
'Sticker contour' dialog. Checking this option will give you the following result.

If you think this option will take too much extra space/media after the nesting command, you can also make some
adjustments too the object, for example by quickly closing the gaps between the words.

Remove the 'Sticker contour' from the object (if
any).

Draw some simple shapes to close the gaps, pen
style or color is not important.
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With the new objects still selected, select the
menu 'Ed it > Conv e rt to ' > Line  ty pe  > S ign
Bla nk'. 'Sign Blank' is a line type that isn't
printed or cut, so this is a invisible object for any
kind of output.

Select the original object including the new
objects and group them together.

Select the menu 'Effe cts  > Sticke r  contour'
and apply the 'Sticker contour' to the group.

The actual workflow

You can subdivide the workflow in two scenarios, a scenario in which you have one object that needs to be duplicated
multiple times and then nested and a scenario in which you have many different objects that need to be nested. 

One object multiple times

1 Import or open the object you want to use.

2 Adjust the page size to the size of your media using the menu 'Vie w > Se ttings'. 

3 Prepare the object like described in the chapter above 'Preparing the objects to be nested'.

4 Multiply the objects using the menu 'Arra nge  > Multip ly '. Enter the number of duplications, in the
dialog that opens, and be sure to uncheck the option 'Modifiable'.

5 Place the objects outside the worksheet because 'True shape nesting' is based on the dimensions of the
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worksheet and places the 'nested' objects on the worksheet.

6 Select the objects you want to use for 'True shape nesting'.

7 Select the menu 'Effe cts  > T rue  sha pe  ne sting  > T rue  sha pe  ne sting'. Select the options you want
to use in the dialog that opens.

8 In the 'True shape nesting' dialog press 'OK' to start the nesting.

Multiple objects 

1 Import the different objects you want to use into one worksheet.

2 Adjust the page size to the size of your media using the menu 'Vie w > Se ttings'. Select the tab 'Page'
and adjust the page size accordingly in the dialog that opens.

3 Prepare the objects (if necessary)  like described in the chapter above 'Preparing the objects to be
nested' but do not yet apply the 'Sticker contour'.  We postpone this because it would be very tedious to
apply a 'Sticker contour' to, let's say, 100 objects that need no other preparation.

4 place the objects outside the worksheet because 'True shape nesting' is based on dimensions of the
worksheet and places the 'nested' objects on the worksheet.

6 Select the objects you want to use for 'True shape nesting'.

7 Select the menu 'Effe cts  > T rue  sha pe  ne sting  > Pre pa re  T rue  sha pe  ne sting'. Choose your
settings in the dialog that opens.

8 In the 'Prepare True shape nesting' dialog press 'Apply' to apply a 'Sticker contour' to all selected
objects.

9 Select the menu 'Effe cts  > T rue  sha pe  ne sting  > T rue  sha pe  ne sting'. Select the options you want
to use in the dialog that opens.

10 In the 'True shape nesting' dialog press 'OK' to start the nesting.

Optional
Say you only need the 'Sticker contour' to nest your objects and not to cut them after printing (where the distance of
the 'Sticker contour is not an option but a customer requirement). If you want to change the distance you first have to
remove the 'Sticker contour’ and reapply them using the 'Prepare True shape nesting' dialog again. This is a simple
four step process.

1 Select all object on the worksheet that are already nested.

2 Select the menu 'Effe cts  > R e m ov e  e ffe ct' which will remove the 'Sticker contour' of all selected
objects. 

3 With the objects still selected open the menu 'Effe cts  > T rue  sha pe  ne sting  > Pre pa re  T rue  sha pe
ne sting' and apply the 'Sticker contour' with the new settings.

4 Apply the 'True shape nesting' again using the menu 'Effe cts  > T rue  sha pe  ne sting  > T rue  sha pe
ne sting'.
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Tip

If you have multiple objects, with different cutting types and/or distances, that you want to use for Print & Cut, then

you can use them as they are. Just apply a 'Sticker contour' on them using a distance of '0' (or any distance you
desire) and a line type of 'Sign Blank'.

The objects in the image above both have a Print & Cut line applied to an Inline effect (represented by the green line)
and a 'Sticker contour' for 'True shape nesting' with a distance of '0' and 'Sign Blank' as line type (represented by the
red line).

The 'Prepare True shape nesting' dialog

1 Cutter-tool
here you can select the line type you want to use, you have several predefined options to choose from.

2 Data
Here you can set the distance between the object and the 'Sticker contour'. 

When using the first 'Corner shape' options the 'Miter limit' will become available which will determine
how far a corner will 'Overshoot'.

In the image below from left to right the 'Miter limit' is set to 11, 72 and 125.
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3 Line properties
Here you can choose the shape of the corners. In the image below from left to right the first, second
and third option.

The second option is the most widely used because it gives the best result for almost any shape.

The 'True shape nesting' dialog

1 Nesting quality
Here you can set the quality of the 'True shape nesting'. The most commonly used option is 'Normal'
which will give a very good result consuming four times less memory as the 'More detail' option. The
option 'Less detail' is extremely fast and gives a lesser, but still acceptable, result and it also consumes

the least amount of memory.

2 Rotation
Here you can set the rotation allowed when nesting.

3 Options
The most important setting here is 'Incremental'. When this option is checked the 'True shape nesting'
will take objects already placed on the worksheet into account when calculating the nesting result.

The option 'use objects extends for objects without unique cutline' does just as it says. It will use the
objects extends while calculating the nesting result and not the actual shape of the object.

4 Page/cropmarks margin
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'True shape nesting' uses the worksheet as 'work area' or, when present, the inside of the alignment
cropmarks area. Especially with alignment cropmarks, but also with a worksheet, you don't want to nest
your objects all the way to the edge. Here you can enter the space between the outer most nested
shapes and the edge of the work area.

Out of memory

'True shape nesting' is very memory intensive. If you have too many objects selected it can run out of memory. 'True
shape nesting' has an 'Incremental' option, this options works together with the objects already nested on the
worksheet. You can use this option to nest very large numbers of objects as follows.

1 Place all objects you want to nest outside the worksheet.

2 Select a lower number of objects. If for example you tried to nest a 1000 objects all at once and ran
out of memory, select only 100 of them.

3 Start the 'True shape nesting' with your preferred settings, the objects will be placed on the worksheet.

4 Select the next 100 objects and start the 'True shape nesting' with your preferred settings, only now
activate the option 'Incremental'.

5 Repeat step 4 until you have placed all objects.

Bitmap distortions (effects)

In EasySIGN most special effects can be applied to bitmaps also. A unique property is that the distortions can be
applied to vector objects and bitmaps at the same time.

To illustrate this we give you an example of this application.

Import a bitmap and place a text over it, and optionally some more vector objects. You may place these objects
outside of the limits of the bitmap.

Select the bitmap and the other objects, and choose the menu option “Effects” “Special effects”
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Select the effect you want to use and click the “Apply” button.

You can superimpose any other effect like an Arcfit.
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Like most functions in EasySIGN this does not destroy the original objects. At all times you can make changes to the
text, the bitmap, and the vector objects, you can even add new objects through the use of the Object manager. The
end result will be automatically recalculated.

Keep in mind that the larger the bitmap is, the longer it takes to calculate the end result.

Settings for bitmap distortions.
Select the menu option “File” “Settings” and choose the tab “Miscellaneous” . here you will find the setting “Bitmap
effect resolution while editing”. The higher you set this value, the longer you have to wait for the end result to appear.

Vectorization

Vectorization
V e c t o r i z a t i o n

Vectorization with EasySIGN is very easy to do. Whether you want to carry out a "Centerline", "Outline" or "Color"
vectorization, all you need in order to do this is a bitmap. Vectors can always be edited and you can always try out
new settings by just simply selecting the command "Vectorization" again. If you select the command "Curves" from
the menu "Edit", “Convert to", you can transform the vectorization object to curves that can be edited. However you
will not be able to select the command "Vectorization" again.
For a "Centerline" of "Outline" vectorization you will need a black & white bitmap. For a color vectorization you will
need an RGB bitmap.

Outline vectorization
O u t l i n e  v e c t o r i z a t i o n

Import or scan a black & white bitmap, e.g. of a logo and make sure it is selected. 
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From the "Bitmap" menu select the option "Vectorization", the next dialog is then opened.

From "Type" (1) choose the option "Contourline". In "Dust filter" (2) you can select the degree of dust removal by
EasySIGN. With "Dust" we mean in the case of a bitmap with a logo and a largely white background the undesirable
parts for a vectorization (dirt on the glass of the scanner, fingerprints on the original etc.). In "Settings" (3) you can
choose from the following items.

Preset
Here you can make a choice from several preferred settings. These settings will show the best results for a certain
type of bitmap. In this case (a black & white bitmap) we would choose the setting "High resolution b&w text". The
sliders under the combo box will adjust to the preselected settings. If you would like to modify this setting you can
choose the option "User defined" from the combo box. You can modify the sliders according to your own ideas.

Number of nodes

 

This setting determines the accuracy with which EasySIGN builds up the vectors during vectorization. The more nodes
there are, the more accurate the shape will be. This is not a golden rule. If the original is very bad it is sometimes
better to select fewer nodes otherwise each slight difference will actually be vectorized. In this case a smaller number
of nodes will usually result in a more flowing result.

Sharpen corners

As it often happens that during scanning sharp corners are rounded, depending on the resolution, or else the original
is a printed copy which never really has sharp corners, EasySIGN offers the possibility to correct this.

Straighten curves

 

This filter turns slightly curved lines into straight lines. If the setting is made higher, more curved lines will be
influenced.

Horizontal/Vertical filter

 

This filter will change lines that are running more or less horizontal or vertical to lines that are running completely
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horizontal and vertical. If the setting is made higher, more lines will be included.

After you have finished with your settings you can click on the button "Apply" near (4) to first view the result or you
can click on "OK" to close the dialog immediately after vectorization. The result will look approximately as follows.

Centerline vector
C e n t e r l i n e  v e c t o r

One of the best features of vectorization in EasySIGN is not only that it is always possible to edit again but that all
types of vectors work in the same way. For centerline vector the only difference with the outline vector is that in
"Type vector" (1) in the dialog you must activate the option "Centerline". 

Color vector
C o l o r  v e c t o r

The way of vectorization has several more settings than the outline and centerline vector but for the rest it works in
exactly in the same way as the outline vector. Color vector only works on RGB bitmaps, so when you scan in an
illustration to vector you must make sure your scanner is set on RGB.

1 Number of colors
 Here you can set the number of colors you want to include in the vector.
2 Color blending
 Color blending blends colors that are very close together, into one color. The advantage of this is that unclear
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transitions between colors disappear. After vectorization unclear transitions have usually become very irregular
lines.

Outlining objects

With version 5, this functionality has been extended dramatically. New options are added and nearly all options have
the possibility to combine several steps into one. The best way the current features can be explained, is by means of
examples.
Select an object, then choose one of the outline options from the "Effects" menu . Depending on your license/version
or OEM type, the following options are at your disposal:

Outline
Outline (square)
Outline (circle)
Outline (double)
Inline
Inline (double)
Expand stroke
Sticker contour
Rubber band

1 Type

Extra data

2 Distance

3 Outer distance

4 Mitre limit

5 Number

Extra options



252 EasySIGN

6 Weld result(s)

7 Hide original

8 Pre weld

9 Inlined

Line properties

10 Corner shape

11 Line caps

Line properties

All types of outline share common properties that are related to the corner shape or line caps.
Which properties apply, depends on the type of outline.

Corner shape (10)

Straight angles

This option draws a mitre angle where the outermost edges of two meeting lines are elongated
until they cut. To prevent drawing of such cutting points in cases where they could be too far
off from the line ends, you can adjust the mitre limit.

A : Original
B : Mitre limit  10
C : Mitre limit  1

Rounded line ends

This option draws a circle around the line end with a diameter that equals the line width.

A : Original
B : Example

Mitre angle

This option flattens the cutting point of two meeting lines, by chopping off part of the
elongation.
This is quite similar to a straight angle with a mitre limit of "0".

A : Original
B : Example

Line caps (11)

Mitre

This option flattens the line at the line ends, so there is no elongation beyond the
line ends.
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A : Origineel
B : Example

Round

This option draws half a circle at the line end with a diameter that equals the line
width.

A : Original
B : Example

Straight

This option elongates the line beyond the line end over a distance that equals half
the line width and flattens the result.

A : Original
B : Example

Sharp

This option draws a sharp point at a line end, where the distance to this line end
equals half the line width.

A : Original
B : Example

 
Type (1)

Here you can select the desired type. You have this opportunity while creating the effect, but you can change this too
at a later time, when you change the properties of an object with some kind of outline. So you can change the type of
outline any time you want. In case several other effects are placed on top of this outline, these effects are
recalculated automatically.
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A A text, on top of which are an Outline, followed by an Arcfit, Flat Perspective and Perspective
Shadow.

B The type has changed from "Outline" to "Double Outline". All effects on top of this have adapted to
the new outline type.
 

Type, Extra data and Extra options

By means of several examples we show you some of the possibilities. While working with outlines, you can make a
large number of combinations yourself. Do pay attention to the fact that you can place an unlimited amount of types
on top of each other.

In the above image, you see from left to right different types of outline stacked on top of one another. If you change
the text now, all stacked outlines will be recalculated (see image below).

Select one of the outline types, such "Outline" from the menu "Effects".
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A : Original
B : Hide original (7) disabled.
C : Hide original (7) enabled.

Outline

Distance  (2) equa ls 1 and Num ber (5) equa ls 1.

The same as the first option, but now with rounded corners.
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The same as the second option, but now with Number (5) at 3.

Outline
(square)
Outline (circle)

Two variants that don’t base the Outline on the outer shape of the selected objects, but on
the selection extends. You have the flavours "square" and "circle".

Double Outline

Distance  (2) equa ls 3, Oute r d istance  (3) equa ls 5 and Num ber (5) equa ls 1.

The same as the first option, but now with rounded corners.
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The same as the second option, but now with Number (5) at 3.

Inline

Distance  (2) equa ls 3 and Num ber (5) equa ls 1.

The same as the first option, but now with Number (5) at 3.

Double Inline

Distance  (2) equa ls 3, Oute r d istance  (3) equa ls 5 and Num ber (5) equa ls 1.

The same as the first option, but now with Number (5) at 3.

Expand stroke

Distance  (2) equa ls 2 and Mitre  lim it (4) equa ls 1.
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The same as the first option, but now with rounded corners.

Sticker
contour

As the name implies, with this option you can produce cutting contours for stickers,
although the use is not limited to this application.

You can set the distance to the originals to be either positive or negative (9). You can even
set the result at distance (2) "0", so the Sticker contour follows the outer shape exactly.

Rubber band The Rubber band really is a unique function. You can imagine the result as a collection of
one or more objects around which a rubber band has been stretched. This is, for example,
a good alternative to the Sticker contour, if you want to make a cutting contour without
inlets and consequently it has far fewer  cutting lines.

You can set the distance to the originals to be either positive or negative (9). You can even
set the result at distance (2) "0", so the Rubber band follows the outer shape exactly.

This function is very well suited to connect objects to each other, too.

If you would try to draw the above example by hand, it would take some work to connect
the two circles perfectly. With the Rubber band and a distance (2) "0", this takes no more
than a single press of a button.
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Centerline

An object oriented effect to get the centerline of any vector object.

Select an object and the command “Effects, Centerline”.

In the dialog you can choose between two types of centerline and whether you want to hide the original. We selected
the first option an kept the original visible.

Because the result is object oriented you can change its properties. Select “Properties” form the context menu to do
so. In the property dialog select the second option.
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The effect has been recalculated. Even when we change the original the effect is recalculated.

When you are pleased with the result you can choose “Hide original” in the properties dialog and for example use the
object for engraving.  If you want to make any changes to the result you have to convert the object to curves
(CTRL+Q). You can then edit the object but it is no longer linked to the original.

Optimize for application (Color trapping)

Especially when vinyl needs to be applied to a backlit sign it is impossible to cold paste two joining pieces together
(without any overlap and directly against each other) And even if this were possible, the stretch and shrinkage would
cause it not to fit after some time. For this reason it is necessary to work with an overlap. The overlap must be
minimal and must be applied without any problems or ugly dark edges on the overlap. For these situations EasySIGN
has a special function, the so-called "Optimize for application". This function is simple to use and offers the possibility
to cut in at the overlaps. The cutting in of overlaps is handy when you need to paste together two objects of the same
dimensions. When the overlap has not been cut in there is a chance that the object underneath will stick out from
under the object on top.

Select the objects you would like to optimize, to show the result more clearly, the pictures are also displayed in wire
frame.
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Next select from the menu "Edit" the command "Optimize for application" and the following dialog will appear.

In this dialog you can enter under "options" (1) the distance for the overlaps, when you want to use "Delimited
overlaps" check the box. Under "Application order" (2) you can adjust the order of the colors. The result, with the
settings used above will look as follows.

The result is object orientated, this means you can always change the properties. To do this, select from the context
menu of the object the option “Properties”. Change the application order of the colors and press “Apply”, the result
will look like below.
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With the drag tool you can adjust the width of the overlap on the worksheet.

Optimize for inlay

With this function you can make an object oriented inlay. Select a vector shape and the menu “Edit, Optimize for
inlay”.

1 Here you can select an existing tool from the library of a numerical value for the diameter.
2 Male routing
3 Female routing
4 Mirror result
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With the drag tool you can adjust the object directly on screen. The result will show if the selected tool or diameter is
suited for the object.

1 Original
2 Correct inlay
3 Tool not suited, diameter is too large.

Entering lines numerically

In response to numerous requests, a way of entering lines numerically has been added to EasySIGN. People who
work with CAD-like programs should find this way of handling line-drawing particularly useful. 

Select the menu "Insert, Objects, Line". This command will open the following dialog.

1 Endpoint
 You can enter the line "X" and "Y" coordinates here. 
2 Type
 You can indicate here whether the entered coordinates should be a "Start point" or a 'Line". Each line consists

of at least one start point and one end point (line). If you have only entered coordinates with the property
"Line", the dialog generates a warning when you press the "OK" key indicating that an error has been made
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and giving you an opportunity to correct it.
3 Add
 When you have finished entering a coordinate, add it to the “Shape” list by clicking on this button.
4 Edits
 When you have selected an entry in the "Shape" list, this entry will be shown in the edit fields of the "X" and "Y"

coordinates and you can change the values. 
5 Shape
 You can select an entry to be edited or deleted from this list.
6 Delete
 This button removes a selected entry from the "Shape" list..

Linking worksheets

The option "Import link" has been added to the EasySIGN import dialog. This option is enabled when you select an
EasySIGN worksheet in this dialog. If you activate this option, the selected worksheet will be imported as a link. The
imported link will then be shown as a preview in the worksheet. A link is always indicated by the linking symbol at the
bottom of the preview.

Why link?

This option is very useful if you have a design which you wish to use in several worksheets and which will be changed
on a regular basis. Thus, instead of having to import, scale, position, etc. the design each time, you can import it as a
link. If the original has been changed, the change in the original will be detected when the worksheet with the link is
detected and the link dialog opens automatically. 

This dialog presents the option of updating the link by pressing "Update link" (4) button. 

The placeholder is on the bottom left of the link. If you have changed the size in the original file, an adjustment will be
calculated from this point.

The original worksheet can be opened by double-clicking a link (if you double-click a linked bitmap, the external
Windows™ editor you have chosen will be opened).

If you wish to enclose a linked worksheet (destroy the link and place the original in the worksheet), you can do this
by selecting the option "Link info" from the object’s context menu. The link dialog opens and you can select the
"Unlink" (5) button. This dialog also allows you to re-link the original (if, for example, the original file has been moved
to a different location on your hard drive) by pressing the "Relink” button. The "Export" button is only available for
bitmap images.

Links within links  
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If you have linked worksheets that contain linked bitmaps (or other linked worksheets), you must ensure that these
links are up-to-date. The program can detect whether a link to an original worksheet is up-to-date but it can't detect
whether the links within these linked worksheets are also up-to-date. You must always ensure that an original
worksheet is up-to-date.

Link output

When you open the plot dialog, you are presented with several options, one of which is for linked worksheets,
“Including colors from linked documents” (3).  

1 Selection only
 If you have selected objects in your worksheet, this option is activated when the plot dialog is opened. When

this option is activated, the list “By color” will be limited to the colors present within the selection on your
worksheet.

2 By color
 Only the color selected in this list will be plotted.
3 Including colors from linked documents
 This option is only available when the option “By color” is activated. The list will now also include all of the

colors from linked worksheets.

Checking links

When a worksheet is opened, all of the links that are present will be checked to see if they are still up-to-date. If they
are not up-to-date, a dialog is presented in which you can now update them. If you do not update them now, they will
be updated (if possible) during a print or plot job. To avoid surprises (size or placement can be completely different in
a changed link and can create unwanted difficulties), it is better to ensure that all of your links are in order before
starting a print or plot job. If a link is missing, you will be warned before printing or plotting. If you ignore this
warning, the missing link will be printed in its low resolution representation and the missing data will be ignored during
plotting.
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Autonumber

EasySIGN supports the use of an autonumber object. This is very easy to use. All you have to do is select the “Insert,
Objects, Autonumber” menu. A dialog will appear and an autonumber object will be placed on the worksheet.

The following settings are available in this dialog.

1 Number
- “Header” allows you to assign a fixed text that will be placed before the actual autonumber.
- “Number” allows you to assign the number from which the autonumber starts numbering.
- “Minimum length” allows you to define the number of zeros to be used to fill to a constant length of an

autonumber. If you only define one zero, the autonumber will use the actual autonumber with no zeros.
- “Suffix” allows you to assign a fixed text that will be placed after the actual autonumber.
2 “Alignment” allows you to define whether the parts of the autonumber object are aligned after or under each

other.
3 This allows you to view a preview of the of the settings you have selected in this dialog.

You can return to this dialog at any time using the properties command via the context menu of the autonumber
object (right mouse button) and change any settings you have made. The settings will be applied to the autonumber
object when you press “OK”.

What you now have is a basic autonumber object. When you duplicate, make a placement leaving behind an original,
using the “Multiply” command, or carry out any other action that makes a duplicate of the object, you can allow the
autonumber object to increase. It does not matter if the object is part of a group or a design, e.g. a sticker for
container numbering, the number will automatically increase. Objects that are already increased can be duplicated.
The numbering will start again from the autonumber object in question.
It is possible to create an autonumber range very quickly by moving the object and clicking once on the right mouse
button (this leaves an original behind). If you then use the shortcut “CTRL+R” (repeat) several times you can
generate a complete worksheet full of autonumber objects in a few seconds.
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The text properties in an autonumber object can also be edited, with a few limitations.

1 The “Header” allows you to edit the text property and color separately from each character. 
2 The actual autonumber allows you to edit the text property and color separately from each character. However,

if the number is increased, the property for the autonumber will still be based on the first character of the
autonumber.

 

 
 
3 The “Suffix” allows you to edit the text property and color separately from each character.

You cannot add or delete any of the characters from any of the above parts. This must be done using the autonumber
object properties dialog. When the autonumber object is edited via the dialog, all of the characters have the same
properties as the first character.

 

 
 

If you no longer wish to use the autonumber object as an object, you can convert the object to a text object via the
context menu.

Saving a selection from a worksheet

When you have created a worksheet and wish to save a part of it to a new  worksheet, you can now export a
selection of this worksheet to a new file. To do this, select the menu “File, Export”. In the dialog, you select the format
“EasySIGN” and activate the option “Selection only”.
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Object manager

Object manager
O b j e c t  m a n a g e r

What is an Object manager?
The Object manager provides the means of reverting almost every object to its original state. Each action, like
applying an effect, welding of objects etc. does not affect the original when handled by the Object manager. Each
separate object is saved internally. For example, a text with multiple effects applied could normally not be edited
without first removing all effects, editing the text and then re-applying the effects. With the Object manager you can
directly select the part of the design you want to edit; the rest of the effects are automatically re-applied.

Important
When the Object manager is active, instead of producing end-results, there are new objects being created. Each
object within this new object still has the original features it had before becoming part of this new object. If the use of
the Object manager possibilities is too complicated at first and you want to start working right away, without first
understanding the Object manager, there is the possibility of disabling some parts via the menu “File”, “Settings”,
“Object manager”. Each object created is then a definitive object which you may recognize from previous versions.
You can then enable these settings again at your own convenience, try them out and, when you are comfortable with
them, put them to use.

Also, objects that have been made when the Object manager was (or is) active can be converted to definitive objects
(no longer possible to reach each separate element of the object), via the command “Edit”, “Convert to”,
“Curves” (CTRL+Q).

How does the Object manager work?
What an Object manager can do for you and how this process works is best explained by an example.

If it is not already visible, select the menu “View”, “Object manager” to display the Object manager. This window (the
Object manager) lists all the objects in a worksheet:

Each object has its own symbol and description:
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A text will always show this icon in the text color itself, and a label consisting of the first characters of the text. Every
other object like an effect will show only the name of the effect in its label.

For the following example we begin with a clean worksheet.

1 Type a text containing an error, for example, “ERRAR” instead of “ERROR”.  Use a bold font approximately 19
mm high:

2 Select the menu “Effects”, “Expand stroke” in the dialog, and activate the options “Weld objects” and “Remove
original”. In the field “Distance” enter approximately 0.6 mm:

3 Apply an effect.  In this case we have used “Arc fit”:

4 Apply another effect.  In this case we have used “Drop shadow”:

The original text still has an error, which you now have to correct.   Instead of removing all the effects, correct the
text and then try to re-apply all the effects as they were, before we use another approach. Select the symbol for that
text in the Object manager:
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The text is simultaneously selected on the worksheet:

Now select the text symbol to correct this text:
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When you have finished correcting, select the select tool in the toolbox; all the effects are now recalculated to fit the
corrected text. To correct the text, including all the applied effects, you need only select it in the Object manager and
edit it:

Of course you can do more with the Object manager than correct spelling errors. Say for example you don’t want a
transparent text but one with a fill, here is what you can do:

1 In the Object manager, select the symbol for outlines:

2 On the worksheet the outline is selected:



272 EasySIGN

3 In the toolbar of the Object manager, select the symbol for “Properties”:

4 When the property dialog of the outline opens, de-activate the option “Remove original”:

5 Both the text and the outline now have a fill; by selecting the text in the Object manager again you can change
only the fill of the text:
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Object manager and Welding
O b j e c t  m a n a g e r  a n d  W e l d i n g

Each object of EasySIGN benefits from the Object manager. A function like “Welding” clearly shows the advantages.
To illustrate this properly, the next example is in wire frame.

1 Draw a rectangle and circle and place these on top of each other:

2 Apply “Edit”, “Welding”, “Melt object”:

3 By selecting one of the objects in the Object manager, you can move it around freely on your worksheet:
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After releasing the object the effect is recalculated. Without having to remove the effect, you can rearrange all the
parts of a design.

You can also change the properties of a welding. You can open the property dialog and change the type of welding by
simply selecting a different type: 

Not only can you change effects, but you can even add new objects to an already existing effect, as follows:

1 Change the effect back into a “Melt object” and draw a circle over the existing effect:
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2 Select the circle in the Object manager and drag it into the welding:

The circle is now a part of the welding:

On the resulting effect you can apply any other effect, for example a shadow:

If you change any of the welding effect, every other effect is automatically adjusted:
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Object manager and Outline
O b j e c t  m a n a g e r  a n d  O u t l i n e

Each object of EasySIGN benefits from the Object manager. A function like “Outline” clearly shows the advantages.
How many times have you applied an outline that had to be changed afterwards so you could start over again? When
you use the Object manager, rather than start over again, you need change only the properties:

1 Draw any object:

2 Apply the effect “Expand stroke”:

3 If you now want round instead of straight corners, you only have to use the right mouse button to open the
properties dialog and adjust this setting:

4 If you are not satisfied with the width of the outline you can open the properties dialog again and change this,
or adjust the width directly on screen with the drag tool:
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5 You can adjust the property of the object at any given time. In the example below the property is changed to a
“Double outline”:

Object manager tips
O b j e c t  m a n a g e r  t i p s

Not every object processed by the Object manager can be made “ready to cut”; this, however, is no big problem. You
just make a working copy of the original and use the command “Edit”, “Convert to”, “Curves” (CTRL+Q). This
converts the object into an “end result”. On this object you can then use the output function of EasySIGN. You always
have the original to work on design modifications.

Because every object on the worksheet is represented in the Object manager, it can sometimes be a problem to
select the right sub-object (object that is a part of an effect or group) easily. The easiest way is to select the “main”
object on screen, which is then automatically selected in the Object manager; directly below this selection you will find
the sub-object again.

Sometimes changing a property doesn’t produce the desired result, because not every action is possible within an
existing hierarchy of objects and effects. In the Object manager you can select the object(s), drag it/them out of the
hierarchy, change or add properties and drag it/them back into the hierarchy again. Because dragging objects in the
Object manager doesn’t have any influence on the location in the worksheet, it will always stay in the same location
relative to the hierarchy.

If you can’t select an object in the Object manager, check whether the layer containing the object is locked for
editing.

Object manager objects: opening and closing
O b j e c t  m a n a g e r  o b j e c t s :  o p e n i n g  a n d  c l o s i n g

In the Object manager (and the menu “Arrange”) there are two important commands:

Open object

Close object

If you edit an object in the Object manager that is part of a complex hierarchy, the calculation time could be a
problem if many manipulations are necessary. In this case it would be better to open the object by selecting the
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button or the menu command “Open object”, which temporarily ignores other parts of the hierarchy, so even complex
editing can be done swiftly. 

The example below is a text with a shadow, not exactly a complex hierarchy, but it illustrates the use of opening
objects:

If you wanted to adjust the kerning of the text, the shadow would be recalculated every time you released the mouse
button. This is an example of a better way of opening the object. Select the symbol for this text in the Object
manager:

Now choose “Arrange”, “Open object” or click on the button in the Object manager. Only the selected text is now
displayed; all the other parts of the hierarchy are invisible and temporarily ignored:

You can now edit everything you want without the hierarchy being recalculated:

The recalculation of the hierarchy is done after you choose the command for closing the object, instead of every time
you release the mouse after dragging a character:
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CTRL+CLICK or sub-selections

EasySIGN supports sub-selections in groups and effects. A sub-selection means that you can select  a part of a group
or effect without having to strip the effect away from the object you want to select and then edit. 

Suppose you have the following situation:

The 4 circles in the image above are a group.  Over them a dark red square is placed, and both have a shadow effect
applied. If you wanted to apply another color to the square, you would normally first have to remove the shadow
effect, then apply the new color and try to apply the same shadow effect you had before. The easier way is to select
the square while pressing the control key:

You have now selected the square directly. When you have a sub-selection, the selection handles themselves are
round instead of square shaped.
Because CTRL+CLICK works via the order in which effects, groups etc. are applied, you cannot always select an
object directly.  Sometimes you have to click again to select “through” an effect or group: 

A sub-selection (in this case the square) can be adjusted in almost every way; you can change its color, change the
corners with the drag tool, apply any transformation etc:
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Now select one of the yellow circles using the control key:

You have now sub-selected the group of 4 circles; you can now change the color of all the four circles at once:

When you click again you have selected only one of the circles (you selected “through” the group); any action is now
only applied to the sub-selected circle:

Note that selecting with the control key is done in the order in which effects, groups etc. are applied. To illustrate this,
see the example below; this is a group of 4 objects:

If you select the yellow rectangle using the control key you can sub-select it directly:
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In the example below we used the same objects but added a square which we grouped with the previous group, a
group within another group. If you now want to sub-select the yellow square, you have to click twice to select
“through” the extra group:

Important: when positioning with the control key
When you want to constrain the movement of a group or effect using the control key, you first have to start the
movement and then press the control key (when the movement has begun). If you first press the control key and
then start to move you will probably only move the sub-selection of the group or effect.

Arc fit

The command “Effects, Arc fit” allows you to place text (and objects) on a special arc. Script text, as shown in the
example below, and Arabic text have the disadvantage that when placed on a conventional arc, their connections do
not align. 

With the command “Arc fit”, you can make the script and Arabic text connections align the way that they would if
typed on a straight line.
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The connection points of the text in the above illustration do not align. To correct this, select the object context menu
and then select the “Properties” command.

1 Distortion type
 You can select the way the objects should behave on the arc here.
2 Center
 You can set the location of the object on the worksheet here.
3 Circle properties
 You can set the arc radius, begin, middle, and end here.

To align the text connection points, choose the second option and press “OK”.
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All of the connection points are now aligned. This effect is achieved by slightly distorting all of the letters. If you use a
small text and a small radius, the distortion will be greater than it is using a large amount of text and a large radius.

Adjusting arcs

Arc fits are the easiest to handle directly on the worksheet using the drag tool.

The original object.

After the command “Arc fit”.

Adjusting the tension/radius of the arc
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Adjusting the radius.

Adjusting the width.
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A Rotate and scale using “I” as an anchor point.
 Together with the control key, scale with “J” as anchor point, leaving “I” under the same angle.

B Adjust the length and height of the arc.
 Together with the control key, rotate around “J” without adjusting the radius.

C Same action as “A”.
D Adjusting the tension of the arc.
E Move the control points.
 Together with the control key, rotate around “J” without adjusting the radius.
F Same action as “D”.
G Rotate and scale using “A” as an anchor point.
H Same action as “B”.
I Same action as “G”.
J Moving the arc in drag mode.

Objects on arc

Fit

The illustrations below show the difference between the objects on an arc for which the distortion “Fit” is and is not
applied. The illustration on the left use the option “Fit”.



286 EasySIGN

Flat perspective

You can apply Flat perspective on one or more objects simultaneously. With this command you can apply a one or two
points perspective. This means that an object can have two vanishing points.

How do I apply flat perspective?
Select the object you want to apply the effect to:
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Then select the menu “Effects”, “Flat perspective”:

Around the object you will see eight control points appear. The control points on the corners are for the perspective
deformation. With each control point you can use the control key for horizontal and vertical restriction in movement. 

By dragging the corner points you can adjust the perspective:
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This tool assures you have control over every possible flat perspective deformation. You can use this tool to put a
logo on a building or the hood of a car and all in the right perspective. The ideal tool for making final design
presentations.

All control points can magnetically snap on guidelines and the nodes of other objects:

By dragging the control points in the middle, you can move the two surrounding nodes without affecting their relative
position toward each other:
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By dragging a control point on a line while simultaneously pressing the shift key you make this line parallel to the
opposing line:

By using the right mouse button on a control point, you get a dialog in which you can set the position of the control
point numerically:
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A flat perspective can be applied to any vector object:

 

Mold effect

With the mold effect you can mold any object into the shape you want without affecting the original object. The mold
tool is explained in the example below.

Select an object:
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Choose the command “Effects”, “Mold effect”:

There are now 4 nodes surrounding the object. These nodes can be dragged in any direction using the drag tool.
Using the control key will limit the movement to horizontal or vertical only:

When you release the mouse button the object flows to the shape of the mold effect:

With the handles of the nodes you can accurately shape the mold effect:

 

When you are working with the mold effect the note editing dialog is visible,  because the mold effect supports normal
vector and node editing like adding nodes, changing properties, deleting nodes etc.

To add and drag a node:
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Now select all the nodes and choose the command “To line” to change all curves to lines:

This illustrates the possibility of node editing on a mold effect. You can now remove the node added earlier by
selecting it and pressing delete, or choosing the option for deleting in the node editing dialog:

Now select the remaining nodes and choose the command “To curve” and “Make symmetrical”:

An object always follows the curves of a mold effect approximately. It is impossible to follow the curves 100%
accurately. However, there is the possibility of changing the accuracy of this by selecting the command “Properties”
from the context menu of a mold effect. This opens a dialog where you can set the precision of the effect:
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When you increase the precision, the object follows the mold effect more closely, but calculation takes longer. The
most effective approach is to first mold the object in approximately the shape you want, and then increase the
precision and make the final adjustments. 

Low precision

High precision

Of course you can apply the mold effect to multiple and very complex objects:

The most effective use of the mold effect lies in text adjustments. The possibilities here are almost endless:
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With the command “Edit”, “Convert to”, “Curves” (CTRL+Q) you can change a mold object into a vector object and
with the command “Effect”, “Extract from effect”, you can retain the original object or objects.

Blend

With this option you can blend between objects and colors.

During the blend the shape, fill and line style (color and width) are taken into consideration.

How do I create a blend

Select two or more objects and then the menu "Effects, Blend".
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The last used settings are applied and the software switches to dragtool mode.

By dragging the diamond node (1) you can determine if the color blend lies closer to the first or second object. By
dragging the triangle node (2) you can determine whether the blend shapes should resemble more the first or second
object.  

By clicking the blend with the right mouse button you can select "Properties" form the context menu. This opens the
property dialog of the blend. Here you can set for example the number of steps.

By using CTRL+CLICK on one of the originals (or by selecting them in the Object Manager) you can edit the original
object (for example change the color of shape), after this the blend will be recalculated. 

You can add new objects to the blend (or remove them) through the Object Manager by dragging them in or out of
the blend effect.

Selecting the option "Circular" from the properties dialog you can connect the first and last object.
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Even now you can edit the original objects or apply other effects to the blend.

The blend dialog

1 Pair
Here you can select the different blend pairs. If the blend only consists of two originals then there will be only
one blend pair, with 3 objects there will be 2 blend pairs etc.

Originals (1), Blend pairs (2), and the results (3).
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2 Number of steps

Here you can set the number of steps per blend pair. If you activate the option "Apply on all blend pairs" the
number of steps is applied to all blend pairs.

3 Circular

Here you can set if the first and last object also should form a blend pair.

1 : Not circular
2 : Bottom
3 : Top

4 Space

Under "Deviation" you can set if the start point of the object should be closer to the first or second object.

1 : 0%
2 : -50%
3 : 50%

5 Fill style and pen style of generated objects

With the combo boxes under "Center" and "Others" you can set how for example gradients should behave in
a blend.

1 : Default both on "Non-Autofit".
2 : "Others" on "Like start object".

Under "Deviation" you can set if the start point of the color blend should be closer to the first or second
object.
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1 : 0%
2 : -75%
3 : 75%

6 Relative start node

This option let you determine the relative start node for each blend pair.

1 : Node 0 (default).
2 : Node 1
3 : Node 2
4 : Node 3

7 All objects

Rotation direction clockwise. This option adjusts the rotation direction of all the objects in a blend to wind in
the same direction.

Some examples of blend effects

Striping, the upper image has as setting "Equal distances centers" and the lower one "Equal space".
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The upper image has a gradient fill and in the lower one every character has a different color.

On the left the original objects and on the right the same objects with a blend.

A combination of the blend and other effects.

Logo design with blend effects.

Blend effect on lines.

How do I create a neon effect with the blend

Type a bold font, here a Verdana with a height of 200mm is used and the characters are 150% in width.
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Give these objects "No fill" and a line style of 6 mm wide. Apply the following color to the line style. 
CMYK : 0-100-100-100

Select "Edit, Clone, On top". Cloning is not essential but it makes life a lot easier when the text has to be changed
later on. Make the line style 2mm and apply the following color.
CMYK : 0-100-100-0

Select "Edit, Duplicate on top". Make the line style 1 mm and apply the following color.
CMYK : 0-0-0-0

Draw a black rectangle with rounded corners behind the text objects.

Select all the text objects and the menu "Effects, Blend".

If you have used Clones then you only have to edit the "Control text" to let the whole effect recalculate.
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Clone

A clone is a copy of an object that still has a link to the properties of the original. Each property of the clone that is
changed, will be disconnected from the original. 

This is best explained with an example. 

Draw a rectangle.

Select the command ‘Edit, Clone, Shifted”.

Next we copy the clone several times. When a clone is copied it automatically becomes a clone of the same original
as the clone it is copied from.

If we change the color of the original, the clone is also affected.

Now we changes the color of one of the clones. The property “Color” is now disconnected from that clone.
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When we now change the color of the original all the clones are affected except the one we disconnected the color
from.

Only the color is disconnected, so if we change the shape of the original this will affect all the clones.

You reconnect the property “Color” by selecting “Restore original” from the context menu of the clone.

In the dialog that appears you see  a list (1) of all the disconnected properties. Select the property you want to
reconnect (the color in this case) and press “OK”.
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When you change the shape and color of the original now, it will affect al the clones.

The original is a rectangle. When we convert this to curves the clones will be converted also. Every adjustment you
now make with the drag tool will affect all clones. 

Clones an text
Clones of text have a special feature. When the text is changed in any way, the clones will be changed also.

 

Klonen en effecten
You can’t clone an effect but you can apply an effect to a clone.
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The clone in the effect will react on the changes made to the original and therefore recalculate the effect.

Striping

With this functionality you can subdivide vectors, effects, bitmaps and combinations of them into separate pieces.
You even can apply several "Stripings" on top of each other to create your own effects. Since the "Striping" is an
effect, original objects are not disturbed. You can remove the "Striping" at any time.

The examples below show the possibility to apply multiple levels of "Stripings" to several objects.

O rig ina l

W ith horizonta l "Strip ing"
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W ith horizonta l and ve rtica l "Strip ing"

W ith horizonta l, ve rtica l and radia l "Strip ing"

Applying a Striping

Select the object(s) to which you want to apply a "Striping". Next select the menu "Effects, Striping” and choose one
of the sub-menus.

The last used "Striping" is applied to the selected objects. To adjust this "Striping", you select the option “Properties”
from the context-menu. You can modify the "Striping" directly on screen, too, by means of control nodes, but the
dialog supplies you with more options and better control.

Inside "Type" (1) you find three major categories of the "Striping". When selecting one of these subtypes each time
other options become active in the dialog.
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Orig ina l object, the  ex tra  b lack  outline  is  to  ind ica te  the  boundary .

A Linear

2 Miscellaneous

DutyCycle

This option determines the ratio between stripes and gaps.

DutyCycle  : 50%

DutyCycle  : 25%

DutyCycle  : 75%

Variability

This option determines the ratio between the width of the first and the last stripe.
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Variab ility  : 0%

Variability : 100%

Angle

With this option, you can set the angle.

Angle  : 0 degrees

Angle  : 45 degrees

4 Number of

Stripes

The number of stripes that should be used.
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Stripes : 4

Stripes : 8

G aps

With this option you can instruct the "Striping" to add or remove a gap. This way, you have
better control over how the "Striping"  fills an object.

G ap : 0, the  sam e num ber o f gaps as str ipes

G ap : -1, one  gap le ss

G ap : +1, one  additiona l gap

B Conical

2 Miscellaneous

See "Linear" for more information.

Some examples:
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DutyCycle  : 50, Variab ility  : 0% , Angle  : 0 degrees

DutyCycle  : 50, Variab ility : 50% , Angle : 15 degrees

DutyCycle  : 75, Variab ility : 0% , Angle : 0 degrees

4 Number of

See "Linear" for more information.

With a conical "Striping", you can only adjust the number of stripes here.

Stripes : 16

5 Center

Here you have several options to influence the center of "Striping". In the example below, the
center is put on
 x : -50% and y : +50%. You can enter  percentages of the width and height of the selection,
numerical values, absolute or relative (to the selection) coordinates.
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C Radial

This option can be subdivided into "Normal", "Polygon" and "Star".

2 Miscellaneous

See "Linear" for more information.

3 Radius

Here you can supply the outer and inner (vertical) radius and also the horizontal radius. The
ratio between the outer and horizontal radius determines the aspect ratio.

Oute r : 100% , Inner : 5% , Horizonta l : 100%

Oute r: 100% , Inner: 5% , Horizonta l: 200%

Oute r: 200% , Inner: 5% , Horizonta l: 100%

6 Star/Polygon

This option group becomes active if you have selected “Star” or “Polygon”. 

Nr. o f corne rs

Sets the number of corners.
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Nr. o f corne rs : 5

Nr. o f corne rs: 10

Am plitude

This setting influences the inner shape of the “Star” or “Polygon”. 

Am plitude  : 50%

Am plitude  : 0%

Am plitude  : 100%

Since the "Striping" is so versatile and applicable to almost all kinds of objects, this is also a strong multi-purpose
design function, which is certainly not limited to cutting tasks.
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Round off

Corners of vector shapes can be rounded off without disturbing the originals. If a straight line connects to a curve,
this line is rounded off, too. Select an object for which you want to round off the corners.

Next, select from the “Effects” menu , the option “Round off”.

The cursor changes to the “drag tool” mode and control nodes for rounding off appear around the object. The last
used “Round off” settings are automatically applied. You can also adjust the “Round off” via a dialog, you then have
the additional choice between rounded corners and “bevel” corners.

By exaggerating the “Round off”, you can even create complete new shapes.
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The “Round off” is applicable to all vector objects, therefore also standard objects, such as the “Star”, can be used to
create new shapes.

Since the “Round off” effect,  like all other effects, doesn’t disrupt the originals, you can adjust the original by means
of CTRL+CLICK or via the object manager.

Templates

Template Wizard
T e m p l a t e  W i z a r d

Using the Template Wizard you can easily change one of the many supplied templates or a custom template. You can
change text and objects in a template by entering a new text or choosing a different clipart file. Trough the Template
Wizard you can even change dimensions, page size, multiply or fill a page with copies of a template.
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Select “File, New from template” to open the Template Wizard. First you will see a dialog in which you can browse for
template files trough previews of the templates. 

1 Favorites, by clicking on the “+” you can add the currently selected folder to your favorites. The next time you
open this dialog you can directly go to a folder by selecting it from the list of favorites.

2 Here you can browse through the folder on your system.
3 Here you can see the previews of the template files in the currently selected folder.

Select the template you want to use and press “OK”.



315EasySIGN

The first time you open the Template Wizard you will be presented with a welcome page. You can change this by
activating the option you want to skip the welcome page in the future (1). The number of pages you will see in the
Wizard is depending on the choices you make and the number of replaceable objects in the selected template.

For each text that has the property “Replaceable” a page will be shown in the Wizard. On this page you can change
the text and font.



316 EasySIGN

1 Shows in a preview the location of the text in the template.
2 The text in the template.
3 Changed text.
4 Reset the text to the original text.
5 Change the font.

Whenever a font isn’t present on your system a question mark will be visible in the list and you will be advised to
change this font to an existing one.

When all the text objects in the template are processed you will get a page with replaceable clipart (if any present in
the template).
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1 Shows in a preview the location of the clipart in the template.
2 Here you can select if you want to replace the clipart.
3 Opens a dialog in which you can find and select clipart.

If you do not select another clipart the clipart from the template will be used.
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1 Select a predefined dimension for the template.
2 Enter your own predefined dimensions.
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1 Select a predefined page size.
2 Define your custom page size.
3 Query page sizes from your output devices.
4 Select page orientation.

If you do not change any property the page size and orientation from the template will be used.
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Here you can multiply the template by entering a number or let the program calculate the number of templates
needed to fill the selected page size. You can also set the page margin and space between the templates.

If you do not change any property only one copy of the template will be used.

Make your own templates
M a k e  y o u r  o w n  t e m p l a t e s

Making you own templates is very easy. Any new text entered on your worksheet is automatically replaceable. You
can switch this off by selecting “Arrange, Templates, Cancel replaceable”. If you want to switch the property
replaceable on for text or objects select “Arrange, Templates, Make replaceable”.
Now save the worksheet as a template by selecting “File, Save as, Template file”. If you open this file with the
command “File, New from template” the Wizard will show a page for every text and object that has the property
“Replaceable” set to true.

Import en Export special

Adobe™ PDF export
A d o b e ™  P D F  e x p o r t

You can export any worksheet from EasySIGN to a PDF file (Portable Document Format). You should keep in mind
that only objects that are placed on a page will be exported correctly. PDF can not display object outside a page.

Select “File, Export”. In the dialog select with “File type” the filter “(Portable Document Format) (*.PDF)” and enter a
name for the PDF file you want to export. When you press the button “Export” the following dialog will appear.
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1 Gradients
Use vectors below ... steps.
PDF has it’s own compact way of handling gradients. These gradients are a lot smaller than vector gradients
but they are never identical to the gradients in your worksheet. If you want the gradients to be identical to the
ones in you worksheet make sure you enter a number here that is larger than the gradient fill steps in your
worksheet. When using default settings 300 steps is enough.

Convert gradients to ...
PDF recognises only RGB and CMYK color spaces. If you used a rainbow HSB fill in your worksheet this has to
be converted to one of the mentioned color spaces. CMYK is normally the best and most accurate method.

2 Bitmaps
Compression
You can choose between “None” and “JPG” compression. When you want to use the PDF for a service bureau
the best choice would be "None". The PDF file will be many times larger then a compressed file but the bitmaps
in your worksheet will be exactly the same with the service bureau as they where in your worksheet. When
using compression some data could be lost. 
 
Quality
Here you can set the strength of the compression.

E-mail

E-mail configuration
E - m a i l  c o n f i g u r a t i o n

With the e-mail system of EasySIGN you can quickly and easily send an active worksheet  as an attachment to an e-
mail or send a preview for approval to your customer.

Before you can use this functionality, you have to adjust some settings. Select the menu “File,”Send to, E-mail
settings”.

Tabsheet HTML-settings
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1 Here you can instruct the software when to warn you in case the attachments are too large.
Keep in mind that most providers enforce a size limit upon your e-mail and your customers also
prefer not to receive large e-mails of several MB., .

2 HTML

Attachment:
Here you can select whether you want to use a HTML template when you send the worksheet as
an attachment, and if so, which one.

Preview:
Here you can select the template you want to use when you send the worksheet as a preview.

Encoding:
Here you select the country code of the area where you are resident.
This selection needs to correspond with the setting in the HTML template you use.
See the default settings and the supplied templates as example.

3 Interface

EML compatible:
This opens the e-mail in your.EML compatible application. On most computers this is Outlook
Express™.
The advantage of this option is that you can edit the contents in any way that suits you, prior to
sending the e-mail.
You can ignore the settings on the tab sheet “SMTP-settings”, but you should adjust the
corresponding settings in your .EML compatible application.

Direct SMTP:
This opens the e-mail in the working environment of EasySIGN. You can change the selection of
the template prior to sending the e-mail. If you choose this option, you should adjust the settings
on the tabsheet “SMTP-settings” as well.

4 Preview:
Enter here the maximum width in pixels and the resolution of the worksheet preview. 
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Tabsheet SMTP-settings

Only adjust this when you have selected  “direct SMTP connection” on the tab sheet “HTML-settings”.

You only have to adjust these settings if you don’t have access to an .EML compatible client like Outlook Express, or
when you don’t want to use this. We advise you to contact your provider in case you encounter any problems. He can
supply you with the necessary information.

If you use this software in a company network with Exchange Server, contact your network administrator.

1 Sender

Name:
Enter the name shown in the field “From:” of an e-mail. Often this will be your company name.
 
E-mail address:
Enter here your e-mail address.

Authentication method:
The way to log on used by your provider.
Choose one of the following options:

NONE: In case your provider supports anonymous log on. This only happens
occasionally.

CRAM MD5: You’ll need this method if you want to log on to an LDAP server.

AUTH LOGIN: This method will do in most circumstances. Your username and password are
sent encoded.

PLAIN LOGIN: Same as AUTH LOGIN, only your username and password are sent
unencrypted. This option is not recommended.

Username:
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Enter your username here. You can find this in the letter from your e-mail provider. Otherwise,
you should contact your provider.

Password:
Enter your password here. You can find this in the letter from your e-mail provider, too.  If you
can’t find it or have changed it, you should contact your provider.

2 Server

Host name/address:
Enter the name of your SMTP server. Often this is 'smtp.domain.com' where you have to replace
domain by the name of your provider. See the letter from your provider. If you work in a
company network, you can enter the IP-address or the WINS name of the server.

Port number:
Enter the port number used by the smtp server used to receive e-mail. Often, this is 25. Contact
your provider in case of any problems.

3 Address book

WAB:
Select this option if you want to use the Windows™ address book.

Outlook™ contacts:
Select this option if you want to use the contact list in Outlook™.

4 Connection:
Enable this option if you want this program to automatically log on to your provider if there is no
open connection yet.

E-mail HTML-templates
E - m a i l  H T M L - t e m p l a t e s

The e-mail system of EasySIGN uses HTML-templates. By means of a HTML-template you can include all required
company information in the presentation of a design to your customer.

While installing EasySIGN, several example HTML-templates are installed in the subdirectory “\HtmlTemplates\” of the
program directory. These templates contain so-called fake text (which serves as a placeholder for your own text) and
an example logo. Images, such as the example logo, are placed in the subdirectory “\HtmlTemplates\images\”. You
should adjust a template before using it, otherwise you may surprise your customers with the fake text in the
examples. You can carry out a test by sending an existing template to yourself by e-mail.

Adapting/Creating a HTML-template
You are entirely free in adapting or creating a template. A HTML-template should at least contain the following text
(literally):

<<|InsertWorksheetImageHere|>>

This text is used to mark the spot where the program should substitute the worksheet preview (image) in the HTML-
template.

There is another marker, or placeholder, you can use to add extra non-standard text to your e-mail before sending it.
This text always shows up in a fixed spot in the e-mail and is marked in the template by the following text (literally):

<<|InsertAdditionalBodyHere|>>

Things you must pay attention to
In order to avoid problems, you should pay attention to using correct HTML-syntax. Using a professional HTML-editor,
such as “Dreamweaver™”, is recommended. In case any problems arise while converting the HTML-template to e-
mail, you should check the HTML-syntax. Incorrect syntax is the most likely cause of your problem.

Given that the HTML-template has to be crafted only once, you can outsource this to an external office, in case you
cannot cope with HTML.

If neither of the above options suits you, you can use the HTML-template “basic.htm”.
This template only contains a mark (placeholder) for the worksheet preview and one for the extra text. In the e-mail
dialog of EasySIGN, you can fill in this text according to your wishes for each new e-mail.

I already use other e-mail templates, what now?
In case you already use other company e-mail templates, for example in Outlook™ (not to confuse with the free
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Outlook Express™) you can easily include a worksheet preview in these templates. Select the worksheet part (or the
whole worksheet) you want to include as preview in your template. Select menu “Edit, Copy special, As bitmap to the
clipboard”. As this name suggests, your selection is copied to the clipboard as a bitmap, which you then can copy into
your e-mail. Availability of the menu depends on your license type of EasySIGN.

Setting up E-mail
S e t t i n g  u p  E - m a i l  

Take the following steps to setup the e-mail system of EasySIGN.

Step 1
Adjust the necessary settings. This has to be done only once. See the chapter “E-mail configuration”.

Step 2
Make a HTML-template in accordance with your company style. This has to be done only once.
See the chapter “E-mail HTML-templates”.

Step 3

Send the active worksheet as attachment
This option is only useful if the recipient is also a licensed user of EasySIGN. Otherwise, a customer to whom you
want to present a design, can’t do anything with an EasySIGN file as attachment in an e-mail. Use the second method
for presentation to the customer.

Select menu “File, Send to, E-mail address (as attachment)”

In case of an .EML compatible e-mail client
Your .EML compatible client will be opened with the current worksheet as attachment. If you’ve
chosen this option, a template will be used for the body of the e-mail.

In case of a direct SMTP connection
A dialog is opened in EasySIGN, where you have the opportunity to fill in e-mail settings like
“To”, “”CC” and “BCC”.  Here, you can still select a template for the e-mail body.
See "SMTP dialog" for the procedure.

If you don’t use a template with this method, you do not have to fill in the field “Additional body”, since this is only
used with templates.

Send the he active worksheet (or part of it) as a preview to your customer
Use this option if you want to send a preview for approval to your customer. Everyone with an e-mail client that can
cope with HTML e-mails (almost every modern e-mail client), will be shown the preview.

Select menu “File, Send to, E-mail address (preview in template)”. 

In case of an .EML compatible e-mail client
Your .EML compatible client is being opened with a preview of the current worksheet at the
location of the placeholder for previews (<<|InsertWorksheetImageHere|>>).

In case of a direct SMTP connection
A dialog is opened in EasySIGN, where you have the opportunity to fill in e-mail settings like
“To”, “”CC” and “BCC”.  Here, you can still select a template for the e-mail body. In the final e-
mail, the placeholder for previews will be replaced by a preview of the active worksheet.
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See "SMTP dialog" for the procedure.

SMTP dialog
Below you see the SMTP dialog and the separate components depicted.

E-mail priority "Low".

E-mail priority "Normal".

E-mail priority “High”.

Opens a preview of the e-mail in de Internet Explorer™.

Saves the e-mail on disk as .EML file.

Empties the field "Attachment(s)".

Opens the settings dialog.

1 Template:
Here you can select the template you wish to use.

2 Attachment(s):
Here you can select possible attachments.

3 Information:
Here you can fill in standard e-mail information. Pressing the buttons “To”, “CC” and “BCC”
opens the address book.

4 Additional body:
This field is only useful if you use the placeholder <<|InsertAdditionalBodyHere|>> in your
HTML-template. The placeholder gets substituted by this text.
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Transparency

Transparancy vector and bitmaps
T r a n s p a r a n c y  v e c t o r  a n d  b i t m a p s

EasySIGN has some very advanced and accurate functions to apply and manage transparency. Transparency can be
applied to all objects in a worksheet, including groups, effects, and the linestyle of objects. Several different methods
of transparency are available. 

1 Uniform transparency

2 Gradient transparency

3 Pattern transparency

4 Bitmap transparency using alpha channels

1 : Uniform transparency

This form of transparency can be applied to any object, the procedure is as follows:

Select the object (or objects) that you want to apply transparency to.

Next, select the transparency tool from the toolbox.

A floating dialog will pop up where transparency can be managed.

The default transparency is set to “None”, change this to "Uniform".
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On the worksheet the transparency of the object will change to the default of 50%. If you lower this value to 20% the
object will become less transparent. You can do this by entering the value 20, then press Enter.

If you change the transparency value to 80% the object will become almost invisible, 100% will make it completely
transparent.

Now click on the selection tool in the toolbox (or press “ESC”)… The transparency dialog will now disappear and the
object is selected again.

Now apply a line style to the transparent object.
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As you can see the line style is transparent too. We will now change the transparency properties. This method is
always the same, first select the transparent object, next click on the tool for transparency in the toolbox.

Change the transparency to 50% (1).

In the combo box (2), Select "Fill". Now only the fill style will be transparent.

In the combo box (2), Select "Pen". Now only the pen style will be transparent.
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You can remove the transparency from an object by selecting it, then click on the transparency tool and choose the
option “None” in the first combo box.

On the left you see a group of complex objects without transparency, on the right the same group with transparency.

Transparency can of course be applied to a combination of bitmap and vector objects.

2 : Gradient transparency

The workflow when applying a gradient transparency is similar to the uniform transparency, however it has some
extra features.

Select the object that you want to make transparent.
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Select the transparency tool from the toolbox and select from the options one of the gradient transparencies.
(Linear, Radial, Square or Conical).

Just as with the normal gradients you can drag handles to set the direction of the transparency. This can be done
directly on screen or by using the gradient dialog.

In the dialog for transparency the following options are available:

1 Selects different types of transparency.

2 Start transparency in percent

3 End transparency in percent

4 Where the transparency should be applied to, Fill, Pen, or Both.

5 Extra options. In the case of a transparent Fill the gradient dialog will be opened.
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On the left you see a group of complex objects without transparency, on the right the same group with transparency.

Transparency can of course be applied to a combination of bitmap and vector objects.

3 : Pattern transparency

A transparent pattern can be applied similarly to a uniform or gradient transparency.

At (1) select “pattern”

When the “pattern” option is activated, a black and white bitmap will be used as transparency pattern by default.
When a black and white bitmap is used, options (2) and (3) will be available in the dialog. This will set the density of
the black and white pixels. In the example a 50% transparency is used for the white pixels.
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Now click the button for the extra options to open the tile fill dialog and apply a different transparency pattern.

The chosen bitmap is grayscale, so the options (2) and (3) will no longer be available.

You can alter the options directly on screen or through the tile fill dialog.
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On the left you see a group of complex object without transparency, on the right the same group with transparency.

Transparency can of course be applied to a combination of bitmap and vector objects.

4 : Bitmap transparency with alpha channels

EasySIGN does not only support importing bitmaps with alpha channels, but you can also create alpha channels
yourself.  An alpha channel can be created from every imaginable object.

Import a bitmap first. This may be a bitmap without an alpha channel.
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Now create a simple blend between two rectangles of different width. This blend does not have to be on top of the
bitmap, it may be positioned anywhere on the worksheet.

Select the bitmap, and click the menu option "Bitmap”, “Transparency”, “Choose…". The mouse will change shape,
use it to select the blend.

1 Position

Unchanged
This option can be used if the objects for the alpha channel are already in their correct position
on the bitmap.

Fit
This option fits the selected objects for the alpha channel to the width and height of the bitmap.

A lign
This option aligns the objects selected for the alpha channel to the bitmap, using the selection
you make in the alignment palette.
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2 Preview

This will show you a preview of the end result, you can choose between “before” and “after”

3 Initial AlphaChannel color

This sets the behaviour of the alpha channel where no objects are covering it. You can choose
between black and white.

4 Combine

Inve rt
This will make all white objects black and black objects white, effectively inverting transparency.
It will also take gray values into account.

Replace
An unlimited amount of objects can be applied to the alpha channel, but if you activate this
option any alpha channels present will be replaced by the current selection.

Add
When an alpha channel is already present this option allows you to add the current selection to
it.

Subtract
When an alpha channel is already present this option allows you to subtract the current selection
from it.

Inte rsection
When an alpha channel is present the current selection will be intersected with it.

5 Various

Rem ove  chosen objects
Removes the active selection after applying it to the alpha channel.

anti-a liased
A recommended option, it will avoid any ‘staircasing’ effects in the alpha channel. If you only
use horizontal and vertical objects (like squares) this option can be deactivated.

Choose  anothe r object (1)..
When this is enabled another object can be selected for the alpha channel immediately after
clicking OK.

Apply  object(s) now
This option is available if you activate “Choose another object (1)..” It will apply the current
selection first before the new selection can be made.

For the alpha channel in our example we have chosen the following options:

1 Fir

2 White

3 Invert/replace

5 Anti-aliased

Now draw an ellipse, select the bitmap and choose the menu “Bitmap” “Transparency” “Choose…”

Select the following options:

1 Fit

2 White

3 Invert/Add

5 Antialiased
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In the menu "Bitmap, Transparency..." the following options are available:

Show
This sets the use of the alpha channel to on or off

Inve rt
This inverts the transparency.

Crop
This option reduces the size of the bitmap as much as possible, using the limits of the alpha
channel.

Choose
See the extended description above.

Detach
This option detaches the alpha channel from the bitmap..

These options can also be used through the context menu of the bitmap.

Transparency settings

If you want to print transparencies or export them to other applications please check the settings for doing this. Select
the menu “File” “Settings” and choose the tab “Output”. You will see the group box called “Transparency/pattern fill”
with the following options:

Calculate as: RG B  or CMYK
Sets the option whether transparency will be calculated as RGB or as CMYK. For the
most accurate results choose CMYK.

Resolution DPI
The optimal setting is 300 DPI, however on large worksheets like used for large
format printing a lower resolution of 72DPI will suffice, especially when the result will
be viewed from a distance, like a billboard.

Full
intersection
as bitmap

If you switch this on, transparency will be applied optimally. If this option is not used,
color differences may occur in complex worksheets where different transparent
objects overlap.

Antialiased This will give the best preview of transparency, the results will be anti-aliased. If you
do not use this option some ‘staircasing’ might result.

The transparency in EasySIGN is calculated at maximum accuracy to guarantee the highest possible quality when
exporting to other formats. There is a price for this in rendering speed when a worksheet has many transparent
objects. You can reduce the amount of time necessary by lowering for example the export resolution.

Compatibility

Compatibility Setup
C o m p a t i b i l i t y  S e t u p

The installation of “Compatibility” for each supported program is done during the EasySIGN Setup. During this Setup
you can choose for which program you want to install  “Compatibility”.
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After the installation

You can start “Compatibility” through “Start, Program files, Compatibility”, or directly from EasySIGN, through the
menu "File, Compatibility". 

Working with “Compatibility”
W o r k i n g  w i t h  “ C o m p a t i b i l i t y ”

Start “EasySIGN”, through the menu "File, Compatibility", the desired program.

An icon will appear In the system tray of Windows™ and the selected program (in this example, CorelDRAW™ 8) will
be started. When the desired program is not started or a message shows that the program could not be found, start
the program manually and then the "Compatibility".

Each icon for a supported software will have a different color. The icon is only visible when the selected program is
started.

When you click on the icon the following menu will appear.

1 Cancel
Closes the menu.

2 Close
Closes the program “Compatibility”.

3 Switch to EasySIGN.

4 Select language.

5 Sign Center (only in combination with CorelDRAW™) This part will be discussed later.

6 Export
Places the active worksheet (or bitmap) directly in EasySIGN.

Exceptions
When you are using Macromedia Freehand™ there will be no icon in the system tray. The link between EasySIGN and
this program is handled through the menu “Xtras, EasySIGN, Export”.

In every program there should be an extra menu visible. For example in Adobe Illustrator™ you have the possibility
to export only cuttable objects.

Vector software

If you use “Compatibility” with, for example, Illustrator™ or CorelDRAW™ a copy of the active worksheet will be
optimized before exporting it to EasySIGN.

Bitmap software

If you use “Compatibility” with for example Photoshop™ or Corel PhotoPAINT ™ a copy of the active bitmap will be
optimized before exporting it to EasySIGN.

Settings in CorelDRAW™
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If you have installed CorelDRAW™, and have never used the export function to the Adobe Illustrator (.AI) format
before,  you have to do this one time manually to initialize the CorelDRAW™ export filters. The location where you
export to or what is on the worksheet is of no importance. You only have to do this  once.

General limitations

Never use more than one instance of a supported program at the same time. So if you have for example two
instances of CorelDRAW™ 10 open, there is no guarantee that “Compatibility” will work.

Limitation for Adobe™ products

You can not have two different versions of the same product running simultaneously. You can not, for example, have
Illustrator™ 9 and Illustrator™ 10 running at the same time when using “Compatibility” for these products.

Engraving/Routing

General
G e n e r a l

The EasySIGN routing module is a product which contains all 2.5D working methods. With plotting there is only 2
dimensional information, where as with 2.5D the depth is added. 2.5D is a very broad understanding, it can be used
for engraving, routing or even a special application. So what are all these terms exactly?

Engraving
The cutting of text and logo’s from a material. Mostly these cuts are not very deep and surely not through the
material. Many engraving materials have a top layer of a different color which after cutting will show the layer below.
Some examples are nametags and type tags.

Routing
With routing you will cut trough the material. Also the partial removing of a material is routing.

When we have a curve object, this object will have enough information to be used as a plot object. For engraving we
will need more information. This extra information is called a “Production style”. You can link this production style to
any vector object. Within this production style is contained, the fill style, the depth the speed etc. For routing, extra
information is necessary too, do you want to route the inside, the outside, the speed etc. This information is contained
in the production style too. 

Apply a production style
A production style can be assigned to an object in two different ways, manually and trough a Wizard.

Manual production style
Select a vector object (this can also be a text object) and select the production style icon.

The following fly-out will become visible.

Select the first option(1).
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1 Passes
Every production style consist of one or more passes. In many cases just one pass is enough, but with very
thick materials more passes are needed. The different passes are shown in (1). After selecting one of these
passes the rest of the dialog will show the settings for the selected item.

2 Pass type

A Pass type
This will determine the type of pass. Every type has a specific purpose, with these settings you
determine what will be done with the shape. 

Line
A line pass will follow the original object's outlines.

Ma le
This pass will run on the outside of a shape, the actual drawn shape will be the result.

Fem a le
This pass will run on the inside of a shape, the actual shape will be removed from the material.
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S  Fill
The pass will remove the inside of a shape and will follow an “S” shape path trough the
material. The shape will only be removed from the material to a certain depth.

Line  fill
A shape will be filled with a set of straight lines, suited for laser and other ways where heat
could cause a problem.

Line  fill, sorted
Same as “Line fill”, but now the tool will choose the shortest path to follow.

Is land fill
The complete interior of a shape will be removed via a path which runs in concentric circles
from the outside to the center of the shape. 

B Angle
The angle of the fill lines.

C Fill overlap
The size of the overlap in which sequential lines cover each other.

D Margin
The distance from the outside of a fill to the inside of a shape.

3 Tool

A Too l
A tool from the library which is used to make this pass.

B Depth, speed and m otor speed
These settings are normally done in the device settings. Here these general settings can be
overwritten per shape. Use this only when a shape derives form the default settings.

4 Lead in
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Lead in
When a shape is being routed it is sometimes not desirable to decent a tool exactly on the
corner of a shape. This could cause small dents in the result. “Lead in” prevents this by starting
the pass on a safe place within or outside the shape and then move towards the beginning. 

This option can also be used with soft materials. By setting the “Lead in” to “Where possible”
you prevent dents on the spots where the tool slows down. 

Production style trough the Wizard
The tool path Wizard is an aid to apply a complicated tool pad. A number of frequently used possibilities with tool
paths are implemented in this Wizard. This Wizard can be started trough the toolbar or from within the dialog for the
tool path options.
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The Wizard will ask you what you want to do, this is accompanied by explaining illustrations. Answer these questions
and press “Next” until you reach the button with “Apply”. When you started the Wizard from the toolbar the tool path
will be applied to the selected object. When you started the Wizard from the dialog for the tool path options the tool
path will be added tot the list in this dialog.

Tool library
Trough this dialog you can define your own tools. Select the menu ‘File, Tool library”.
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1 Tool library
 Here you will find all the tools present. If you select one of them you can change it’s settings under “Tool

properties” (2).

2 Tool properties

A Width at the end of the shaft of the tool. When the shaft has the same width over the complete
length this option is disabled.

B Width at the point of the tool.

C Maximum depth the tool can descent into the material.

D The angle of the tool point.

E Here you can assign a color to the tool. The color of the tool will be shown in the worksheet to
distinguish between the different tools.

3 Here you can add or delete a tool from the library. 
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Add an Engraver/Router
A d d  a n  E n g r a v e r / R o u t e r

To add an Engraver/Router select the menu 'File > Device Setup > 'Add Router Wizard...'.

Select from the dropdown for drivers (1) the desired device. Click 'Next'.

Select from the dropdown for Ports (1) the Port your device has been connected to. Click 'Next'.
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How this page will look depends on the selected Port from the previous page. On this page make your settings
according the manual supplied with your device.

To finish the installation of your device, click 'Finish'.
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Device setup
D e v i c e  s e t u p

Select the menu 'File > Device Setup > Open...'. The following Window will become visible.

On the left open the folder 'Router/Engraver Settings' and click on 'Router/Engraver Setting 0'. On the right the
available Router/Engraver settings will become visible.

4 icons appear, double clicking an icon will open a settings dialog.

A Sorting and optimization

1 No sorting
 The design will be engraved/routed in the order in which they where drawn.
2 Speed
 The order of the objects will be adjusted for optimal speed.
3 Vinyl transport
 The order of the objects will be adjusted for minimal movement in the material direction.

B Default parameters
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1 Hover height
 The height above the material with movements of a tool.
2 Sink rate
 Speed with which the tool descents in the material.
3 Tool-up speed
 Speed when the tool is up (not in the material).
4 Acceleration
 Maximum acceleration of the tool, this is important with corners.

C Per object default parameters

These settings become active when tool paths do not have a setting of their own in the tool path options dialog. When
you set the option “Use default settings” to false.

1 Depth
 Depth of the tool.
2 Speed
 Engraving/Routing speed.
3 Tool motor
 Revolutions per minute of the tool.

D Tool assignments
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You can set the number and position of a tool, if your machine is equipped with a tool changer. The software will
select the correct tool during a job.

Display settings
D i s p l a y  s e t t i n g s

Specially for engraving and routing, two new display qualities are added.

“View, Quality, Toolpath”, this setting shows the tool path and the rotation direction.
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“View, Quality, Solid toolpath” , this setting shows the tool path and the width of the tool. Here you can check if the
tool and fill types are the ones you need for the job.

EasySIGN Print Server

EasySIGN Print Server, before you start
E a s y S I G N  P r i n t  S e r v e r ,  b e f o r e  y o u  s t a r t

Before you can start printing with the EasySIGN Print Server, either as stand-alone or as a supplement to EasySIGN,
you have to make some settings. In the following chapters we will explain what each setting does. Before you read
the following chapters, please work through the "Getting Started". As a prerequisite, you have to finish all the steps
that are explained in that manual. The "Getting Started" teaches you the basics of the EasySIGN Print Server. Also all
the necessary license tickets must have been entered, which is also explained in the "Getting Started".

We really can't emphasize enough that you have to finish the "Getting Started" to be able to understand the following
chapters. The EasySIGN Print Server is very easy to use, but you will have to gain some basic understanding first.

Note
If you've downloaded this software as a TryBuy, you can also download the "Getting Started" as a PDF file from the
download menu of http://www.easysign.com.

First use and Main screen
When you start the EasySIGN Print Server for the first time, the main screen will become visible, it will look
something like below. It might happen that you get a Wizard that asks you for a ticket. If so, please refer to the
“Getting Started” that came with the software. 
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Also, if you do not have a printer installed yet, a Wizard will come up to guide you through the procedure of installing
it. This wizard is described in the getting started and this manual assumes you have already installed a printer.

The components of this main screen are as follows. A more detailed explanation of each window will follow in the next
chapter.

Current jobs (A)
In this window all jobs will be placed that have been added, either by using a Hotfolder or by adding it manually. The
list will show a small preview for every job, as well as its name and some extra information. From this list, jobs can
be edited as well as dragged and positioned onto the prints.

Archived Jobs (B)
Once a job has been printed, it will be moved automatically to the archived jobs. This list behaves similarly to the
‘current jobs’ list, so you can place jobs, edited them and remove them. Only the name of the list, ‘Archived jobs’
signifies that the jobs have been printed already.

Installed Devices (C)
In this list, all installed printers will be shown, and you can edit every detail. A printer that is busy will shown a red
line through it, which means that the device cannot be edited at that moment.

Hotfolders (D)
A Hotfolder is a directory that is monitored by the software for files to be printed. By moving a file directly into this
directory, a new job will be created along with some default settings.

Logbook (E)
In the logbook, all significant events that occur in the print server will be shown, like starting and finishing a print, and
any error messages that might occur. The logbook has the option of being e-mailed to any mail account, enabling you
to monitor the progress from a remote location.

Print preview (F)
The most important part of the print server is the print preview which occupies the middle of the screen by default.
This preview shows an empty roll of material, ready for placement of jobs.

Print Properties (G)
This is where most of the interaction with the print server takes place. Here you will set the width and height of the
material, the stacking, start the print etc.
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User interface
U s e r  i n t e r f a c e

The user interface and placement of any window is customisable. Any window can be docked almost anywhere,
simply by clicking on its name, and dragging it to the desired position. By double-clicking on a docked window, it will
be floated above other windows. To dock a floating window, simply drag its title bar to another position. The window
placement will be shown by a blue, semitransparent box, and if it is to your liking, just release the mouse button to
dock the window.

Any Window can have the following situation: 

Floating The window is positioned over other windows, obscuring the underlying interface.
Double click the title of any window to float it.

Docked The window is positioned next to other windows. Drag any window by its title bar to
position it, a blue transparent box will show where it will be docked.

Auto Hide The window will be shown by a tab with its name on the left side of the main
window. By hovering the mouse over this tab, the window will be shown. To use this
feature, click the pin symbol in the title bar.

Hide A window can be closed by clicking the cross in its title bar. To re-enable it, use the
main menu "View > Toolbars" to re-check the menu item.
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It is also possible to change the entire look and feel of the windows in the print server. To do this, use the main menu
command "View > Icon style" and "View > Application look".

And if this does not provide you with enough customization options, you can now also customize the main menu and
toolbars. To do this, right-click the area to the right of the menu, and choose ‘Customize...’ The following dialog will
appear:

Through the tabs in this menu you can customize all menus and toolbars, or even create new ones to your liking. This
manual will not describe every option in detail, feel free to experiment until the interface is to your liking. Most tabs
have a ‘reset all’ button that will restore the original situation.

Working with jobs
W o r k i n g  w i t h  j o b s

The first thing to do when printing something is to add jobs. A job is a single file, like a PDF, JPEG or TIFF file. It has
many properties, which we will discuss in this chapter.

Adding a job
A job can be added in three different ways: by dragging it onto the job list, through the menu item "File > Add job", or
through a hot folder. Hotfolders will be discussed later on, in a separate chapter. 

To drag a file from the Windows explorer to the print server, simply drag and drop it onto the ‘job list’ or ‘Archived job
list’, like shown here:
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Or, click the main menu and go to "File > Add Job". Then, browse to the file you want to print and click it.

After a file has been added, a job will appear for it in the job list. The print server will then start to create a preview
for it, and collect some information like the size of the job and the number of pages.  It might be that the job does not
display a preview right away, as this process takes some time on larger jobs. During previewing, the job cannot be
edited, so please be patient.

After a while, the job will show ‘ready for printing’, and it will then be editable. To edit the job double-click it, or click
the edit icon.

which will show the following dialog:
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Options

A Nr of copies
How many times the current job should be repeated on the print.

B Print extra info
Select yes if you want extra info on the final print. This prints the setting, device, etc. at the bottom of
the print.

C Print cropmarks
Selecting Yes enables cropmarks on the final print.

D Cropmark type
Choose form ‘cropmarks’, ‘cropmarks and swatch bar’, or ‘Rulers’. If you are using paneling, you
should select ‘Rulers’, which will help you align the panels.

E Cropmark size
The size, around the print, of the printed cropmarks.
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Size  -  R o ta tion

A Width
The width of the current job in units. To change, type a number or use the spin buttons.

B Height
The height of the job in the currently active units.

C Width scale
The current width as a percentage of the original file size.

D Height scale
The current height as a percentage of the original file size.

E Scale proportionally
When ticked, the width and height of the job change proportionally.

F Rotation
Select the desired rotation in 90 degree steps from the combo box.

E Cropmark size
The size, around the print, of the printed cropmarks.
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Pa ne ling

A Paneling type
You can choose between ‘None’ and ‘User defined’, User defined switches the paneling to on.

B Number of panels
By changing this number, the job will automatically be divided in the specified number of panels.

C Carriage Panel size
Vertical panel line(s) in the preview. Type the positions where you want the panel lines to appear, for
example ‘50 100 150’.

D Carriage panel overlap
The overlap of the panels, these can also be negative. You can enter one value, which sets the overlap
for all panels, or multiple values if you want different overlaps. If you enter nothing or ‘0’ there will be
no overlap.

E Roll Panel Size
The position(s) of the panel lines in the roll direction.

F Roll panel overlap
The overlap of the panels in the roll direction.

G Active panels
If empty all the panels will be printed. When you enter one or more panel numbers separate by e white
space only these panels will be printed.

H Paneling In the preview window
You can manually add or remove panels by pressing the right mouse button in the preview window and
selecting a horizontal or vertical panel line from the menu. A double click will add a carriage panel line,
if you hold down the SHIFT key before double clicking, a roll panel will be added.

E Cropmark size
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The size, around the print, of the printed cropmarks.

Co lo r  co rre ction
All the different color corrections will be applied on top of the color management. As with all settings, you can see the
result in the preview window. This might take a few seconds, especially when the job file is large.

A Brightness
The brightness of the job, ranges from -100 to +100.

B Contrast
The contrast of the job, ranges from -100 to +100.

C Saturation
The saturation of the job, ranges from -100 (no color at all) to +100 (very bright color).

D Hue
The hue (color shift) of the job, ranges from -180 to +180.

E Color temperature
The temperature (‘warmth’) of the job, ranges from -4000K (very warm) to +4000K (very cold).

F Grayscale
Tick this box if you want the entire job to output in grayscale.

E Cropmark size
The size, around the print, of the printed cropmarks.
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Input ICC pro file
The following settings are color management related, and this manual is not intended as a complete guide. For a more
complete explanation of color management, see also the document “Calibration training”.

A CMYK bitmap input profile
A combo box from which you can select the desired input profile for CMYK bitmaps. All profiles on your
system, including the profiles from the EasySIGN "Shared" directory, are listed here.

B RGB bitmap input profile
A combo box from which you can select the desired input profile for RGB bitmaps.

C Grayscale bitmap input profile
A combo box from which you can select the desired input profile for Grayscale bitmaps.

D Bitmap render intent
The render intent for bitmaps. You can choose from the following:

Pe rce ptua l
All colors in a device’s gamut will be scaled to the output gamut, keeping the relation between the
colors intact. This method is recommended for reproducing scanned or imported bitmaps.

R e la tiv e  co lo r im e tr ic
This method will leave colors that fit into both gamut’s intact. Colors outside of the gamut of the output
device will be adjusted to fit, preserving brightness and color at the expense of saturation. This method
is preferred if accurate color representation is necessary, for example when printing spot colors.

Sa tura tion
Scales the source gamut to the destination gamut but preserves relative saturation instead of hue, so
when scaling to a smaller gamut, hues may shift. This rendering intent is primarily designed for
business graphics, where bright saturated colors are more important than the exact relationship
between colors.
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Abso lute  co lo r im e tr ic
Absolute colorimetric rendering reproduces in-gamut colors exactly, and clips out-of-gamut colors to
the nearest reproducible hue, sacrificing saturation and possibly lightness. This method also takes the
color of the paper into account when printing.

E Color manage CMYK bitmaps
Whether or not CMYK bitmaps should be color managed.

F Use embedded profiles when available
Whether or not you want to use the profile that was included in the source file for a job.

G CMYK vector input profile
A combo box from which you can select the desired input profile for CMYK vector data.

H RGB vector input profile
A combo box from which you can select the desired input profile for RGB vector data.

I Grayscale vector input profile
A combo box from which you can select the desired input profile for Grayscale vector data.

J Vector render intent
The render intent for vector data, see the description under "Bitmap render intent" for
the available types.

K Color manage CMYK vector
Whether or not CMYK vector data should be color managed.

L Suppress dirty Cyan
If enabled, dirty cyan is suppressed. use this if you want cyan to be printed as cyan, even after color
managing.

M Suppress dirty Magenta
If enabled, dirty magenta is suppressed.

N Suppress dirty Yellow
If enabled, dirty yellow is suppressed.

Working with Hotfolders
W o r k i n g  w i t h  H o t f o l d e r s

First of all what is a Hotfolders? A Hotfolder is a directory on your hard disk or network that represents a set of default
settings. By copying a job into a Hotfolder, the new job will be set up the same way as the Hotfolder, and then it will
be added to the job list, ready for printing. So if want to set up a way to print something that is always mirrored, or at
200% by default, a Hotfolder would be the way to do it.

Also, if you want to print something directly from the EasySIGN design software to the Print Server, a Hotfolder is
necessary to store the exported print job.

Adding a Hotfolder
To add a Hotfolder, first you have to find the window labeled Hotfolders. If it is not visible, just go to "View >
Toolbars" and make sure that ‘Hotfolders’ is ticked.

The Hotfolders window has the usual three-button icons, to add, remove and edit the Hotfolders that have been set.



361EasySIGN

By clicking the ‘add’ button, a wizard will come up that guides you through the
process of installing a new Hotfolder.

Step 1. Choosing a device and a setting
Any Hotfolder will mark the incoming files with a device and setting, meaning that the jobs are intended to be printed
on the selected device and setting.

Please be aware that a Hotfolder is just a set of defaults. Any job that comes in through the Hotfolder, gets the same
setting but everything can be changed of course before committing to printing.

Check that you have chosen the correct printer and setting, and click ‘Next’ to continue. In the next page of this
Wizard, there is one important setting, the ‘Root directory’. You should choose one root directory and place all hot
folders in it. The root directory can then be shared over the network, for other computers to use.
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There are some extra settings to be made in this dialog:

A Input file processing
When you place a file in a Hotfolder it will be processed. When processing is done, you can choose
whether to remove the file or move it to a subdirectory called ‘Processed’ or ‘Error’.

B Job Processing
When a job has been printed, you can choose whether you want to keep it in the Archive. The following
choices exist:

R e m ov e
When the job has been printed, it will be removed immediately.

Archiv e  a s  spa ce  a llows
The job will be put in the archive, but it will be removed automatically if the software runs out of disk
space.

Archiv e  inde fin ite ly
The job is kept in the archive until removed by the user.

When you click ‘Finish’, your Hotfolder will be added and it will shown in the list.

Setting up Hotfolders
Every hot folder can have its own default settings, making it very easy to create Hotfolders, not only for every type of
material, but even for customer based hot folders. 
Make the default settings once, give it an appropriate name, very handy for returning jobs. Remember that these
settings are only defaults: an incoming job can always be changed before printing it. 

Editing the settings of a Hotfolder can be done in the following way: select the
Hotfolder itself, then click the ‘edit’ icon in the top of the toolbar.

The following dialog will appear:
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On the left side of the dialog are three icons that activate the following three tabs:

Hotfolder properties

A Name
The name and directory of this Hotfolder. You should change the name in something meaningfull.

B Folder
The actual directory that gets monitored for new files coming in. You can change this directory by
clicking the ‘Browse’ button on the right.

C Folder is active
Activates or de-activates the Hotfolder.

D After rendering
For some files, the RIP will render them, after which the original file will no longer be necessary, and
can be removed. Use ‘remove’ if you copy original files into the Hotfolder. Use ‘Move to processed’ if
you want to keep the original files for some reason. The file will then be moved to the ‘Processed’
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directory which is created in the Hotfolder directory.

E If an error occurs
Same as above, except the input file will be moved to the ‘error’ directory or deleted if it generates an
error while rendering.

F Job processing
When a job has been printed, it will be automatically moved to the job archive, where it will stay.

G Output settings
The default printer and setting that this job is meant to be printed with.

H Nr of copies
Number of times the job will be placed when dragged onto a print.

Sizing and paneling
This page gives you the opportunity to set up an incoming job for the correct size and paneling options. These settings
are similar in their function to the settings on an individual job, so please refer to the previous chapter on working
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with jobs for a more elaborate description.

Input profiles and color management
Again, these settings are the default settings for color management on the jobs that come in on this Hotfolder. As they
are similar to the settings on an individual job, please refer to the previous chapter on jobs for a detailed description
on how they work.

After pressing "OK" the Hotfolders tab will look like below:
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Working with prints
W o r k i n g  w i t h  p r i n t s

This is where it all comes together: a print is the centre where you place the individual jobs, arrange them, and send
them to your printer. The prints are shown like below:

A Print view
This view shows the print as it is going to come out of your printer: a long roll of material, which is
empty for now. To place jobs, you can simply drag them from the job list onto the print. If the job has
paneling activated, this will automatically show when dragging the job.

The print view has a number of drag able items itself:

Ma te r ia l s ize (B)
By dragging the small arrow on the lower right of the print view, the material size can be adjusted.

Ma rg ins (C)
The front end of the material, as well as the left and right side, can be dragged to set a margin. This
margin will be used when automatically placing items with the ‘stacking method’ option enabled.

Viewing around the print view can be done with the scrollbars around it, or by using the toolbar above it. The function
of the individual buttons are: 
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Wireframe
Shows placed jobs as a wireframe, with information as text.

Filled
Shows the jobs as a color preview.

Zoom sheet
Shows the entire length of the print, including empty space.

Zoom front
Shows the first side of the print, zoomed to maximum width.

Zoom jobs
Shows everything (every job) that has been placed on the print.

Select mode
Click this button to be able to select and move jobs.

Zoom in
Click this button, then drag across the print view to zoom to a specific area.

Zoom out
This button instantly zooms the view out by a predetermined amount.

Drag view
Activate this button, then click and drag to move the print view.

There can be an unlimited amount of individual prints at the same time, which enables you to work on a new print
while a previous one is processing. To do this, look at the top of the print where you will find a tab bar with the name
of your current print.

After adding a new print, just click back and forth between them to bring them to the front. The X in  prints name lets
you close and delete them, of course this will only work if the print is not being processed just yet.

When you create more than a few prints, they cannot be displayed all at the same time. In that case, a small arrow
on the right shows a menu of all available prints.

Print properties bar
On the right side of the print view you will find a large toolbar which enables you to control the active print. It has the
following options:
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A Device
The specific printer that this print will appear on.

B Setting
The setting you want to use for this device.

C Device mode
There are five different device modes available, hover the mouse over the icons to see a description:

Pr int

This is the default, it only prints even if cutline's are available.

Pr int a nd  cut

Immediately after printing, the job is also cut. Only available on Print & Cut hybrid machines.

Pr int & cut  p r int only
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This will print a job with cropmarks, ready to be re-inserted on cut. Available on Print & Cut hybrid
machines only, and used in case you would want to laminate a Print & Cut job before cutting it.

Pr int & cut  cut only

This will cut a print & cut job on a hybrid machine.

Cut only

This cuts a job on a hybrid print & cut machine without printing anything.

Be aware that the Print & Cut modes are only used on hybrid machines, meaning printers with an
integrated cutter. Please refer to the manual that can with the printer for the correct workflow.

Print & Cut workflows that use a separate cutter and printer can of course also be processed, however
the print server treats these as a normal print job (with crop marks of course) and they would be
printed in the default ‘print’ mode.

D Roll width/length
The size of the material in the printer. This size can also be changed by dragging the small black arrow
on the lower right of the print view.

E Stacking method
When placing jobs, it is possible to align the jobs automatically, a process called ‘nesting’. There are
three options available:

Sim ple

All jobs will be placed after each other, no other optimization Is performed.

Jobs  toge the r

Multiple copies of a job will be nested, but they will not be mixed with other jobs.

Sa v e  m a te r ia l

An optimal placement of jobs will be made, mixing copies of jobs and panels if necessary.

The selected stacking method will be shown by these buttons. However, when you move a job
manually, the stacking switches off and no automatic placement will be performed, until you click one
of these buttons again.

F Alignment

All stacking methods can have a left, middle or right alignment.  Click one of these buttons to choose,
the default is right-alignment.

G Margin
The distance between stacked jobs.

H Confidence strip
A strip can be enabled on the left and/or right side of the print. Enabling this ‘exercises’ the print heads,
which might help to keep open all inks in a print head. Width can be adjusted.

I Margins
A left, right and front margin can be entered here, this enables you to keep some extra material
around the print itself. This can be handy when doing Print & Cut for example.

J Number of copies
The number of times this print will be printed.

Print buttons
There are several ways of starting a print, you can choose to start printing right away, or to be a bit more careful and
render a print first. The buttons have the following functions:
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K Print now
Starts rendering, and as soon as a small portion of the render is ready the print will start. This can be
used when you have a fast computer and you know for sure that the computer can keep up with the
printer.

L RIP, then print
This renders the print data first, and when everything is ready the print will automatically be started.
Can be used on slower computers to make sure the printer will never need to wait.

M RIP only
Renders all data, but w ill not print until ‘Print now ’ is clicked.

N Triggers
It is possible to start any print that you have set up at a specific time. When you click the ‘Triggers’
button a new dialog appears:

Sta rt a t a  spe cific da te  a nd  tim e  (A)
This enables you to start the current print when you are away, for example when you want to print
during the night.
 
Sta rt whe n le ngth m ore  tha n (B)
This starts a print when there are enough jobs available.

Sta rt whe n e fficie ncy  m ore  tha n (C)
This starts the job when the stacking has produced a print with high enough accuracy.

Archive

Archive
A r c h i v e

Archive is a utility program designed specially for EasySIGN. This program helps you to manage your EasySIGN
worksheets and your customer database. In EasySIGN you can save worksheets per client. In Archive you can open,
import, manage and process customer data etc.

First version
If you have never had a version of Archive on your system before a "wizard" will appear to help you initialize the
program.
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In the initial dialog of the "wizard" the steps to follow are explained. You must decide in which mode you are going to
run Archive; this depends on whether you work on a network. You must also specify the location you want Archive to
save the worksheets in which you have made in EasySIGN. You can always call up this "wizard" once you have
initialized the program. If you do this and you already have an Archive directory and EasySIGN worksheets, it is
advisable to make a backup of these before you continue with the "wizard". If all is clear you can click on the "Next"
button (2) to continue.

In the next screen of the "wizard" you can choose the "modes" you would like to work in.

4 "Standalone"
 Use this mode if you do not work in a network or if you do not use a network, but if the program is being used



372 EasySIGN

on one computer only.
5 "PTP-Server"
 In this case your computer is a Server and also a workstation.
6 "DS-Setup"
 If you are going to use a "fileserver".
7 "Client"
 If you already use a "fileserver".

 

The different modes
T h e  d i f f e r e n t  m o d e s

Standalone
If you have chosen this option in the "wizard", after a click on the "Next" button the next window will appear.

4 In this field the path to the standard directory of Archive will be displayed. It is recommended to use this path.
If you want to specify a different path you can do so by typing in the name of the path or by finding a different
location with the "browse" button (5).

PTP-Server
Choose this option if your network does not contain a "dedicated file server". One of the computers in the network is
behaving as a server.
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4 In this field you must type in the path to the directory of Archive or find a location by using the browse (5)
button.

6 If the Archive directory is on drive C, you must specify here how drive C is shared over the network.

S Server/workstation
 On this computer the PTP-Setup is carried out. This will contain the shared "Archive" folder for the other

workstations (C) and a working version of Archive.

C Workstation 
W On the workstations the "Client setup" of Archive is executed and the shared folder (A) on the server (S) is

used as a source. 

DS-Setup
You use this option if your network contains a "dedicated file server", such as e.g. an NT server. The worksheets are
saved centrally on this server.
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4 In this field you must type in the path to the Archive directory or find the location by using the browse button
(5).

S Server
C Workstation
W On one of the workstations the "DS-Setup" is executed and the server (S) is specified as the source for the

"Archive" folder (A). This computer has also become a "client". On the other workstations a "Client setup" of
Archive is executed and the shared folder (A) on the server (S) is used as a source. 

Client setup
This option will make use of a drive that already contains the folders and assumes that the option "DS-Setup" or "PTP-
Setup" has already been executed once on a different computer.
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4 In this field you must type in the path to the Archive directory or find the location using the browse button (5).

After completing the necessary settings you must click on the "Finish" button (2).

The work environment
T h e  w o r k  e n v i r o n m e n t

Once you have opened Archive the screen will display the following. If during the setup of EasySIGN you have chosen
to install the examples, these have been placed in Archive under a customer used as an example.
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1 The menu
 All parts of the menu are discussed in detail further on.
2 The toolbar
 Here you will find the most frequently used menu commands directly accessible through a button.
3 Overview window
 Here you will find all customers, represented in a tree structure.
4 Information window
 Here you can enter customer data or view the customer’s worksheets.
5 Status bar

 

The menu
T h e  m e n u

Customer

You will find this same menu as a right mouse button menu in each part of the tree structure.

New (CTRL+N)
Depending on what you selected in the tree structure, a new customer will be placed on a certain level. If you have
selected the "root" e.g., you can create a group called "Football clubs". If you then select the new folder "Football
clubs" and you click again on "New" the new customer/folder will be added under "Football clubs". This way you can
categorize all your customers per type of work.

Delete (DEL)
This command deletes a selected folder. If however there are still worksheets in this customer’s folder, then you can
only delete the customer after you have deleted the worksheets.

Edit/Read only
When you select the submenu "Edit", you can modify customer data. The moment you modify customer data the
database is locked to other users. This is to ensure that two people cannot edit customer data at the same time. A
different user can still open the worksheets, only he cannot modify the customer data. In order to unlock the record
again you must select the submenu "Read only". If no action has taken place after five minutes the database is
automatically unlocked and can be used by other users.
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Search
This command opens a dialog enabling you to search for an existing customer.

1 Search for
 Here you can enter the search criteria.
2 Look in
 Here you can specify which fields will be searched.
3 Search result
 Here the results of the search will be displayed. When you double click on one of the parts of this list, the file

will become an active file.
4 Search
 This initiates the search.
5 Close

Close
This command closes the program.

Edit

Undo
When you are in modifying mode, the currently edited record is completely recovered.

Delete
This command deletes the selected worksheets.

Select all
This command selects all worksheets of the customer that have been opened.

Invert selection
This command reverses a selection already made.

Rename.
This command enables you to change the name of a selected customer in the tree structure.

View

Toolbar
Shows or hides the toolbar.

Status bar
Shows or hides the status bar.

Customer data
Activates the customer data in the information field.
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Large icons
Displays the available worksheets in the information window as large icons with the relevant file name.

Small icons
All worksheets are displayed with a small icon.

List
The worksheets are displayed as a list.

Details
Extra information is displayed about the worksheets such as the date the worksheet was last modified.

Previews
All worksheets are displayed with an illustration of the worksheet.

Refresh (F5)
This command refreshes the window.

Tools

Mode Wizard
This command opens the mode wizard as described earlier in the section "First version".

Backup
This menu item gives you backup advice.

Help
In this menu you will find everything about help and the digital manual.

Information window
I n f o r m a t i o n  w i n d o w

In this window you will find all worksheets that belong to a particular customer. From here you can manage the
worksheets.
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You can select several worksheets at the same time by using the control key to delete these worksheets e.g. or to
import them into EasySIGN. If you have selected a worksheet, you can click on it once with the right mouse button in
order to call up the right mouse button menu of the worksheet.

In this popup menu you will find the following commands.

1 Open
 This command will open the selected worksheet in EasySIGN. If EasySIGN is not open, it will be opened

automatically. This function can also be activated by double clicking on the worksheet.
2 Import
 This command imports the worksheet in the active worksheet in EasySIGN.

3 Delete
 This command deletes the selected worksheets. If you have accidentally deleted the wrong worksheet you can

use the Recycle bin from Windows™ to recover the file.

If Archive cannot find the EasySIGN program a message will be displayed with the question for you to specify the
location of the program. If you choose "Yes", a dialog will appear enabling you to find the program.

Move all files

If you want to move the archive to a different drive, then close Archive 32 and move the complete directory "Archive"
to the new location. Restart Archive and you will be asked to specify the database again. Specify the new location and
all references will be automatically adjusted.

Drag & Drop

From Archive you can drag a file to Explorer and vice versa. You can also drag a file directly from Archive to
EasySIGN; when you let go of this file it will be either opened or imported.
In Archive you can copy files from one customer to another by dragging them, if you use the shift key while dragging
you can move the file (or files).
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Archive via EasySIGN
A r c h i v e  v i a  E a s y S I G N

You can archive your worksheets through the "File" menu of EasySIGN. There are three ways to do this.

1 Archive
 When you have opened a worksheet this command will save any modifications.
2 Archive as...
 This command opens a dialog and asks if you want to save an archive or a new worksheet under a different

name or under a different customer.
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In the list under (1) you can see the customers in Archive and under (2) you will find some information on a selected
customer. In field (3) you can specify the name for the worksheet and then click on OK. The worksheet will be saved
in the selected customer folder. 

Recent customers
R e c e n t  c u s t o m e r s

A list containing the last ten customers has been added to the “File” menu. If you manage a large number of
customers with the help of Archive, this is a very handy way to avoid having to search for current active customers
by wading through the records or constantly using the search command.

Back-up advice
B a c k - u p  a d v i c e

Backing up itself is not usually the problem, however, knowing what and when to backup often is. Archive offers a
way to determine when a backup is needed for your EasySIGN, Archive files. These are usually all the key EasySIGN
and Archive files that normally wouldn’t be replaced following re-installation, such as manually added executables,
worksheets, personal color tables, etc.

You can access the dialog for this operation via the “Help, Backup advice” menu.
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1 Files to be backed-up
 This provides a list of all the files to be backed-up.
2 Show folders only
 When you activate this option only the folders containing the files to be backed-up will be visible.
3 Print
 This button opens a text file with all the files from the dialog.
4 Close
 This closes the dialog.

Worksheet search
W o r k s h e e t  s e a r c h

This command starts a search on all your hard drives and network connections for EasySIGN worksheets. The
selection you make from the search result can be added as a new customer. You can start this search via the “Extra,
Worksheet search” menu, after which a search progress dialog opens.

You can use the “Cancel” button to abort the search. When all drives and network connections have been searched
another dialog is opened showing all the folders containing EasySIGN worksheets (old and new ones).
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In this dialog you can make a selection and add these selections as new customers to the Archive database.

Moving customers
M o v i n g  c u s t o m e r s

The left field of Archive allows you to move customers to a different location in the database. The location off your
worksheets and folders on your hard drive remains the same after moving a customer. It is not possible to copy
customers to a different location.
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Previews
P r e v i e w s

If you want Archive to not only show you the standard worksheets but also worksheets that can be previewed in
Windows™ Explorer, you can activate the menu  "View, Show all previews".

Disclaimers

Disclaimers
D i s c l a i m e r s

Copyright ©2012 NCD Holding b.v. All rights reserved.

No part of this document may be reproduced or transmitted in any form or by any means, printing, microfilm,
recording, electronic, or otherwise, or stored in a retrieval system or any other medium, without the prior written
permission of NCD Holding b.v.

The software described in this publication is protected under license and may be copied or used only in accordance
with the general conditions of NCD Holding b.v.

Provisions and Warranties

The information contained in this publication is meant for informative use only and is subject to change without any
prior notice. This shall not be construed as an obligation on the part of NCD Holding b.v.

THIS PUBLICATION IS MEANT FOR INFORMATIVE USE WITHOUT ANY WARRANTIES, EXPRESS OR IMPLIED,
INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE.

NCD HOLDING B.V. DOES NOT ACCEPT ANY RESPONSIBILITY OR LIABILITY FOR MISTAKES OR STATEMENTS IN
THIS PUBLICATION, OR IN OTHER DOCUMENTS THIS PUBLICATION  REFERS TO.

REFERENCES TO COMPANIES, THEIR SERVICES AND PRODUCTS ARE MADE WITHOUT ANY WARRANTY, EXPRESS OR
IMPLIED. IN NO EVENT WILL NUMERICAL NCD HOLDING B.V. BE LIABLE FOR ANY SPECIAL, CONSEQUENTIAL,
INCIDENTAL OR INDIRECT DAMAGES, INCLUDING WITHOUT LIMITING DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER FINANCIAL OR OTHER  LOSS
ARISING FROM THE USE OR INABILITY TO USE THE SOFTWARE CAUSED BY OR IN COMBINATION WITH THE USE OF
THIS PUBLICATION.

This publication may contain technical or other imperfections or typographical errors. Changes to the information
contained herein are added periodically; these changes will be incorporated into new editions of this publication. NCD
Holding b.v. may choose to implement changes and/or improvements in the products and/or programs described in
this publication at all times without notice.

EasySIGN is a registered trademark or trademark of NCD Holding b.v.
All other brands and product names are trademarks, registered trademarks or service marks of their respective
owners.

A Product of The Netherlands
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